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About This Book

The Solstice AdminSuite 2.2 Administration Guide provides product overview,
task, and reference information for Solstice™ AdminSuite™ 2.2, a suite of
graphical user interface tools used to perform system administration tasks in
the Solaris™ software environment.

Who Should Use This Book
This book is intended for anyone responsible for using the Solstice AdminSuite
software to perform administrative tasks such as setting up and modifying
users, groups, servers, printers, clients, modems, or terminals.

This book assumes that you are familiar with the mouse-use terminology such
as Select (click on an item once) and Choose (click on a menu button and slide
the cursor to the item you would like to choose).

Before You Use This Product
To use this product, you should be familiar with UNIX® system software
concepts, the network configuration of your site, and your site policies for
security.
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How This Book Is Organized
This book has three parts:

• Part 1 – Solstice AdminSuite Overview
Provides overview information on the Solstice AdminSuite software.

• Part 2 – Using Solstice AdminSuite Tools
Provides task-specific information needed to use the Solstice AdminSuite
software.

• Part 3 - Additional Solstice AdminSuite Administration
Provides information on additional administration that you may need to do
after using the Solstice AdminSuite software, and additional administration
that the Solstice AdminSuite software provides.

What Typographic Changes Mean
The following table describes the typographic changes used in this book.

Table P-1 Typographic Conventions

Typeface or
Symbol Meaning Example

AaBbCc123 The names of commands,
files, and directories;
on-screen computer output

Edit your .login  file.
Use ls -a  to list all files.
machine_name% You have mail.

AaBbCc123 What you type, contrasted
with on-screen computer
output

machine_name% su
Password:

AaBbCc123 Command-line placeholder:
replace with a real name or
value

To delete a file, type rm filename.

AaBbCc123 Book titles, new words or
terms, or words to be
emphasized

Read Chapter 6 in User’s Guide.
These are called class options.
You must be root to do this.
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Shell Prompts in Command Examples
The following table shows the default system prompt and root prompt for the
C shell, Bourne shell, and Korn shell.

Table P-2 Shell Prompts

Shell Prompt

C shell prompt machine_name%

C shell superuser prompt machine_name#

Bourne shell and Korn shell
prompt

$

Bourne shell and Korn shell
superuser prompt

#
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Part 1 — Solstice AdminSuite Overview

This part provides an overview of the Solstice AdminSuite software and
contains these chapters.

Introduction
Provides brief descriptions of all the software included with the Solstice
AdminSuite product.

Using Solstice AdminSuite in a Name Service Environment
Provides information on how to use the Solstice AdminSuite software in a
name service environment.

Security
Describes security issues and provides suggestions on how to use the Solstice
AdminSuite software in a manner that conforms to your site security
policies.

1

2

3

Using the Solstice Launcher
Provides instructions on how to start the Solstice Launcher and add
applications to the Solstice Launcher.

4
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Introduction 1

Solstice AdminSuite is a collection of graphical user interface tools and
commands used to perform administrative tasks such as managing users,
groups, hosts, system files, printers, disks, file systems, terminals, and
modems.

This is a list of the overview information in this chapter.

What’s New in the Solstice AdminSuite 2.2 Product page 2

When to Use Solstice AdminSuite page 5

Benefits of Solstice AdminSuite page 5

Solstice AdminSuite Tools and Their Command-Line Equivalents page 6

Other Solstice AdminSuite Commands page 9
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What’s New in the Solstice AdminSuite 2.2 Product
The Solstice AdminSuite 2.2 product provides the following new features:

• Storage Manager

Storage Manager is a new icon in the Solstice launcher that launches two
new tools that are always displayed and run together: File System Manager
and Disk Manager. File System Manager is a new tool that enables you to
manage file systems for a server or for a group of clients on a server. Disk
Manager is a new tool that enables you to manage disk slices and fdisk
partitions on a single disk or a group of equivalent disks.

For more information about Storage Manager, see its online help and
Chapter 11, “Managing Disks and File Systems With Storage Manager.”

• Host Manager supports AutoClient systems (Solstice AutoClient 2.0)

Host Manager now enables you to add Solaris 2.4 – 2.5.1 support for
AutoClient systems, if you have the required licensing. See the Solstice
AdminSuite 2.2 Installation and Product Notes for information about how to
obtain and install AutoClient licenses and see the Solstice AutoClient 2.0
Administration Guide for detailed information on administering AutoClient
systems.

Note – The Solstice AutoClient 2.0 product is part of the Solstice AdminSuite
2.2 product. Even though Host Manager has the ability to add AutoClient
systems, you must obtain an AutoClient license to add and run an AutoClient
system.

• Command-line equivalents for the AdminSuite tools

The new command-line equivalents enable you to complete most of the
administrative operations you can perform with the AdminSuite tools from
the command line. Table 1-1 on page 6 provides the list of all the
command-line equivalents and their corresponding AdminSuite tool. Also,
the chapters in Part 2 for each AdminSuite tool provide corresponding
examples for the command-line equivalents in each procedure.
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• Mixed-mode name service support

The new admtblloc  command enables you to configure the name service
policy for the AdminSuite tools. You can now choose a mixture of name
services for the AdminSuite tools to populate. For example, you can now set
up Host Manager to populate the /etc  files for bootparams  information
and to populate the NIS+ table for other information.

For more information on this feature, see “Selecting a Name Service
Environment” on page 14.

• Patching clients

The new admclientpatch  command provides a way to add patches to
diskless clients and AutoClient systems in a more efficient and centralized
way. It also provides a way to ensure that the same patches are applied to all
your diskless clients and AutoClient systems. Patches are automatically
applied when clients are created.

• PowerPC support

The AdminSuite product can now be installed and run on PowerPC systems
that are running the Solaris 2.5.1 software.

• Software usage monitoring

A compilation of software programs that enable you to monitor software
usage in a server/client environment or on a non-networked system, which
can simplify system administration and purchasing decisions.

For more information about software usage monitoring, see Chapter 13,
“Monitoring Software Usage.”

• Improved NIS support

The AdminSuite tools can now view and modify NIS maps on Solaris 2.x
NIS master servers that have been set up with the Name Services Transition
Kit 1.2.

• Remote halting and booting commands

Two new commands, admhalt  and admreboot , can be used to remotely
boot and halt systems.

For more information on these commands, see the admhalt(1M)  and the
admreboot(1M)  man pages.
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• Automatically booting x86 AutoClient systems and diskless clients from the
network

You can create an MDB floppy that enables your x86 AutoClient systems
and diskless clients to automatically boot from the network in case you are
not present to boot it, such as after a power failure.

See “x86: How to Set Up a System to Automatically Boot From the
Network” on page 239 for step-by-step instructions.

• Viewing a remote system’s hardware configuration

You can use the admhostls -h  command to view a system’s hardware
configuration. This provides more functionality than Host Manager.

• Operation logging

You can create a log file, so that for each major operation completed with a
Solstice AdminSuite tool, the date, time, server, application name, user ID
(UID), and operation are written to the specified log file.

For detailed information on setting up operation logging, see “Logging
Solstice AdminSuite Operations” on page 59.

• Solaris 2.5.1 support.

The AdminSuite product now supports SPARC, x86, and PowerPC clients
and servers running the Solaris 2.5.1 operating system.

• Support for large user IDs (UIDs) and group IDs (GIDs)

User Manager now enables you to create and support user accounts that
exceed the 60000 UID and GID limits, up to the maximum value of a signed,
32-bit integer, or 2147483647. However, UIDs and GIDs over 60000 create
interoperability issues with many Solaris features, especially on systems
running Solaris 2.5 and earlier. See the Solaris 2.5.1 Release Notes for detailed
information on using large UIDs and GIDs and their associated
interoperability issues with Solaris.
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When to Use Solstice AdminSuite
The Solstice AdminSuite software enables you to locally or remotely manage:

• Important system database files, such as aliases  and hosts

• User accounts and groups

• File systems

• Disk slices and fdisk  partitions

• Terminal and modems

• Diskless and dataless clients

• AutoClient systems

• Standalone systems

• Servers

• Printers

See Chapter 2, “Using Solstice AdminSuite in a Name Service Environment,”
for information on controlling access to the Solstice AdminSuite software.

Benefits of Solstice AdminSuite
Using the Solstice AdminSuite software to perform system administration
tasks has these benefits:

• The tools and commands are faster than using numerous Solaris commands
to perform the same tasks.

• System files are updated automatically without the risk of making errors by
editing important system files manually.

• You can manage systems remotely from one system.



6 Solstice AdminSuite 2.2 Administration Guide—May 1996

1

Solstice AdminSuite Tools and Their Command-Line Equivalents
Table 1-1 lists the Solstice AdminSuite tools that must be run under an
X Window System™, such as the OpenWindows™ environment. Table 1-1 also
lists the commands that provide the same functionality as the Solstice
AdminSuite tools and can be used without running an X Window System. The
chapters in Part 2 for each tool provide corresponding examples for the
command-line equivalents in each procedure.

Table 1-1 Solstice AdminSuite Tools and Their Command-Line Equivalents

AdminSuite Tool
Command-Line
Equivalents Helps You Manage ... Described In ...

Host Manager admhostadd
admhostdel
admhostmod
admhostls

System information and server
support for AutoClient and
standalone systems, and diskless
clients and dataless clients

Chapter 6, “Managing Server
and Client Support With Host
Manager”

Group Manager admgroupadd
admgroupdel
admgroupmod
admgroupls

UNIX group information Chapter 7, “Managing Users
With User Manager and Group
Manager”

User Manager admuseradd
admuserdel
admusermod
admuserls

User account information Chapter 7, “Managing Users
With User Manager and Group
Manager”

Serial Port Manager admserialdel
admserialmod
admserialls

Serial port software for terminals
and modems

Chapter 8, “Managing Terminals
and Modems With Serial Port
Manager”

Printer Manager - none - Printer software for print servers
and clients

Chapter 9, “Setting Up SunSoft
Print Client Software With
Printer Manager”

Database Manager - none - Network-related system files
such as aliases  and hosts

Chapter 10, “Managing Network
Service Files With Database
Manager”

Storage Manager
(consists of Disk Manager
and File System Manager)

- none - Disk slices and fdisk  partitions
on a single disk or a group of
equivalent disks (Disk Manager)
and file systems for a server or
for a group of clients on a server
(File System Manager)

Chapter 11, “Managing Disks
and File Systems With Storage
Manager”
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Starting the Solstice AdminSuite Tools
The Solstice Launcher must be used to start the Solstice AdminSuite tools.
Enter the following command to start the Solstice Launcher, which must be run
on an X Window System:

The Solstice Launcher is displayed.

Note – You can also start the Solstice Launcher by using the -display  option
to remotely display on a bit-mapped screen.

$ solstice &
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From the Solstice Launcher, you can:

• Click on an icon in the Launcher to start a tool.
You can also use the Tab key to move from icon to icon, and press the Space
bar to start a tool.

• Close the Launcher (and each tool) to an icon by clicking on the Window
menu in the top left corner of each tool’s main window.

See Chapter 4, “Using the Solstice Launcher,” for more information about
using the Launcher.

Requirements for Using Solstice AdminSuite Tools
To use the Solstice AdminSuite tools, you must have:

• A bit-mapped display monitor – The Solstice AdminSuite tools can be used
only on a system where the console is a bit-mapped screen such as a
standard display monitor that comes with a Sun® workstation.

If you want to perform administration tasks on a system with an ASCII
terminal as the console, use the command-line equivalents of the Solstice
AdminSuite tools.

• X Window System software, such as the OpenWindows environment.

• Root privilege or membership in the sysadmin group (group 14) and the
required access privileges for managing the NIS or NIS+ database. See
Chapter 2, “Using Solstice AdminSuite in a Name Service Environment,” for
more information.

You should use the Solstice AdminSuite tools as a regular user who has
membership in the sysadmin group rather than as root.
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Other Solstice AdminSuite Commands

Table 1-2 Solstice AdminSuite Commands

Command Enables You To ... Described in ...

admclientpatch(1m) Provide a centralized way to add patches to
AutoClient systems and diskless clients. Host
Manager then automatically adds the patches
when you add an AutoClient system or a diskless
client.

Solstice AutoClient 2.0 Administration
Guide

admtblloc(1m) Set a customized name service policy for Host
Manager.

“Setting Up a Name Service Policy” on
page 72

admhalt(1m) Halt one or more remote systems. admhalt(1m)  man page

admreboot(1m) Reboot one or more remote systems. admreboot(1m)  man page
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Using Solstice AdminSuite in a
Name Service Environment 2

The Solstice AdminSuite software can be used in different name service
environments. When you use each application or command-line equivalent,
you must specify the name service environment data you wish to modify.

This is a list of the overview information in this chapter.

Available Name Service Environments page 12

The /etc/nsswitch.conf File and the Solstice AdminSuite Product page 13

Selecting a Name Service Environment page 14

Working with the Name Services Transition Kit 1.2 page 14

Setting Up User Permissions to Use Solstice AdminSuite page 15

Adding Users to the sysadmin Group page 16



12 Solstice AdminSuite 2.2 Administration Guide—May 1996

2

Available Name Service Environments
Solstice AdminSuite can be used to manage information on the local system or
across the network using a name service. The sources of information that can
be managed by Solstice AdminSuite are described in Table 2-1.

See “Setting Up User Permissions to Use Solstice AdminSuite” on page 15 for
information on using Solstice AdminSuite with or without a name service
environment.

Table 2-1 Available Name Service Environments

 Name Service Select This Name Service To Manage ...

 NIS+ NIS+ table information. This requires sysadmin group (group 14)
membership and the appropriate ownership or permissions on
the NIS+ tables to be modified.

 NIS NIS map information. You must be a member of the sysadmin
group. If the NIS master server is running the Solaris 1.x OS
Release, you must have explicit permissions on the NIS master
server to update the maps. This means an entry for your host
name and user name must reside in root’s .rhosts  file on the
NIS master server. This entry is not required if the NIS master
server is running the Solaris 2.x OS Release and the Name
Services Transition Kit 1.2 software.

 None The /etc  files on the local system. You must be a member of the
sysadmin group on the local system.
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The /etc/nsswitch.conf  File and the Solstice AdminSuite Product
The Solstice AdminSuite software allows you to select which name service
databases will be updated (written to) when you make modifications with one
of the tools. However, the /etc/nsswitch.conf  file on each system specifies
the policy for name service lookups (where data will be read from) on that
system.

Caution – It is up to the user to make sure that the name service they select
from one of the tools is consistent with the specifications in the
/etc/nsswitch.conf  file. If the selections are not consistent, the tools may
behave in unexpected ways, resulting in errors or warnings. See “Selecting a
Name Service Environment” on page 14 for an example of the window from
which you select a name service.

The /etc/nsswitch.conf  file has no effect on how the system configuration
files get updated. In the /etc/nsswitch.conf  file, more than one source can
be specified for the databases, and complex rules can be used to specify how a
lookup can be performed from multiple sources. There is no defined syntax for
using the rules in the /etc/nsswitch.conf  file to perform updates.

Because of this, updates are controlled by the name service selection that is
made when the one of the tools are started. The administrator must decide
where the update is to take place.

When using the tools, administrative operations can take place on multiple
systems with a single operation. It is possible that each of these systems could
have a different /etc/nsswitch.conf  configuration. This situation can make
it very difficult to administer your network. It is recommended that all of the
systems have a consistent set of /etc/nsswitch.conf  files and that the
Solstice AdminSuite software is used to administer the primary name service
specified in the standard /etc/nsswitch.conf  file.

With this release of the Solstice AdminSuite product, you can define a more
complex update policy for the tools by using the admtblloc  command. For
more information on this command, refer to the admtblloc(1M)  man page
and see “The admtblloc Command” on page 73.

!
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Selecting a Name Service Environment
After you start the Solstice Launcher and click on an application icon, a
window is displayed prompting you to select a name service. Select the name
service that is appropriate for your environment.

This example is from Host Manager’s Load window.

Note – The NIS and NIS+ environments are not available for Serial Port
Manager.

Working with the Name Services Transition Kit 1.2
The Name Services Transition Kit 1.2 is designed to allow you to support a NIS
server running Solaris 2.x. Installing the software and setting up the Solaris 2.x
NIS servers is described in the Name Services Transition Kit 1.2 Administrator’s
Guide. Solstice AdminSuite can manage information using the NIS name
service supported by Solaris 2.x NIS servers installed with the Name Services
Transition Kit 1.2 software.

On NIS servers installed with the Solaris 2.x OS Release, the Name Service
Transition Kit 1.2, and Solstice AdminSuite, the configuration files stored in
/etc  directory are modified by Solstice AdminSuite applications (these files
are in turn automatically converted to NIS maps). If the NIS server is not
installed with Solstice AdminSuite, then the directory location specified by the
$DIR  variable in the /var/yp/Makefile  is used.

Name Service Menu
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Setting Up User Permissions to Use Solstice AdminSuite
To use Solstice AdminSuite, membership in the sysadmin group (group 14) is
required. See “Adding Users to the sysadmin Group” on page 16 for more
information.

Following are additional requirements to use Solstice AdminSuite for each
name service.

User Permissions in the NIS+ Environment

The requirements for using Solstice AdminSuite are:

• Membership in the NIS+ admin group.
• Modify permissions on the NIS+ tables to be managed. These permissions

are usually given to the NIS+ group members.

See NIS+ and FNS Administration Guide for information on adding users to a
NIS+ group and granting permissions on NIS+ tables.

User Permissions in the NIS Environment

The requirements for using Solstice AdminSuite are:

• An entry for your host name and user name in root’s .rhosts  file on the
NIS master server if the server is running the Solaris 1.x OS Release. If the
NIS master server is running the Solaris 2.x OS Release and Name Services
Transition Kit 1.2 software, this entry is not required.

• Running ypbind  with the -broadcast  option, which is the default form, if
you want to manage NIS map information in domains other than your own.
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Adding Users to the sysadmin Group
The following procedure describes how to add users to the sysadmin group
using Group Manager, a tool within the Solstice AdminSuite software. To use
this tool, you must be already be a member of the sysadmin group and meet
the requirements for each name service listed in “Setting Up User Permissions
to Use Solstice AdminSuite” on page 15.

If you do not have access to a user account that is a member of the sysadmin
group to run Group Manager, see the procedure to add users to the sysadmin
group described in the Solstice AdminSuite 2.2 Installation and Product Notes.

▼ How to Add a User to the sysadmin Group

1. Verify that the prerequisites described in “Requirements for Using
Solstice AdminSuite Tools” on page 8 are met.

2. Type solstice &  in a Shell or Command Tool window.
The Solstice Launcher is displayed.

3. Click on the Group Manager icon.
The Group Manager Load window is displayed.

4. Select the name service you wish to modify.

5. Click on OK.
The Group Manager main window is displayed.

6. Click on the sysadmin group in the Group Manager main window.

7. Select Modify from the Edit Menu.
The Modify window is displayed.

8. Add a comma-separated list of members to the Members List text box.
The list must not contain spaces.

9. Click on OK.

Note – The admtblloc  command can be used to set the name service policy
for only the configuration files present in this list.
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An important part of using the Solstice AdminSuite software is understanding
its security features and setting up security policies to protect your
administrative data.

This is a list of the step-by-step instructions in this chapter.

 Security Information
Solstice AdminSuite uses the distributed system administration daemon
(sadmind ) to carry out security tasks when you perform administrative tasks
across the network. The sadmind  daemon executes the request on the server
on behalf of the client process and controls who can access Solstice
AdminSuite.

Administering security involves authentication of the user and authorization of
permissions.

• Authentication means that the sadmind  daemon must verify the identity of
the user making the request.

Security Information page 17

Things to Consider When Creating a Security Policy page 21

Creating a Level 2 DES Security System page 23
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• Authorization means that sadmind  verifies that the authenticated user has
permission to execute Solstice AdminSuite on the server. After the user
identity is verified, sadmind  uses the user identity to perform authorization
checks.

If you have permission to use Solstice AdminSuite, you also need to have
create, delete, or modify permission before you can change an NIS+ map.
See NIS+ and DNS Setup and Configuration Guide for a description of NIS+
security.

User and group identities are used for authorization checking as follows:

• Root identity – The root identity has privileges (to access and update data)
only on the local system. If the server is the local system (in other words, if
the user has logged in as root on the server), the user will be allowed to
perform Solstice AdminSuite functions on the server under the root identity.

• User who is a member of sysadmin group (group 14 ) – Solstice
AdminSuite permissions are granted to users who are members of the
sysadmin group (group 14 ). This means that a user modifying
administration data must be a member of the sysadmin group on the system
where the task is being executed.

Security Levels

Each request to change administration data contains a set of credentials with a
UID and a set of GIDs to which the user belongs. The server uses these
credentials to perform identity and permission checks. Three levels of
authentication security are available.
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The security levels are described in Table 3-1.

Note – Level 1 is the default security used by sadmind .

Changing the Security Level

You can change the security level from Level 1 to Level 2 by editing the
/etc/inetd.conf  file on each system, and adding the –S 2  option to the
sadmind  entry. If you do this, make sure that the servers in the domain are set
up to use DES security.

You do not need to maintain the same level of security on all systems in the
network. You can run some systems, such as file servers requiring strict
security, at security Level 2, while running other systems at the default Level 1
security.

Table 3-1 Solstice AdminSuite Security Levels

Level Level Name Description

0 NONE No identity checking is done by the server. All UIDs are set to
the nobody  identity. This level is used mostly for testing.

1 SYS The server accepts the original user and group identities from
the client system and uses them as the identities for the
authorization checks. There is no checking to be sure that the
UID of the user represents the same user on the server
system. That is, it is assumed the administrator has made the
UIDs and GIDs consistent on all systems in the network.
Checks are made to see if the user has permission to execute
the request.

2 DES Credentials are validated using DES authentication, and
checks are made to be sure that the user has permission to
execute the request. The user and group identities are
obtained from files on the server system by mapping the
user’s DES network identity to a local UID and set of GIDs.
The file used depends on which name service is selected on
the server system. This level provides the most secure
environment for performing administrative tasks and requires
that a publickey  entry exists for all server systems where
the sadmind  daemon is running, and for all users accessing
the tools.
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See the description of how to set up security for NIS+ in NIS+ and FNS
Administration Guide.

Name Service Information

The sadmind  daemon uses information held by the name service. The three
sources of information are:

• Files in the /etc  directory such as passwd , group , and shadow, referred to
as the keyword files

• The NIS name service referred to as the keyword nis

• The NIS+ name service referred to as the keyword nisplus

On each system, the /etc/nsswitch.conf  file lists several administrative
files, followed by a list of one or more keywords that represent the name
services to be searched for information. If more than one keyword is listed,
they are searched in the order given. For example, the entry

group: files nisplus

indicates that the security mechanism looks first in the local /etc/group  file
for an entry. If the entry exists, the security mechanism uses the information in
this entry. If the entry doesn’t exist, the NIS+ group  file is searched.

By default, systems running the Solaris 2.4 and higher OS release have an entry
for group 14  in the local /etc/group  file. If you want to set up your system
to use network-wide information, do not add members to the sysadmin group
on the local system. Instead, update the group14 entry found in the group table
stored in the name service.

When running under Level 2 security, the security mechanisms use the
public/private key information. Make sure that the entry for publickey  is
followed by either nis  or nisplus  (depending on which name service you are
using), and remove the files  designation. See NIS+ and FNS Administration
Guide for more information about the nsswitch.conf  file.
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Things to Consider When Creating a Security Policy
Consider the following when creating a security policy for using Solstice
AdminSuite in a name service environment.

• Determine how much trust is needed.

If your network is secure and you do not need to use authentication
security, you can use Solstice AdminSuite applications with the default
Level 1 security.

If you need to enforce a higher level of security, you can set the security
level of sadmind  to Level 2.

• Determine which name service will be used.

The name service determines where the security methods get information
about user and group identities. The name services are designated in the
/etc/nsswitch.conf  file (see “Name Service Information” on page 20).

• Decide which users have access to Solstice AdminSuite.

Decide which users will perform administrative functions over the network
with Solstice AdminSuite. List these users as members of group14 accessed
by the server system. The group 14  must be accessible from each system
where administration data will be updated by Solstice AdminSuite. The
group 14  can be established locally on each system or can be used globally
within a name service domain, depending upon the policy established by
the administrator.

• Determine global and local policies.

The global policy affects all hosts in the network. For example, you can add
members to group 14  in the NIS or NIS+ group  file. Members of this
group will have permission to perform administrative tasks on all server
systems that list the network name service as the primary source of
information. The name services are listed in the /etc/nsswitch.conf  file.
For more information about the nsswitch.conf  file, see “Name Service
Information” on page 20.

A user can establish a local policy that is different from the global policy by
creating a group 14  in the local /etc/group  file and listing the users who
have access to the local system. The members of this group will have
permission to manipulate or run Solstice AdminSuite methods on the user’s
local system.
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Note – Setting up a local policy does not disable a global policy. Name service
access is determined by the nsswitch.conf  file.

• Set up permissions for NIS+ management.

You need the proper permissions when using Solstice AdminSuite to modify
or update the NIS+ files. In addition to the permissions required by Solstice
AdminSuite, the NIS+ security mechanisms impose their own set of access
permissions. The NIS+ security mechanisms are described in NIS+ and FNS
Administration Guide.

• Set up access for NIS management.

If the NIS master server is running the Solaris 1.x operating system, a user
must have a .rhosts  entry on the NIS master server to modify the NIS files.
If the NIS master server is running the Solaris 2.x operating system and the
Name Services Transition Kit 1.2, then no entry is required. The NIS updates
will be authorized using the standard group 14  mechanism.
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Creating a Level 2 DES Security System
Creating a level 2 DES security system requires a number of steps that depend
upon your system configuration. The following sections describe how to set up
your system to have level 2 DES security for systems using /etc , NIS , and
NIS+  name services.

▼ How to Create Level 2 DES Security for Systems Using /etc  Name
Service

1. On each system that runs the sadmind  daemon, edit the
/etc/inetd.conf  file.
Change this line (or one similar to this):

to:

2. On each system that runs the sadmind daemon, set the
/etc/nsswitch.conf  entry for publickey  to files .
Change this entry (or one similar to this):

to:

3. Create credentials for all group 14  users and all of the systems that will
run sadmind -S 2 .

a. Log in as root to one of the systems that will run sadmin -S 2 .

100232/10 tli rpc/udp wait root /usr/sbin/sadmind sadmind

100232/10 tli rpc/udp wait root /usr/sbin/sadmind sadmind -S 2

publickey:nis [NOTFOUND=return] files

publickey: files
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b. Run the following command for each user that will run admintool .

Note – You must run this command even for users who are not in group 14 .
If you are not in group 14  and do not have credentials, you are not a user
according to sadmind ; you will not be able to run any methods, even those
that do not require root. You will have to supply the user’s password to the
newkey  program.

c. Run the following command for every host that you have configured to
run secure sadmind .

You will have to provide the root password for each of these hosts to the
newkey  program.

d. Copy the /etc/publickey  file on this system to each of the hosts (put
this file in /etc/publickey ).
This file contains all the credentials for each user and each host.

Note – Do not run newkey  on each of the systems. This seems to create a
different public/private  key pair, and the public key will not be valid
across the network. You must create this file on one machine and then copy it
to all the others.

e. As root, enter the following command on each system to put root’s
private key in /etc/.rootkey .

By doing this, you will not have to keylogin  as root on every system
every time you want to run admintool ; this creates an automatic root
keylogin  at boot time.

# newkey -u username

# newkey -h hostname

# keylogin -r
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4. Create an /etc/netid  file for each user and each system; put this file on
all of the systems.

a. For each user in the publickey  file, create an entry in /etc/netid
that looks like the following:

b. List every group that this user is a member of; sadmind -S 2  and files
look to netid  rather than /etc/group  to determine group 14
membership.

c. For each host in the publickey  file, create an entry in /etc/netid
that looks like the following:

d. Copy this file to every system in /etc/netid .

5. Reboot all of the machines.

6. On each system that you want to run the application on, log in and then
keylogin . (You must be a member of group 14 .)
After the keylogin , you can safely log out; your key is stored in the
keyserv  daemon until you explicitly keylogout  or the system reboots.

unix. uid@domainnameuid: uid: gid, gid, ...

unix. hostname@domainname 0: hostname
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▼ How to Create Level 2 DES Security for Systems Using NIS Name
Service

1. On each system that runs the sadmind  daemon, edit the
/etc/inetd.conf  file.
Change this line (or one similar to this):

to:

2. On each system that runs the sadmind  daemon, set the
/etc/nsswitch.conf  entry for publickey  to nis .
Change this entry (or one similar to this):

to:

3. Create credentials for all group 14  users and all of the systems that will
run sadmind -S 2 .

a. Log in as root on the nis server.

b. Run the following command for each user that will run admintool .

100232/10 tli rpc/udp wait root /usr/sbin/sadmind sadmind

100232/10 tli rpc/udp wait root /usr/sbin/sadmind sadmind -S 2

publickey:nis [NOTFOUND=return] files

publickey: nis

# newkey -u username -s files
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Note – You must run this command even for users who are not in group 14 .
If you are not in group 14  and do not have credentials, you are not a user
according to sadmind ; you will not be able to run any methods, even those
that do not require root. You will have to supply the user’s password to the
newkey  program.

c. Run the following command for every host that you have configured to
run secure sadmind .

You will have to provide the root password for each of these hosts to the
newkey  program.

d. Copy the /etc/publickey  file on this system to the source file that is
specified in /var/yp/Makefile ; remake and push the nis  maps.

4. Verify that you are a member of group 14  in the group/nis maps.

a. Login as root.

b. Change directories to the source file specified in /var/yp/Makefile .

c. Manually edit the group file and add yourself to Group14, just as you
did in the /etc/group  file.

d. Change directories to /var/yp  and run make.

You should see the group map pushed; a message appears indicating that
this action has occurred.

Note – The security system looks in the NIS maps for your group14  access
and will fail if you do not have group14  specified there, regardless if your
/etc/nsswitch.conf  file has group files nis .

# newkey -h hostname

# cd /var/yp; make

# cd /var/yp; make
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When sadmind  is running in -S 2  mode, it uses the publickey  entry to
determine which name service to look at for user credentials. When the entry
in /etc/nsswitch.conf  is nis , it looks in the nis  group map to ensure that
the user is a member of group 14 .

5. As root, enter the following command on each system to put root’s private
key in /etc/.rootkey .

By doing this, you will not have to keylogin  as root on every system every
time you want to run admintool ; this creates an automatic root keylogin
at boot time.

6. Reboot all of the workstations; verify that the nscd  gets flushed.

7. On each system that you want to the application to run on, log in and then
keylogin . (You must be a member of group 14 .)
After the keylogin , you can safely log out; your key is stored in the
keyserv daemon until you explicitly keylogout  or the system reboots.

▼ How to Create Level 2 DES Security for Systems Using NIS+ Name
Service

1. On each system that runs the sadmind  daemon, edit the
/etc/inetd.conf  file.
Change this line:

to:

# keylogin -r

100232/10 tli rpc/udp wait root /usr/sbin/sadmind sadmind

100232/10 tli rpc/udp wait root /usr/sbin/sadmind sadmind -S 2
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2. On each system that runs the sadmind  daemon, set the
/etc/nsswitch.conf  entry for publickey  to nisplus .
Change this entry (or one similar to this):

to:

3. Log in as root on the NIS+ master server; create credentials for all group
14  users and all of the systems that will run sadmind -S 2 .

a. Create local credentials for the user.

b. Create des  credentials for the user.

4. Log in as root on the NIS+ master server; add all of the users for the
admintool  to the NIS+ group 14  using the following command.

Note – The use of this function replaces the current member list with the one
that is input; therefore, you must include all members you wish to be a part of
group 14 .

publickey:nisplus [NOTFOUND=return] files

publickey: nisplus

# nisaddcred -p uid username. domainname. local

# nisaddcred -p unix. uid@domainname -P username. domainname. des

# nistbladm -m members=username, username...[name-sysadmin], group.org_dir
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5. As root, add all of the users for the admintool  to the NIS+ admin  group.

Verify that the NIS_GROUP env variable is set to admin .

6. On all the workstations that you intend to run the admintool , enter the
following command.

7. Reboot all of the workstations; verify that the nscd  gets flushed.

8. On each system that you want to the application to run on, log in and then
keylogin . (You must be a member of group 14 .)
After the keylogin , you can safely log out; your key is stored in the
keyserv  daemon until you explicitly keylogout  or the system reboots.

# nisgrpadm-a admin username

# keylogin -r
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Using the Solstice Launcher 4

The Solstice Launcher provides access to the Solstice product family of
administration tools. The tools that appear in the Launcher depend on what
Solstice products you have installed on your system.

This is a list of the topics and step-by-step instructions in this chapter.

Starting the Solstice Launcher page 32

How to Privately Register an Application in the Solstice Launcher page 34

How to Remove a Privately Registered Application page 35

How to Locally Register an Application in the Solstice Launcher page 36

How to Remove a Locally Registered Application page 37

How to Globally Register an Application in the Solstice Launcher page 38

How to Remove a Globally Registered Application page 40

How to Customize Application Properties in the Solstice Launcher page 41

How to Modify Properties of a Locally Registered Application page 43

How to Use the File Selection Window page 44
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Starting the Solstice Launcher
Start the Solstice Launcher from a window as follows:

The Solstice Launcher is displayed.

$ solstice &
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The Solstice Launcher menus are described in Table 4-1.

Registering Applications in the Solstice Launcher
Applications that display in the Solstice Launcher are registered. This means
that you can add and remove applications, including custom applications, to
and from the Launcher main window.

Applications are registered in three ways:

• Private registry – Registered applications are private to the user.
Applications are registered privately with the Add Application command
from the Launcher menu. See “How to Privately Register an Application in
the Solstice Launcher” on page 34 for instructions on registering
applications privately.

Privately registered applications can be added, removed, and their
properties can be modified from the Solstice Launcher.

• Local registry – Registered applications are local to the system. Applications
registered locally are available to all local users of the system. Applications
can only be registered locally with the /usr/snadm/bin/soladdapp
command. See “How to Locally Register an Application in the Solstice
Launcher” on page 36 for information on using the soladdapp  command to
register applications locally.

Locally registered applications can only be added or removed using the
soladdapp  and soldelapp  commands. Their properties cannot be
modified from the Solstice Launcher.

Table 4-1 Solstice Launcher Menus

Use This Menu ... To Access This Command ... That Performs This Function ...

Launcher Add Application Adds and registers applications with the Launcher.

Properties Provides ability to customize the launcher by showing, hiding, or
removing applications; reordering the icons; changing the
Launcher window width; modifying application properties;
adding applications

Exit Stops running the Solstice Launcher. Does not affect open or
iconified applications.
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• Global registry – Registered applications are shared by all local and remote
users using the Solstice Launcher in a particular /opt  directory.
Applications can only be registered globally with the
/usr/snadm/bin/soladdapp  command.
See “How to Globally Register an Application in the Solstice Launcher” on
page 38 for information on using the soladdapp  command to register
applications globally.

Globally registered applications can only be added or removed using the
soladdapp  and soldelapp  commands. Their properties cannot be
modified from the Solstice Launcher.

If the user has a local registry file, and both a local registry and global registry
file are in place, then the applications from all files are displayed.

▼ How to Privately Register an Application in the Solstice Launcher

The following procedure describes how to privately register an application in
the $HOME/.solstice_registry  file.

1. Select Add Application from the Launcher menu.

2. Enter the following application information in the Add Application
window.

a. Identify the application name in the Name text box.
This name is displayed in the Launcher window.

b. Identify the application path name in the Application Path text box.
If you are not sure of the application path name, click on the ... button,
which displays the Application Path Selection window. See “How to Use
the File Selection Window” on page 44 for information on using this
window.

c. Identify any command-line arguments for the application in the
Arguments text box.
These arguments are passed to the application when it is started.

d. Identify the application icon path name in the Icon Path text box.
If you are not sure of the icon path name, click on the ... button, which
displays the Application Path Selection window. See “How to Use the
File Selection Window” on page 44 for information on using this
window.
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3. Click on Register to add the application.

Example of Registering a Private Application in the Solstice
Launcher

The following example registers an application called Mail Manager.

▼ How to Remove a Privately Registered Application

1. Select Properties from the Launcher menu.
 The Properties window is displayed.

2. Select an application from the Hide or Show lists.

3. Click on the Remove button in the Properties window.

4. Click on OK.
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▼ How to Locally Register an Application in the Solstice Launcher

1. Become root.

2. Register an application with the soladdapp  command.

In this command,

Example of Registering a Local Application in the Solstice Launcher

The following example uses the soldaddapp  command to locally register an
application called Mail Manager.

# /usr/snadm/bin/soladdapp \
           -r /etc/.solstice_registry \
           -n “ Tool Name” \
           -i /opt/pkgname/etc/tool.icon \
           -e /opt/pkgname/bin/command

args

/usr/snadm/bin/soladdapp Is the Solstice command for registering
applications.

-r /etc/.solstice_registry Specifies the path name of the Solstice local
registry file.

-n  “ Tool Name” Specifies the name of the tool to be registered.

-i /opt/pkgname/etc/tool.icon Specifies the path name of the tool icon.

-e /opt/pkgname/bin/command Specifies the path name of the tool executable.

args Specifies optional arguments to use with the
executable.

# /usr/snadm/bin/soladdapp \

-r /etc/.solstice_registry \
-n “Mail Manager” \
-i /opt/SUNWdsk/etc/diskmgr.xpm \

      -e /opt/SUNWdsk/bin/diskmgr
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▼ How to Remove a Locally Registered Application

1. Become root.

2. Remove an application with the soldelapp  command.

In this command,

Example of Removing a Locally Registered Application

The following example uses the soldelapp  command to remove an
application called Mail Manager.

# /usr/snadm/bin/soldelapp \
           -r /etc/.solstice_registry \
           -n “ Tool Name”

/usr/snadm/bin/soldelapp Is the Solstice command for removing
applications from the local registry file.

-r /etc/.solstice_registry Specifies the path name of the Solstice local
registry file.

-n  “ Tool Name” Specifies the name of the tool to be removed.

# /usr/snadm/bin/soldelapp \

-r /etc/.solstice_registry \
      -n “Mail Manager”
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▼ How to Globally Register an Application in the Solstice Launcher

1. Become root.

2. Register an application with the soladdapp  command.

In this command,

# /usr/snadm/bin/soladdapp \
           -r /opt/SUNWadm/etc/.solstice_registry \
           -n “ Tool Name” \
           -i /opt/pkgname/etc/tool.icon \
           -e /opt/pkgname/bin/command

args

/usr/snadm/bin/soladdapp Is the Solstice command for registering
applications.

-r /opt/SUNWadm/etc
/.solstice_registry

Specifies the path name of the Solstice global
registry file.

-n  “ Tool Name” Specifies the name of the tool to be registered.

-i /opt/pkgname/etc/tool.icon Specifies the path name of the tool icon.

-e /opt/pkgname/bin/command Specifies the path name of the tool executable.

args Specifies optional arguments to use with the
executable.
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Example of Registering a Global Application in the Solstice
Launcher

The following example uses the soldaddapp  command to globally register an
application called Mail Manager.

# /usr/snadm/bin/soladdapp \

-r /opt/SUNWadm/etc/.solstice_registry \
-n “Mail Manager” \
-i /opt/SUNWdsk/etc/diskmgr.xpm \

      -e /opt/SUNWdsk/bin/diskmgr
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▼ How to Remove a Globally Registered Application

1. Become root.

2. Remove an application with the soldelapp  command.

In this command,

Example of Removing a Globally Registered Application

The following example uses the soldelapp  command to remove an
application called Mail Manager.

# /usr/snadm/bin/soldelapp \
           -r /opt/SUNWadm/etc/.solstice_registry \
           -n “ Tool Name”

/usr/snadm/bin/soldelapp Is the Solstice command for removing
applications from the global registry file.

-r /opt/SUNWadm/etc/
.solstice_registry

Specifies the path name of the Solstice global
registry file.

-n  “ Tool Name” Specifies the name of the tool to be removed.

# /usr/snadm/bin/soldelapp \

-r /opt/SUNWadm/etc/.solstice_registry \
      -n “Mail Manager”
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Customizing the Solstice Launcher

▼ How to Customize Application Properties in the Solstice Launcher

1. Select Properties from the Launcher menu.
 The Properties window is displayed.

2. Use the Hide/Show buttons to disable or enable the display of
applications in the Launcher window.

a. Select an application from the Show list and click on the Hide button
to hide an application.
The application is moved to the Hide list.

b. Select an application from the Hide list and click on the Show button
to show an application.
The application is moved to the Show list.

c. Click on OK when you are finished moving applications to and from
the Show and Hide lists.

3. Use the Remove button to remove an application from a local registry file.
See “How to Remove a Privately Registered Application” on page 35 for
information on removing a locally registered application.

4. Click on the Add Application button to add an application to the
Launcher window.
The Add Application window is displayed. This window is equivalent to
the Add Application command from the Launcher menu.

See “How to Privately Register an Application in the Solstice Launcher” on
page 34 for information on adding applications to the Launcher.

5. If you select an application from the Hide or Show lists and click on the
Application Properties button, the Application Properties window is
displayed.
See “How to Modify Properties of a Locally Registered Application” on
page 43 for information on modifying the properties of a locally registered
application.

6. Change how the tool icons are displayed in the Launcher window.

a. Select an application in the Show list and click on the Up or Down
arrow under Icon Order to change the location of an icon.
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b. Use the up/down arrows under Launcher Width to indicate the number
of columns that will display in the Launcher window.

7. If you increase the number of icons to be wider than the width of the
Launcher window, use the scrollbar at the bottom of the Launcher to view
any icons that moved off the window.

8. Click on OK.

Example of Customizing Application Properties in the Solstice
Launcher

The following example shows that Database Manager has been moved to the
Hide list. This means it will not be displayed in the Solstice Launcher.
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Customizing Locally Registered Applications in the Solstice Launcher
Locally registered applications can be customized in the following ways:

• Applications can be hidden or redisplayed by using the Hide/Show feature.

• The number of columns in the Launcher window can be expanded and
contracted, which affects how the applications are displayed.

• The application icons can be moved up or down to change the order in
which the application icons are displayed.

See “How to Customize Application Properties in the Solstice Launcher” on
page 41 for more information on customizing applications.

▼ How to Modify Properties of a Locally Registered Application

1. Select Properties from the Launcher menu.
The Properties window is displayed.

2. Select an application from the Hide or Show lists.

3. Click on the Application Properties button.
The Application Properties window is displayed.

4. Modify the following application properties:

a. The application name in the Name text box.

Note –  The application name must be changed in order for any application
properties changes to be successful.

b. The application path name in the Application Path text box.
If you are not sure of the application path name, click on the ... button,
which displays the Application Path Selection window. See “How to Use
the File Selection Window” on page 44 for information on using this
window.

c. Any command-line arguments to the application in the Arguments text
box.
These arguments are passed to the application when it is started.
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d. The icon path name in the Icon Path text box.
If you are not sure of the icon path name, click on the ... button, which
displays the Application Path Selection window. See “How to Use the
File Selection Window” on page 44 for information on using this
window.

5.  Click on Register.

Example of Modifying Properties of a Locally Registered
Application

The following example provides an alternative executable and icon for Host
Manager.

▼ How to Use the File Selection Window

1. Use the Filter text box in the Application Path Selection window to
specify a path name using a regular expression, such as the wildcard
character (*).
When a new value is entered, the Directories and File lists are updated
appropriately.

2. Select a file name from the Files list to update the Open File text box.

3. Click on OK to place the Open File text box value into the field from
which the File Selection window was invoked.

The application file name is displayed in the Application Path text box in
the Application window.
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Example of Using the File Selection Window

The following example of the Application Path Selection window uses a filter
to search the /opt/SUNWadm/2.1/bin  directory for application tool
executables, which are displayed under the Files list.
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Part 2 —  Using Solstice AdminSuite
Tools

This part provides instructions for how to use the Solstice Launcher and the
individual Solstice AdminSuite applications. This part contains these chapters.

Solstice AdminSuite Tools Reference Information
Provides information that is common across all the Solstice AdminSuite
tools, such as online help and error/warning messages.

Managing Users With User Manager and Group Manager
Provides instructions for how to create and manage user information with
User Manager and Group Manager.

Managing Server and Client Support With Host Manager
Provides instructions for how to set up a system with Host Manager. Also
describes how to add diskless and dataless client support to a server.

Managing Terminals and Modems With Serial Port Manager
Provides instructions for setting up the serial port software to work with
terminals and modems with the Serial Port Manager.

Setting Up SunSoft Print Client Software With Printer Manager
Provides instructions for how to set up print servers and print clients with
Printer Manager.

5

7

6

8

9



Managing Network Service Files With Database Manager
Provides instructions for how to manage network service files with Database
Manager.

10

Managing Disks and File Systems With Storage Manager
Provides instructions for how to manage disks and files system with Storage
Manager, which consists of two tools: Disk Manager and File System
Manager.

11



49

Solstice AdminSuite Tools Reference
Information 5

This chapter contains reference information for features found in all tools
within the Solstice AdminSuite software.

This is a list of the overview information in this chapter.

Main Window Areas page 50

Using Admin Help page 51

Filtering System Entries With User Manager and Group Manager page 53

Filtering System Entries With Host Manager page 54

Buttons page 55

Global Browsing Capabilities With Host Manager page 56

Batching Operations With Host Manager page 57

Status Area Within Host Manager page 58

Logging Solstice AdminSuite Operations page 59
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Main Window Areas
When you select a tool icon in the Solstice Launcher, the tool’s main window is
displayed. Many of the tools have main window areas similar to the Host
Manager’s main window shown in Figure 5-1.

Figure 5-1 Host Manager Main Window Areas

The main window contains two areas: a menu bar and a display area. The
menu bar usually contains four menus: File, Edit, View, and Help. For more
information on these menus, see the online help (the section “Using Admin
Help” on page 51 describes how to access online help).

Disk Manager and File System Manager have a different main window. See
Chapter 11, “Managing Disks and File Systems With Storage Manager,” for
more details.

Menu Bar Display Area
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Using Admin Help
An important part of the Solstice AdminSuite software is a Help utility called
Admin Help. Admin Help provides detailed information about Solstice
AdminSuite tools and their functions.

• To access Admin Help from a Solstice AdminSuite tool’s main window,
choose “About xx Manager” from the Help menu.

• To access the online help from a Solstice AdminSuite application’s command
window, click on the Help button.

Figure 5-2 shows the Admin Help window.

Figure 5-2 Admin Help Window

The titles displayed in the top window pane identify the list of topics available
for each level of help.

The text displayed in the bottom window pane describes information about
using the current menu or command.
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Use the scroll bars to the right of each pane to scroll through the help
information displayed.

On the left side of the Admin Help window are buttons used to find
information and navigate through the help system. The buttons are described
in Table 5-1.

Table 5-1 Admin Help Buttons

This Button ... Is Used To ... Notes

Topics Displays a list of overview
topics.

Click on a title in the top window
pane to view the accompanying help
text.

How To Displays a list of step-by-
step procedures.

Click on a title in the top window
pane to view the accompanying help
text.

Reference Displays a list of more
detailed information.

Click on a title in the top window
pane to view the accompanying help
text.

Previous Returns to the last
accessed help text.

The help viewer automatically returns
to the previous help selection.

Done Exits the help system. The Admin Help window is closed.
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Filtering System Entries With User Manager and Group Manager
The User Manager and Group Manager applications provide a means of
filtering entries if you do not want to see all of the entries in a system file. To
filter system entries, choose Load from the File menu and specify a filter from
the Filter Groups menu, as shown in Figure 5-3.

Figure 5-3 Filtering System Entries With User Manager and Group Manager

Table 5-2 describes the different filtering commands.

After you have selected a name service and a method for filtering entries that
are displayed, click on OK. The tool’s main window is displayed.

Table 5-2 Filtering Commands for User Manager and Group Manager

Use This Command ... To ...

All Display all file entries. This is the default setting.

Specify Specify a text string that displayed file entries must match.
Specifying wildcards is acceptable. This option is helpful if
you want to focus on a small number of entries.

None Turn off file entry display. This is helpful if you only want to
add new entries and have no interest in viewing existing
entries.

Filtering Commands
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Filtering System Entries With Host Manager
To view specific system entries in Host Manager’s main window, choose Set
Filter from the View menu. The Filter window is displayed and you have the
option of setting from one to three filtering characteristics, as shown in
Figure 5-4.

Figure 5-4 Filtering System Entries With Host Manager

After you have chosen a method for filtering the entries that are displayed in
the main window, click on OK.
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Buttons
Table 5-3 describes the common window buttons used in the Solstice
AdminSuite tools.

Caution – Clicking on OK after clicking on Apply might cause a duplicate
operation, resulting in an error. Click on Cancel after clicking on Apply to
dismiss the window.

Table 5-3 Common Window Buttons in the Solstice AdminSuite Tools

This Button ... Is Used To ...

OK Complete a task so that it can be processed. The window is
closed after the task is completed.

Apply Complete a task but leave the window open. (Not available on
all windows.)

Reset Reset all fields to their original contents (since the last
successful operation).

Cancel Cancel the task without submitting any changes and close the
window. Fields are reset to their original contents.

Help Access Admin Help.

!
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Global Browsing Capabilities With Host Manager
Host Manager enables you to see most system attributes in the main window,
shown in Figure 5-5. Choose Customize from the View menu to change your
attribute viewing options.

Figure 5-5 Global Browsing Capabilities With Host Manager

Attributes
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Batching Operations With Host Manager
Host Manager enables you to add, delete, modify, convert, and revert more
than one system at the same time, which is called batching. The scrolling and
highlighting capabilities of the main window enable you to select multiple
systems, as shown in Figure 5-6. To select more than one system, click SELECT
(by default, the left mouse button) on the first system. Then select each
subsequent system by pressing the Control key and clicking SELECT.

Figure 5-6 Selecting Multiple Entries Within Host Manager
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Status Area Within Host Manager
“Main Window Areas” on page 50 describes two areas of Host Manager’s main
window: a menu bar area and a display area. The Host Manager main window
also has a status area in the bottom of the window, which is shown in
Figure 5-7.

In the left corner, the status area displays status information about pending
changes, such as how many systems are waiting to be added, deleted,
modified, and converted. In the right corner, the status area displays the
current name service you are modifying with Host Manager.

The message “Total Changes Pending” reflects the number of systems that are
waiting to be added, deleted, modified, and converted when you choose Save
Changes from the File menu. After you choose “Save Changes” from the File
menu, this message changes to “All Changes Successful.” If any changes did
not succeed, a message is written to the Errors pop-up window.

Figure 5-7 Status Information Within Host Manager

Status Area
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Logging Solstice AdminSuite Operations
You can set up a log file to record each major operation completed with the
Solstice AdminSuite tools or their command-line equivalents. After you enable
logging, the date, time, server, user ID (UID), and description for every
operation are written to the specified log file.

You need to follow the procedure described in “How to Enable Logging of
Solstice AdminSuite Operations” on page 59 on each server where you run the
Solstice AdminSuite software and want to maintain a logging file.

▼ How to Enable Logging of Solstice AdminSuite Operations

You do not need to quit a Solstice AdminSuite application or the Solstice
Launcher, if they are already started.

1. Become root.

2. Edit the /etc/syslog.conf  file and add an entry at the bottom of the file
that follows this format:

Note that filename must be the absolute path name of the file, for example:
/var/log/admin.log .

3. Create the file, filename, if it does not already exist:

user.info filename

# touch filename
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4. Make the changes to the /etc/syslog.conf  file take effect by stopping
and starting the syslog service:

Solstice AdminSuite operations will now be logged to the file you specified.

Example of a Host Manager Log File

# /etc/init.d/syslog stop
Stopping the syslog service.
# /etc/init.d/syslog start
syslog service starting.
#

Nov 30 10:34:23 lorna Host Mgr: [uid=100] Get host prototype
Nov 30 10:34:52 lorna Host Mgr: [uid=100] Adding host: frito
Nov 30 10:35:37 lorna Host Mgr: [uid=100] Get host prototype
Nov 30 10:35:59 lorna Host Mgr: [uid=100] Deleting host frito
Nov 30 10:36:07 lorna Host Mgr: [uid=100] Modifying sinister with
sinister
Nov 30 14:39:21 lorna Host Mgr: [uid=0] Read hosts
Nov 30 14:39:43 lorna Host Mgr: [uid=0] Get timezone for lorna
Nov 30 14:39:49 lorna Host Mgr: [uid=0] Get host prototype
Nov 30 14:40:01 lorna Host Mgr: [uid=0] List supported
architectures for lorna dirpath=/cdrom/cdrom0/s0
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Managing Server and Client
Support With Host Manager 6

This chapter describes how to set up and maintain server and client support by
using the Solstice Host Manager and its corresponding command-line
equivalents. This is a list of the step-by-step instructions in this chapter.

How to Start Host Manager page 80

How to Update System Types page 82

How to Set Defaults for Adding Support page 82

How to Add Support for a Standalone System or OS Server page 83

How to Convert a System to an OS Server page 88

How to Add SunOS 4.x OS Services to an OS Server page 92

How to Add Solaris 2.x OS Services to an OS Server page 98

How to Add Support for a Diskless Client page 101

How to Add Support for a Dataless Client page 105

How to Modify Support for a System page 111

How to Delete Support for a System page 111

How to Use the Command-Line Interface to Automate Setup Tasks page 112
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What Are Servers and Clients
Systems on the network can usually be described as one of the following:

• Server – A system that provides services to other systems in its network.
There are file servers, boot servers, database servers, license servers, print
servers, installation servers, and even servers for particular applications.
This chapter uses the term server to mean a system that provides file
systems and installation software for other systems on the network.

• Client – A system that uses remote services from a server. Some clients have
limited disk storage capacity, or perhaps none at all, and they have to rely
on remote file systems from a server to function. Diskless and dataless
clients are examples of this type of client.

Other clients may use remote services (such as installation software) from a
server, but they don’t rely on a server to function. A standalone system,
which has its own hard disk containing the root (/ ), /usr , and
/export/home  file systems and swap space, is a good example of this type
of client.

What Does Support Mean
Providing support for a system means providing software and services to help
another system function. Support can include:

• Making a system known to the network (i.e., host name and Ethernet
address information)

• Providing installation services to remotely boot and install a system

• Providing operating system (OS) services to a system with limited or no
disk space
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Overview of System Types
System types are basically defined by how they access the root (/) and /usr
file systems, including the swap area. For example, standalone and server
systems mount these file systems from a local disk, while diskless and dataless
clients mount the file systems remotely, relying on servers to provide these
services. Table 6-1 lists these and other differences for each system type.

Table 6-1 System Type Overview

System Type Local File Systems
Local
Swap?

Remote File
Systems

Server root (/ )
/usr
/home
/opt
/export
/export/home
/export/root

Yes optional

Standalone System root (/ )
/usr
/export/home

Yes optional

Diskless Client – none – No root (/ )
swap
/usr
/home

Dataless Client root (/ ) Yes /usr
/home

AutoClient System cached root (/ )
cached /usr

Yes root (/ )
/usr
/home
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Table 6-2 describes how the other clients compare to a standalone system.

Servers

A server system has the following file systems:

• The root (/ ) and /usr  file systems, plus swap space.

• The /export , /export/swap , and /export/home  file systems, which
support client systems and provide home directories for users.

• The /opt  directory or file system for storing application software.

Servers can also contain the following software to support other systems:

• Operating system (OS) services for diskless clients, dataless clients, and
AutoClient systems.

• Solaris CD image and boot software for networked systems to perform
remote installations.

• JumpStart™ directory for networked systems to perform custom JumpStart
installations.

Standalone Systems

A networked standalone system can share information with other systems in the
network, but it can function autonomously because it has its own hard disk
with enough space to contain the root (/ ), /usr , and /export/home  file
systems and swap space. The standalone system thus has local access to
operating system software, executables, virtual memory space, and user-
created files.

Table 6-2 Comparison of Clients Relative to a Standalone System

System Type
Centralized
Administration Performance

System
Disk
Usage

Network
Use

AutoClient System better similar better similar

Diskless Client better worse better worse

Dataless Client similar worse better worse
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A non-networked standalone system is a standalone system with all the
characteristics listed above except that is not connected to a network.

Diskless Clients

A diskless client has no disk and depends on a server for all its software and
storage area. A diskless client remotely mounts its root (/ ), /usr , and /home
file systems from a server.

A diskless client generates significant network traffic due to its continual need
to procure operating system software and virtual memory space from across
the network. A diskless client cannot operate if it is detached from the network
or if its server malfunctions.

Dataless Clients

A dataless client has local storage for its root (/ ) file system and swap space.
The dataless client cannot function if detached from the network, because its
executables (/usr ) and user files (/home ) are located across the network on the
disk of a server.

A dataless client places far less demand on the server and the network than a
diskless client does. Because dataless clients require less network access, a
server can accommodate many more dataless clients than it can diskless
clients. Also, since all the user files of all the dataless clients are stored
centrally (on a server), they can be backed up and administered centrally.

Note – SunSoft plans to remove support for dataless clients after Solaris 2.5.
You can add this system type now using Host Manager, but in future releases
of the Solaris operating environment you will need to choose a different type.
It is recommended that you use AutoClient systems instead of dataless clients.

AutoClient Systems

For detailed information about AutoClient systems and how to administer
them, see the AutoClient 2.0 Administration Guide. An AutoClient system is
nearly identical to a diskless client in terms of installation and administration.
It has the following characteristics:
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• Requires a 100-Mbyte or larger local disk for swapping and for caching its
individual root (/ ) file system and the /usr  file system from a server.

• Can be set up so that it can continue to access its cache when the server is
unavailable.

• Relies on servers to provide other file systems and software applications.

• Contains no permanent data, making it a field replaceable unit (FRU).

Note – You must obtain a license for each AutoClient system you want to add
to your network. See the Solstice AdminSuite 2.2 Installation and Product Notes
for licensing information.

What You Can Do With Host Manager
Host Manager is a graphical user interface that enables you to add and
maintain server and client support on a network. With a name service like
NIS+, you can manage system information in a centralized manner so that
important system information, such as host names, do not have to be
duplicated on every system in the network.

Host Manager enables you to:

• Add and modify system support
• Update system types
• Convert system types
• Add OS services
• Set up remote installation services
• Queue tasks

Add and Modify System Support

Host Manager enables you to add and modify support for the following
system types:

• Solstice AutoClient systems
• Solaris diskless clients
• Solaris dataless clients
• Solaris standalone systems
• Solaris OS servers
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For detailed information about each system type, see “Overview of System
Types” on page 63.

Table 6-3 describes the server-client configurations that are supported by the
Solstice AdminSuite 2.2 release of Host Manager.

Note – The SunOS 4.x release is only supported on SPARC systems with the
Sun4, Sun4c, or Sun4m platform group. SunSoft plans to remove support for
the SunOS 4.x release in a later version of the Solstice AdminSuite software.

Update System Types

Host Manager initially marks the system types of previously added systems as
generic. However, you can choose Update System Types from the File menu to
probe previously added systems and attempt to determine their system types.
If Host Manager cannot determine the system type (for example, the system is
not running the Solaris software) the systems will stay marked as generic.

1. AutoClient systems are only supported on Solaris 2.4 – 2.5.1.

Table 6-3 Supported Server-Client Configurations

If You Have An ...
You Can Add OS Services
and Support For ... For the Following Releases ...

x86 server running
Solaris 2.4 – 2.5.1

SPARC clients1 Solaris 2.3 – 2.5.1

x86 clients Solaris 2.4 – 2.5.1

PowerPC clients Solaris 2.5.1

SPARC server running
Solaris 2.3 – 2.5.1

SPARC clients1 SunOS 4.x, Solaris 2.3 – 2.5.1

x86 clients Solaris 2.4 – 2.5.1

PowerPC clients Solaris 2.5.1

Power PC server
running
Solaris 2.5.1.

SPARC clients1 Solaris 2.3 – 2.5.1

x86 clients Solaris 2.4 – 2.5.1

PowerPC clients Solaris 2.5.1
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Note – Previously added systems running Solaris 2.5 must also have the
Solstice AdminSuite software installed for Host Manager to determine their
system type.

The system type information is stored in the bootparams  file in the local /etc
files or a name service database. Host Manager will either modify an existing
bootparams  entry or add a new one such as the following for a Solaris
standalone system named mars :

Convert System Types

Host Manager enables you to convert one system type to another. Table 6-4
shows what conversions you can make.

You can add Solaris 2.x OS services during a conversion to an OS server.

Add OS Services

A Solaris OS server is a server that provides operating system (OS) services to
support diskless or dataless clients. By using Host Manager, you can add
support for an OS server or convert a standalone system to an OS server.

mars boottype=:st

Table 6-4 System Type Conversions

You Can Convert A  ... To A ...

Standalone System AutoClient System, or
OS Server

Dataless System AutoClient System, or
OS Server

AutoClient System Standalone System

Generic System Standalone System, or
AutoClient System, or
OS Server
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For each platform group and Solaris release that you want to support, you
must add the particular OS service to the OS server. For example, if you want
to support SPARC Sun4m systems running Solaris 2.4, you must add
Sun4m/Solaris 2.4 OS services to the OS server. You would also still need to
add OS services to support SPARC Sun4c systems or x86 systems running
Solaris 2.4,because they are different platform groups.

You must have access to the appropriate Solaris CD image to add OS services.

Caution – Once you successfully add OS services to an OS server, they cannot
be deleted using Host Manager.

Note – Although Host Manager enables you to add support for diskless and
dataless clients running the Sun4.x release, you cannot add SunOS 4.x OS
services using Host Manager. You must use the install4x  command to add
OS services to an OS server and then use Host Manager to add support for the
SunOS 4.x client.

Set Up Remote Installation Services

Host Manager enables you to set up systems to provide Solaris 2.x installation
services for other systems on the network. You can set up the following types
of installation services on a system:

• An install server – A system on the network that provides a Solaris CD
image (either from a CD-ROM drive or a copy on a hard disk) for other
systems to install from.

• A boot server – A system that provides boot information to other systems
on the network. The boot server and the install server are usually the same
system.

• A profile server – A system that contains JumpStart files for systems to
perform a custom JumpStart installation.

Note – A boot server and install server are typically the same system.
However, if the system to be installed is on a different subnet than the install
server, a boot server is required on that subnet.

!
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Queue Tasks

Host Manager enables you to queue tasks such as converting system types and
adding OS services. Since these tasks may require several minutes to process,
Host Manager enables you to set up tasks to be performed without requiring
you to wait for each task to be completed. After setting up the tasks, choose
Save Changes from the File menu. Host Manager’s progress is displayed in the
message bar located at the bottom of the window as each task is processed.

What You Can’t Do With Host Manager
Table 6-5 shows the limitations of Host Manager and their suggested
workarounds.

Table 6-5 Host Manager Limitations and Workarounds

Limitation Workaround

Host Manager cannot automatically recognize all
previously added system types.

Use the Update System Type option from the File menu the
first time you use Host Manager. This option will probe
systems on the network and attempt to identify their system
types.

Host Manager can’t add SunOS 4.x services to an OS
server.

Mount a SunOS 4.x CD image and add OS services by using
the install4x  command.

Host Manager can’t provide remote installations
services for SunOS 4.x systems.

Install SunOS 4.x systems from the local CD-ROM drive.

Host Manager does not allow you to add host aliases
(needed for servers with multiple network interfaces,
also known as multi-homed hosts).

Enter the host aliases into the name service with Database
Manager.

Host Manager does not enable you to install patches on
existing clients and servers. (However, if you have used
the admclientpatch  command to set up a patch spool
directory, Host Manager will reference this spool
directory and add appropriate patches for all new
hosts.)

Use the admclientpatch  command to set up a patch spool
directory and to update existing servers and clients with the
latest patches. See admclientpatch(1M)  for details.

Host Manager does not enable you to remove OS
services from an OS server after they have been
successfully installed.
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Command-Line Equivalents of Host Manager
Table 6-6 lists the commands that provide the same functionality as Host
Manager and can be used without running an X Window System, such as the
OpenWindows environment. Many of the Host Manager procedures in this
chapter provide corresponding examples using the command-line equivalents.
Also see “Using the Command-Line Interface to Automate Setup Tasks” on
page 112 for more information on using the command-line equivalents in a
script to automate setup tasks.

Files Modified by Host Manager
Table 6-7 describes the system files modified by Host Manager.

Table 6-6 Command-Line Equivalents of Host Manager

Command Description

admhostadd Adds support for a new system or OS server.

admhostmod Modifies an existing system or OS server. You can also add OS
services to an existing OS server.

admhostdel Deletes an existing system or OS server.

admhostls Lists the existing system entries in the selected name service.

admhostls -h Lists hardware information of one or more system entries in
the selected name service.

Table 6-7 Files Modified by Host Manager

System File Where Modified Description

bootparams /etc , NIS, or NIS+ A database listing the servers that provide the
paths to a client’s boot and installation software
and a client’s root and swap areas

/etc/dfs/dfstab Server providing the file
services

A file containing a series of share  commands
that make file services available to the client

ethers /etc , NIS, or NIS+ A database containing the client’s Ethernet
address

hosts /etc , NIS, or NIS+ A database containing the client’s host name and
associated IP address

timezone /etc , NIS, or NIS+ A database containing the client’s time zone
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Setting Up a Name Service Policy
A name service policy is used to specify the location of system and network
information managed by the Solstice AdminSuite software. This information
can be located in the /etc  directory for a local system, or in the NIS+ or NIS
name service.

The Solstice AdminSuite software supports a mixed-mode name service policy.
A mixed-mode name service policy enables you to specify different name
services for configuration information. Note that this functionality is primarily
useful with Host Manager.

You can use the admtblloc(1M)  command to choose a mixture of name
services for the Solstice AdminSuite tools to populate. For example, you can set
up Host Manager to populate local /etc  files for bootparams  information
and to populate the NIS+ tables for the other host configuration information,
as shown in Figure 6-1.

/export/root Server providing the file
services

A default directory that contains root files for a
diskless client or AutoClient system

/export/swap Server providing the file
services

A default directory that contains the swap file for
a diskless client

/var/sadm/softinfo Solaris 2.3 server
providing OS services

A directory containing a list of OS services
available on Solaris 2.3 server

/var/sadm/system/admin/services Solaris 2.4 - 2.5.1 server
providing OS services

A directory containing a list of OS services
available on a Solaris 2.4 - 2.5.1 server

/tftpboot Server providing the
boot services

A directory containing SPARC and PowerPC
client booting information

/rplboot Server providing the
boot services

A directory containing x86 client booting
information

/etc/inetd.conf Server providing the
boot services

A system file that starts the tftp  and rpl  boot
daemons

cred.org_dir NIS+ A NIS+ table used to store the host’s DES and
LOCAL credentials

Table 6-7 Files Modified by Host Manager (Continued)

System File Where Modified Description



Managing Server and Client Support With Host Manager 73

6

Figure 6-1 Example Mixed-Mode Name Service Policy

Caution – If you choose to implement a mixed-mode name service policy, you
must run the Solstice AdminSuite software from the system containing
information in the /etc  directory.

The admtblloc  Command

The admtblloc  command is used to implement a mixed-mode name service
policy in Solstice AdminSuite. To use this command, you must have
permission to use the software for each name service as described in “Setting
Up User Permissions to Use Solstice AdminSuite” on page 15.

hosts.org_dir

ethers.org_dir

/etc/bootparams

cred.org_dir

NIS+ domain: solar.com

NONE: local /etc files

timezone.org_dir

!
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Note – The admtblloc  command has no relation to the
/etc/nsswitch.conf  file used to set the system-wide name service selection
policy in the Solaris 2.x operating environment. The admtblloc  command is
used to set the policy for all users of Solstice AdminSuite graphical user
interface tools or command line interfaces.

Specifying the Name Service Policy Using admtblloc

This example shows how to specify the name service policy specified in
Figure 6-1 using the admtblloc  command:

In this example,

After setting the mixed-mode name service policy specified in Figure 6-1,
Solstice AdminSuite will use the bootparams  information stored in the /etc
directory on the current host running the Solstice AdminSuitetool whenever
the name service (specified in the Load window) is NIS+. The name service
policy for the other configuration files (hosts , ethers , timezone  and
credential ) is NIS+, unless you specify otherwise using admtblloc  again.
The mixed-mode name service policy remains in effect for all users of Solstice
AdminSuite in the name service until you change it using the admtblloc
command once again.

$ admtblloc -c NIS+ -d solar.com bootparams NONE

- c NIS+ -d solar.com The NIS+ domain solar.com  is the name
service context (the name service and domain
name specified in the Load window).

bootparams bootparams  is the configuration file to set
the name service policy for.

NONE NONE specifies that the host running the
Solstice AdminSuitetool or command line
interface must use the bootparams  file
found in the local /etc  directory.
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Note – If you specify that the name service location of a configuration file is
NONE using the admtblloc  command, the /etc  file on the current host
running the Solstice AdminSuite application or command-line interface is
modified. You should log in to the host where you want to use the local /etc
file and perform operations using the Solstice AdminSuite on that system.

Viewing the Name Service Policy Using admtblloc

This example shows how to display the name service policy using the
admtblloc  command:

$ admtblloc
Name           Name Service  Path

Aliases        NIS+
Hosts          NIS+
Group          NIS+
Netgroup       NIS+
Protocols      NIS+
Bootparams     NONE
Auto.home      NIS+
RPC            NIS+
Timezone       NIS+
Netmasks       NIS+
Ethers         NIS+
Passwd         NIS+
Services       NIS+
Networks       NIS+
Locale         NIS+
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In this example output,

By default, the name service policy displayed by the admtblloc  command is
for the name service the current host is a member of. To display the name
service policy for a different name service, specify the name service context.

This example shows how to display the name service policy for the NONE or
local /etc  files name service context domain using the admtblloc  command:

In this example,

Name Is the name of the configuration file.

Name Service Specifies the name service used to access the
configuration file.

Path (Optional) Specifies the path to the ASCII
source file on NIS servers in the NIS name
service. The default is the /etc  directory.

$ admtblloc -c NONE
Name           Name Service  Path
Aliases        NONE
Hosts          NONE
Group          NONE
Auto_home      NONE
Netgroup       NONE
Protocols      NONE
Bootparams     NONE
RPC            NONE
Timezone       NONE
Netmasks       NONE
Ethers         NONE
Passwd         NONE
Services       NONE
Networks       NONE
Locale         NONE

-c Specifies the name service context.

NONE Is the local /etc  files name service.
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You can also use the admtblloc  command to display the name service policy
for a specified configuration file. This example shows how to display the name
service policy for the hosts  file in the default name service:

Note – The configuration file names are case-sensitive.

Configuration Files Supported by the admtblloc  Command

Following is a list of the configuration files Solstice AdminSuite can use in a
mixed-mode name service environment.

• Aliases
• Hosts
• Group
• Auto_home
• Credentials
• Netgroup
• Protocols
• Bootparams
• Rpc
• Timezone
• Netmasks
• Ethers
• Passwd
• Services
• Networks
• Locale

Note – The admtblloc  command can be used to set the name service policy
for only the configuration files present in this list.

Refer to the admtblloc(1M)  man page for more information about how to use
this command.

$ admtblloc Hosts
Hosts          NIS+
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Adding Server and Client Support

Table 6-8 Task Map: Adding Server and Client Support

Activity Description For Instructions, Go To

Update System
Types

Optional. Make sure Host Manager recognizes all the
previously added system types. This is usually a one-
time task before using the AdminSuite 2.2 Host Manager
for the first time.

▼ How to Update
System Types

page 82

Set Defaults for
Adding Support

Optional. Before you add support for several clients, set
up defaults for the Add window by choosing Set Defaults
from the Host Manager’s Edit menu. Setting up defaults
can increase the consistency and efficiency of adding
support for systems.

▼ How to Set Defaults
for Adding Support

page 82

Add Support for a
Standalone

System

Add Support for a Standalone System
Add support for a standalone system by choosing Add
from the Host Manager’s Edit menu. Once in the Add
window, choose Standalone System from the System
Type menu.

You can also convert a AutoClient system or generic
system to a standalone system by choosing Convert to
Standalone from the Edit menu.

▼ How to Add
Support for a
Standalone System
or OS Server

page 83

Add Support for an
OS Server

Add Support for an OS Server
Add support for an OS server by choosing Add from the
Host Manager’s Edit menu. Once in the Add window,
choose OS Server from the System Type menu.

▼ How to Add
Support for a
Standalone System
or OS Server

page 83

Convert a Standalone System to an OS Server
Convert a standalone system to an OS server by
choosing Convert from the Host Manager’s Edit menu.
You can add Solaris 2.x OS services during the
conversion.

▼ How to Convert a
System to an OS
Server

page 88
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Add OS Services
to an OS Server

Add SunOS 4.x OS Services
If you need to add support for SunOS 4.x diskless or
dataless clients, an OS server must have the
appropriate SunOS 4.x services added.

▼ How to Add SunOS
4.x OS Services to
an OS Server

page 92

Add Solaris 2.x OS Services
If you need to add support for Solaris 2.x diskless
clients, dataless clients, or AutoClient systems, an OS
server must have the appropriate Solaris 2.x services
added.

▼ How to Add Solaris
2.x OS Services to
an OS Server

page 98

Add Support for
Clients

Add Support for AutoClient Systems
Add support for an AutoClient system by choosing Add
from the Host Manager’s Edit menu. Once in the Add
window, choose Solstice Autoclient System from the
System Type menu.

Solstice AutoClient 2.0
Administration Guide

Add Support for a Diskless Client
Add support for a diskless client by choosing Add from
the Host Manager’s Edit menu. Once in the Add window,
choose Solaris Diskless Client from the System Type
menu.

▼ How to Add
Support for a
Diskless Client

page 101

Add Support for a Dataless Client
Add support for a dataless client by choosing Add from
the Host Manager’s Edit menu. Once in the Add window,
choose Solaris Dataless Client from the System Type
menu.

▼ How to Add
Support for a
Dataless Client

page 105

Table 6-8 Task Map: Adding Server and Client Support (Continued)

Activity Description For Instructions, Go To
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▼ How to Start Host Manager

1. Verify that the prerequisites described in Chapter 1, “Introduction,” are
met.

2. Start the Solstice Launcher.

The Solstice Launcher is displayed.

3. Click on the Host Manager icon.

The Load window is displayed.

4. Select the name service used in your network.

5. Check that the domain or host name is correct.
If not, type the domain or host name you need to access.

6. Click on OK.
The Host Manager main window is displayed.

$ solstice &
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Example of a Host Manager Main Window
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▼ How to Update System Types

This procedure attempts to determine the system types for systems marked as
generic.

1. Start Host Manager from the Solstice Launcher and select the name
service, if not done already.
See “How to Start Host Manager” on page 80 for more information.

2. Select Update System Types from the File menu on the Host Manager
Window.
The Update Systems Types window is displayed.

3. Click on Update to update the systems marked as generic.

Command-Line Equivalent for Updating System Types

You can also use the admhostmod -x type= type host command to update a
system type.

▼ How to Set Defaults for Adding Support

1. Start Host Manager from the Solstice Launcher and select the name
service, if not done already.
See “How to Start Host Manager” on page 80 for more information.

2. Choose Set Defaults from the Edit menu.
The Set Add Defaults window is displayed.

3. Fill in the Set Add Defaults window.
The defaults you select will be the initial defaults values in the Add
window. If you need information to complete a field, click on the Help
button to see field definitions for this window.

4. Click on OK.

Command-Line Equivalent for Updating System Types

You can also use the admhostadd -D  command to set up defaults for adding
support.
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▼ How to Add Support for a Standalone System or OS Server

The high-level steps in this procedure are:

• Add system information about the system.
• (Optional) Set up remote install capabilities for the system.
• (Optional) Install the system.

1. Start Host Manager from the Solstice Launcher and select the name
service, if not done already.
See “How to Start Host Manager” on page 80 for more information.

2. Choose Add from the Edit menu on the Host Manager window.
The Add window is displayed.

3. Fill in the system information, selecting Solaris Standalone or OS Server
as the system type.
The system information includes all the fields from the host name through
the time zone. If you need information to complete a field, click on the Help
button to see field definitions for this window.

4. If you want to set up remote install capabilities for the system, continue
to Step 5. If not, skip to Step 10.

5. Click on Enable Remote Install.

6. Select an Install Server.
The Install Server defaults to the current host. Select Other from the Install
Server menu to specify another host as the install server.



84 Solstice AdminSuite 2.2 Administration Guide—May 1996

6

7. Click on Set Path to identify the path to the Solaris CD image on the
install server.
If the install server is a remote system, note that it must be minimally set up
as a managed system.

8. Select the system’s architecture type and OS release from the OS Release
menu.
The architecture type must match the system’s architecture and the OS
release should match the Solaris release you want to remotely install on the
system.

9. If necessary, specify a boot server and/or profile server.
To specify another server other than the default, select Other from the menu.
Select a Profile Server from the Profile Server pull-down menu. You must
also specify a path to the boot software on the boot server or the custom
JumpStart directory on the profile server.

To set up the other components of a custom JumpStart installation and
preconfiguring network and system information, see SPARC: Installing
Solaris Software, x86: Installing Solaris Software, or Solaris PowerPC Edition:
Installing Solaris Software.

10. Click on OK on the Add window.

11. Select Save Changes from the File menu to add support for the standalone
system or OS server.
The standalone system or OS server is displayed in the Host Manager main
window.

If You Are Using ... And ... Then Enter the Path ...

The Solaris CD as the
Solaris CD image

The Solaris CD is
managed by Volume
Management

/cdrom/cdrom0  or
/cdrom/cdrom0/s0  or
/cdrom/cdrom0/s2

The Solaris CD is not
managed by Volume
Management

Where you mounted the
Solaris CD

A copy of the Solaris CD on
the install server’s hard
disk (by using
setup_install_server )

To the Solaris CD image
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12. (Optional) Boot and install the standalone system or OS server.
For more information about booting and installing, see SPARC: Installing
Solaris Software, x86: Installing Solaris Software, or Solaris PowerPC Edition:
Installing Solaris Software.

Note – If you are installing an OS server, you must allocate space in /export
and /export/swap  for the desired number of clients.
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Example of a Completed Add Window for a Standalone System



Managing Server and Client Support With Host Manager 87

6

Example of a Command-Line Equivalent for Adding a Standalone
System

The following command is equivalent to using Host Manager to add a
standalone system to the name service database.

In this command,

Example of a Command-Line Equivalent for Adding a Standalone
System and Enabling Remote Installation

The following command is equivalent to using Host Manager to add a
standalone system and to enable a network installation.

In this command,

% admhostadd -i 129.152.225.2 -e 8:0:20:b:40:e9 -x type=STANDALONE -x tz=US/Mountain venus

-i 129.152.225.2 Specifies the IP address of the system.

-e 8:0:20:b:40:e9 Specifies the Ethernet address of the system.

-x type=STANDALONE Specifies the type of the system.

-x tz=US/Mountain Specifies the system’s timezone.

venus Specifies the name of the system.

% admhostadd -i 129.152.225.2 -e 8:0:20:b:40:e9 -x type=STANDALONE -x tz=US/Mountain
-x install=Y -x installpath=cable:/cdrom/cdrom0/s0 venus

-i 129.152.225.2 Specifies the IP address of the system.

-e 8:0:20:b:40:e9 Specifies the Ethernet address of the system.

-x type=STANDALONE Specifies the type of the system.

-x tz=US/Mountain Specifies the system’s timezone.
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Where to Go From Here

If you want to add OS services after you install an OS server, see “How to Add
Solaris 2.x OS Services to an OS Server” on page 98.

▼ How to Convert a System to an OS Server

1. Start Host Manager from the Solstice Launcher and select the name
service, if not done already.
See “How to Start Host Manager” on page 80 for more information.

2. Select a host entry from Host Manager’s main window.
You can convert a standalone system, dataless client, and generic system to
an OS server.

3. Choose Convert to OS Server from the Edit menu.
The Convert window is displayed, and the selected system is displayed in
the host name field.

4. Click on the Add button in the OS Services window to add services.

-x install=Y Specifies that remote installation is enabled.

-x installpath=
cable:/cdrom/cdrom0/s0

Specifies that the Solaris CD image is on a
mounted CD on a remote system named cable .
Note that the remote system must be minimally
set up as a managed system.

venus Specifies the name of the system.
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5. Click on Set Path to identify the path to the Solaris CD image from which
to add the client services.
The Install Server defaults to the current host. Select Other from the Install
Server menu to specify another host as the install server. Note that a remote
system must be minimally set up as a managed system.

6. Specify the type of services you want to add and click on Add.
The OS service is added to the OS Services list and marked with a plus sign
(+), which means it will be added when you save changes. You can use the
Delete button to delete an OS service from the list before you save changes.

7. Click on OK on the Convert window.

8. Select Save Changes from the File menu to convert the system to an OS
Server.
The converted system is displayed as an OS server in the Host Manager
main window.

If You Are Using ... And ... Then Enter the Path ...

The Solaris CD as the
Solaris CD image

The Solaris CD is
managed by Volume
Management

/cdrom/cdrom0  or
/cdrom/cdrom0/s0  or
/cdrom/cdrom0/s2

The Solaris CD is not
managed by Volume
Management

Where you mounted the
Solaris CD

A copy of the Solaris CD on
the Install Server’s hard
disk (by using
setup_install_server )

Where you specified
setup_install_server
to copy the Solaris CD
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Example of a Completed Convert Window

Each OS service
consists of a platform,
platform group, and OS
Release. OS services
marked with a plus sign
(+) are added when you
save changes. You can
use the Delete button to
delete services to be
added.
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Example of a Command-Line Equivalent for Converting a
Standalone to an OS Server

The following command is equivalent to using Host Manager to convert a
standalone system to an OS server.

Example Command-Line Equivalent for Adding Services to an OS
Server

The following command is equivalent to using Host Manager to add OS
services an OS server.

In this command,

% admhostmod -x type=OS_SERVER minnie

% admhostmod -x mediapath=jupiter:/cdrom/cdrom0/s0 -x platform=sparc.sun4m.Solaris_2.5
minnie

-x mediapath=
jupiter:/cdrom/cdrom0/s0

Specifies that the Solaris CD image is on a
mounted CD on a remote system named
jupiter . Note that the remote system must
be minimally set up as a managed system.

-x platform=
sparc.sun4m.Solaris_2.5

Specifies the services to be installed, in this
case the Solaris 2.5 services for a SPARC
Solaris, Sun4m kernel architecture.

minnie Specifies the name of the OS server.
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▼ How to Add SunOS 4.x OS Services to an OS Server

Note – SunSoft plans to remove support for the SunOS 4.x release in a later
version of the Solstice AdminSuite software. Also, you cannot add SunOS 4.x
services to x86 and PowerPC OS servers.

The high-level steps in this procedure are:

• Determine the OS server to which you want to add SunOS 4.x OS services
for diskless and dataless clients.

• Verify that the SunOS 4.x heterogeneous install software is installed.

• Install the required SunOS 4.x release software (install4x  command).

1. Log in as root on the OS server to which you want to add SunOS 4.x OS
services for diskless and dataless clients.

2. Verify that the SunOS 4.x heterogeneous install software is installed.

If the package information is displayed, proceed to Step 7. If not, go to the
next step.

3. Insert the Solaris 2.x CD into your CD-ROM drive.
This step assumes that your system is running Volume Management.

Note – Use the Solaris 2.x CD that matches the Solaris 2.x release that is
installed on the OS server. For example, use the Solaris 2.4 11/94 CD if the OS
server is running the Solaris 2.4 11/94 release.

To access the SunOS 4.x CD from another system running either the Solaris
2.x release or the SunOS 4.x release, see “Setting Up the CD-ROM Drive for
install4x ” in the Solaris 1.x to 2.x Transition Guide.

4. Change directory to the location of the software.

# pkginfo SUNWhinst

# cd /cdrom/cdrom0/s0/Solaris_2. x
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5. Install the SunOS 4.x heterogeneous install software.

6. Eject the Solaris 2.x CD.

7. Insert the SunOS 4.x release CD into your CD-ROM drive.
This step assumes that your system is running Volume Management, and
the CD-ROM drive is directly attached to the server. Volume Management
automatically mounts the CD directory on /cdrom/volume1/s0.

# pkgadd -d ‘pwd‘ SUNWhinst

# cd
# eject cd
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8. Start the SunOS 4.x release software installation program.

The main menu is displayed.

# /usr/sbin/install4x -m /cdrom/volume1/s0 -e /export

                         *** 4.1* Install Main Menu ***

     Choose an Architecture (then select modules to load):

                                          Modules
                                     Loaded    Selected
     [a] sun4.sun4c.sunos.4.1.2         0          0
     [b] sun4.sun4.sunos.4.1.2          0          0
     [c] sun4.sun4m.sunos.4.1.2         0          0

   or begin the loading process for all selected modules:

     [L] Load selected modules

   or abort without loading any modules:

     [Q] Quit without loading                               +-------------------+
                                                            | Disk Usage:       |
   Type any bracketed letter to select that function.       |       0K Selected |
                                                            |   53634K Free     |
   Type ? for help.                                         +-------------------+
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9. On the main menu, specify the architecture you want to support by typing
the associated character that is shown in brackets.
The Module Selection menu is displayed.

10. Select modules to load by typing the associated character that is shown in
brackets.
The Module Selection screen readily enables you to pick groups of modules
to be loaded. When you enter a 1, it marks all required modules for loading.
When you enter a 2, it marks all recommended modules. When you enter a
3, it marks all commonly loaded modules. When you enter a 4, it marks all
optional modules. When you enter a 5, it marks all modules shown on the
Module Selection screen.

Select sun4.sun4c.sunos.4.1.2 modules:
  +[a] R proto root................240K  |  [o]   User_Diag................6352K
  +[b] R usr.....................26240K  |  [p]   Manual...................7456K
  +[c] R Kvm......................4832K  | +[q] D TLI........................48K
  +[d] R Install...................936K  |  [r] D RFS.......................912K
   [e] D Networking...............1040K  |  [s] D Debugging................2928K
   [f] D System_V.................4008K  |  [t]   SunView_Programmers......1840K
   [g] D Sys......................5288K  |  [u]   Shlib_Custom.............1376K
   [h] C SunView_Users............2664K  |  [v]   Graphics.................1784K
   [i]   SunView_Demo..............512K  | +[w]   uucp......................608K
  +[j]   Text......................712K  | +[x]   Games....................3136K
   [k]   Demo.....................4264K  |  [y]   Versatec.................5960K
   [l] C OpenWindows_Users.......25936K  |  [z]   Security..................312K
   [m] C OpenWindows_Demo.........4288K  |  [A]   OpenWindows_Programmers.10200K
   [n] C OpenWindows_Fonts........7840K  |

Module     + = already loaded        R = Required     C= Common
Legend:   ** = selected for loading  D = Desirable    Others are optional

Select [a-A] or a Quick-Pick Option:                       +-------------------+
    [1] All Required Modules     [4] All Optional Modules  | Disk Usage:       |
    [2] All Desirable  Modules   [5] All Modules           |       0K Selected |
    [3] All Common Modules                                 |   53634K Free     |
 or [D] (done) to return to the main screen                +-------------------+
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11. Return to the main menu by typing D.
The main menu is displayed.

12. Type L to install the software.
The modules you previously selected are installed.

13. After the modules are installed, press any key to return to the main menu.
The loaded modules are displayed in the main menu.

14. If you want to add support for other architectures, repeat Step 9 through
Step 12. Otherwise, type Q to exit.

                         *** 4.1* Install Main Menu ***

     Choose an Architecture (then select modules to load):

                                          Modules
                                     Loaded    Selected
     [a] sun4.sun4c.sunos.4.1.2         0          4
     [b] sun4.sun4.sunos.4.1.2          0          3
     [c] sun4.sun4m.sunos.4.1.2         0          1

   or begin the loading process for all selected modules:

     [L] Load selected modules

   or abort without loading any modules:

     [Q] Quit without loading                               +-------------------+
                                                            | Disk Usage:       |
   Type any bracketed letter to select that function.       |       0K Selected |
                                                            |   53634K Free     |
   Type ? for help.                                         +-------------------+

Installing module ‘proto root’ [size: 248K]
        in directory /export/exec/proto.root.sunos.4.1.2 ...

Updating server databases ...

Press any key to continue:
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Note – There is no command-line equivalent for adding SunOS 4.x services to
an OS server.

Where to Go From Here

If you want to add SunOS 4.x support for a diskless client, see “How to Add
Support for a Diskless Client” on page 101. If you want to add SunOS 4.x
support for a dataless client, see “How to Add Support for a Dataless Client”
on page 105.
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▼ How to Add Solaris 2.x OS Services to an OS Server

1. Start Host Manager from the Solstice Launcher and select the name
service, if not done already.
See “How to Start Host Manager” on page 80 for more information.

2. Select an OS server to modify from the Host Manager main window.

3. Select Modify from the Edit menu on the Host Manager window.
The Modify window is displayed.

4. Click on the Add button in the OS Services window to add services.

5. Click on Set Path to identify the path to the Solaris CD image from which
to add the client services.
The Install Server defaults to the current host. Select Other from the Install
Server menu to specify another host as the install server. Note that a remote
system must be minimally set up as a managed system.

6. Specify the type of services you want to add and click on Add.
The OS service is added to the OS Services list and marked with a plus sign
(+), which means it will be added when you save changes. You can use the
Delete button to delete an OS service from the list before you save changes.

7. Click on OK on the Add window.

8. Select Save Changes from the File menu to add services.

If You Are Using ... And ... Then Enter the Path ...

The Solaris CD as the
Solaris CD image

The Solaris CD is
managed by Volume
Management

/cdrom/cdrom0  or
/cdrom/cdrom0/s0  or
/cdrom/cdrom0/s2

The Solaris CD is not
managed by Volume
Management

Where you mounted the
Solaris CD

A copy of the Solaris CD on
the Install Server’s hard
disk (by using
setup_install_server )

Where you specified
setup_install_server
to copy the Solaris CD
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Example of a Completed Add OS Services Window

Each OS service
consists of a platform,
platform group, and OS
Release. OS services
marked with a plus sign
(+) are added when you
save changes. You can
use the Delete button to
delete services to be
added.
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Example of a Command-Line Equivalent for Adding Services to an
OS Server

The following command is equivalent to using Host Manager to add OS
services an OS server.

In this command,

% admhostmod -x mediapath=jupiter:/cdrom/cdrom0/s0 -x platform=sparc.sun4c.Solaris_2.5
rogue

-x mediapath=
jupiter:/cdrom/cdrom0/s0

Specifies that the Solaris CD image is on a
mounted CD on a remote system named
jupiter . Note that the remote system must
be minimally set up as a managed system.

-x platform=
sparc.sun4c.Solaris_2.5

Specifies the services to be installed, in this
case the Solaris 2.5 services for a SPARC
Solaris, Sun4c kernel architecture.

rogue Specifies the name of the OS server.
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▼ How to Add Support for a Diskless Client

The high-level steps in this procedure are:

• Add system information about the diskless client.
• Select OS services for the diskless client.
• Boot the diskless client.

Note – This procedure assumes the system providing the services (the file
server) has already been configured as an OS server.

1. Start Host Manager from the Solstice Launcher and select the name
service, if not done already.
See “How to Start Host Manager” on page 80 for more information.

2. Select Add from the Edit menu on the Host Manager main window.
The Add window is displayed.

3. Fill in the system information, selecting Solaris Diskless as the system
type.
The system information includes all the fields from the host name through
the timezone. If you need information to complete a field, click on the Help
button to see field definitions for this window.

4. Select a File Server.
The File Server defaults to the current host. Select Other from the Install
Server menu to specify another host as the install server.

5. Select the client’s architecture type and the OS release from the OS
Release menu.
The architecture type must match the diskless client’s architecture and the
OS release should match the Solaris release you want diskless client to run.

6. Identify the system’s root path, swap path, and swap size.

7. Click on OK on the Add window.

8. Select Save Changes from the File menu to add support for the diskless
client.
The diskless client is displayed in the Host Manager main window. It takes
several minutes to add the diskless client support, particularly to create the
system’s root and swap areas and apply any applicable patches with the
admclientpatch(1M)  command.
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Caution – For the diskless client to work properly, it needs root access to its
/export/root  directory. If Host Manager displays a message that the
/export  directory is already shared and has different share options than
required, you need to allow root access to the client root area before the
diskless client will function properly. The access mode for the client root is
normally rw= clientname, root= clientname.

If Host Manager displays a message that the /usr  directory is already shared,
it is because it tried to share /usr  read-only. If you have it shared with
read-write permissions, it is okay and you do not have to make any
modifications.

9. Boot the diskless client from the network.
Refer to Chapter 12, “Booting a System From the Network,” for detailed
information on how to boot a diskless client manually or how to set up a
diskless client to automatically boot from the network.

10. Provide the following system configuration information for the diskless
client during the initial boot process, if prompted.
• Geographic region
• Time zone
• Date and time

11. Create a root password when prompted.

!
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Example of a Completed Add Window for a Diskless Client



104 Solstice AdminSuite 2.2 Administration Guide—May 1996

6

Example of a Command-Line Equivalent for Adding Diskless Client

The following command is equivalent to using Host Manager to add support
for a diskless client.

In this command,

% admhostadd -i 129.152.221.66 -e 8:0:20:d:63:b2 -x type=DISKLESS -x tz=US/Mountain
-x fileserv=pluto -x os=sparc.sun4c.Solaris_2.5 -x root=/export/root -x swap=/export/swap
-x swapsize=24 orion

-i 129.152.221.66 Specifies the IP address for the diskless
client.

-e 8:0:20:d:63:b2 Specifies the Ethernet address for the
diskless client.

-x type=DISKLESS Specifies the type of the system.

-x tz=US/Mountain Specifies the system’s timezone.

-x fileserv=pluto Specifies the name of the OS server for the
diskless client.

-x os=
sparc.sun4c.Solaris_2.5

Specifies platform, kernel architecture, and
software release of the diskless client.

-x root=/export/root Specifies the root path of the diskless client.

-x swap=/export/swap Specifies the directory where the swap file
will be created.

-x swapsize=24 Specifies the size the swap file.

orion Specifies the name of the diskless client.
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▼ How to Add Support for a Dataless Client

The high-level steps in this procedure are:

• Add system information about the dataless client.
• Select OS services for the dataless client.
• (Optional) Set up remote install capabilities for the dataless client.
• (Optional) Boot and install the dataless client.

Note – This procedure assumes the system providing the services (the file
server) has already been configured as an OS server.

1. Start Host Manager from the Solstice Launcher and select the name
service, if not done already.
See “How to Start Host Manager” on page 80 for more information.

2. Select Add from the Edit menu on the Host Manager main window.
The Add window is displayed.

3. Fill in the system information, selecting Solaris Dataless as the system
type.
The system information includes all the fields from the host name through
the time zone. If you need information to complete a field, click on the Help
button to see field definitions for this window.

4. Select a File Server.
The File Server defaults to the current host. Select Other from the Install
Server menu to specify another host as the install server.

5. Select the system’s architecture type and OS release from OS Release
menu.
The architecture type must match the dataless client’s architecture, and the
OS release should match the Solaris release you want the dataless client to
run.

6. If you want to set up remote install capabilities for the system, continue
to Step 7. If not, skip to Step 11.

7. Click on Enable Remote Install.

8. Select an Install Server.
The Install Server defaults to the current host. Select Other from the Install
Server menu to specify another host as the install server.
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9. Click on Set Path to identify the path to the Solaris CD image on the
install server.
If the install server is a remote system, note that it must be minimally set up
as a managed system.

Note – The path to the Solaris CD image must be the same release that you
specified in the OS Release menu.

10. If necessary, specify a boot server and/or profile server.
To specify another server other than the default, select Other from the menu.
Select a Profile Server from the Profile Server pull-down menu. You must
also specify a path to the boot software on the boot server or the custom
JumpStart directory on the profile server.

To set up the other components of a custom JumpStart installation and
preconfiguring network and system information, see SPARC: Installing
Solaris Software, x86: Installing Solaris Software, or Solaris PowerPC Edition:
Installing Solaris Software.

11. Click on OK on the Add window.

If You Are Using ... And ... Then Enter the Path ...

The Solaris CD as the
Solaris CD image

The Solaris CD is
managed by Volume
Management

/cdrom/cdrom0  or
/cdrom/cdrom0/s0  or
/cdrom/cdrom0/s2

The Solaris CD is not
managed by Volume
Management

Where you mounted the
Solaris CD

A copy of the Solaris CD on
the Install Server’s hard
disk (by using
setup_install_server )

Where you specified
setup_install_server
to copy the Solaris CD
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12. Select Save Changes from the File menu to add support for the dataless
client.
The dataless client is displayed in the Host Manager main window.

Caution – For the dataless client to work properly, it needs root access to its
/export/root  directory. If Host Manager displays a message that the
/export  directory is already shared and has different share options than
required, you need to allow root access to the client root area before the
dataless client will function properly. The access mode for the client root is
normally rw= clientname, root= clientname.

If Host Manager displays a message that the /usr  directory is already shared,
it is because it tried to share /usr  read-only. If you have it shared with
read-write permissions, it is okay and you do not have to make any
modifications.

13. (Optional) Boot and install the dataless client.
For more information about booting and installing, see SPARC: Installing
Solaris Software, x86: Installing Solaris Software, or Solaris PowerPC Edition:
Installing Solaris Software.

!
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Example of a Completed Add Window for a Dataless Client
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Example of a Command-Line Equivalent for Adding Dataless Client

The following command is equivalent to using Host Manager to add support
for a dataless client.

In this command,

% admhostadd -i 129.152.225.2 -e 8:0:20:7:e0:26 -x type=DATALESS -x tz=US/Mountain
-x fileserv=pluto -x os=sparc.sun4c.Solaris_2.5 neptune

-i 129.152.225.2 Specifies the IP address for the dataless client.

-e 8:0:20:7:e0:26 Specifies the Ethernet address for the dataless
client.

-x type=DATALESS Specifies the type of the system.

-x tz=US/Mountain Specifies the system’s timezone.

-x fileserv=pluto Specifies the name of the OS server for the
dataless client.

-x os=
sparc.sun4c.Solaris_2.5

Specifies platform, kernel architecture, and
software release of the dataless client.

neptune Specifies the name of the system.
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Maintaining Server and Client Support

Table 6-9 Task Map: Maintaining Server and Client Support

Activity Description For Instructions, Go To

Modify Support for
a System

Modify support for a system by choosing Modify from
the Host Manager’s Edit menu.

▼ How to Modify
Support for a
System

page 111

Delete Support for a
System

Delete support for a system by choosing Delete from
the Host Manager’s Edit menu.

▼ How to Delete
Support for a
System

page 111
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▼ How to Modify Support for a System

1. Start Host Manager from the Solstice Launcher and select the name
service, if not done already.
See “How to Start Host Manager” on page 80 for more information.

2. Select a system entry to modify from the Host Manager main window.

3. Choose Modify from the Edit menu.
The Modify window contains the selected system entry.

4. Modify support for the system.
If you need information to change a field, click on the Help button to see
field definitions for this window.

5. Click on OK on the Modify window.

6. Select Save Changes from the File menu to modify support for the system.

Command-Line Equivalent for Modifying Support for a System

You can also use the admhostmod  command to modify support for a system.

▼ How to Delete Support for a System

1. Start Host Manager from the Solstice Launcher and select the name
service, if not done already.
See “How to Start Host Manager” on page 80 for more information.

2. Select a system entry to delete from the Host Manager main window.

3. Select Delete from the Edit menu.
A window is displayed asking you to confirm the deletion.

4. Click on OK.

5. Select Save Changes from the File menu to delete support for the system.
The system entry is deleted from the Host Manager main window.

Command-Line Equivalent for Deleting Support for a System

You can also use the admhostdel  command to delete support for a system.
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Using the Command-Line Interface to Automate Setup Tasks
Using the Host Manager command-line equivalents allows you to automate
many of the setup tasks associated with creating new diskless and AutoClient
systems. This automation is similar to what can be done when using the
JumpStart product to install Solaris on standalone systems. By writing your
own shell scripts and using the command-line equivalents, you can
automatically customize the client environment in one operation.

The example in the next section shows how to use the command-line interface
to set up an OS server, add OS services, and add a diskless client to that server.
The server’s name is rogue , and the diskless client is venus .

Note – For additional command-line examples, see the command-line
equivalent section at the end of most of the procedures in this chapter.

▼ How to Use the Command-Line Interface to Automate Setup Tasks

1. Convert a standalone system to an OS server.

2. Add OS services to the OS server.

a. This example adds the Solaris 2.5 End User Cluster OS services for the
Sun4m kernel architecture to rogue . The Solaris CD image is on a
mounted CD on a remote system named jupiter . Note that the remote
system must be minimally set up as a managed system.

% admhostmod -x type=os_server rogue

% admhostmod -x mediapath=jupiter:/cdrom/cdrom0/s0 \
-x platform=sparc.sun4m.Solaris_2.5 -x cluster=SUNWCuser \
rogue
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b. This examples adds the Solaris 2.5.1 All Cluster OS services for the
Sun4m kernel architecture to rogue . The Solaris CD image has been
copied to hard disk on a remote system, saturn , and the automounter
is used to access it. Note that the remote system must be minimally set
up as a managed system.

3. Add the diskless client.
This example adds a sun4m, Solaris 2.5.1 diskless client named venus  to the
server rogue .

You could use a similar version of this command in a shell script with
additional operations to customize the diskless client’s root as part of setting
up the client. The script could be parameterized to accept the IP address,
Ethernet address, and host name.

% admhostmod -x mediapath=rogue:/net/saturn/export/Solaris_CD \
-x platform=sparc.sun4m.Solaris_2.5.1 -x cluster=SUNWCall \
rogue

% admhostadd -i 129.152.225.2 -e 8:0:20:b:40:e9 \
-x type=diskless -x fileserv=rogue \
-x os=sparc.sun4m.Solaris_2.5.1 \
-x swapsize=40 -x  venus
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Managing Users With User
Manager and Group Manager 7

This chapter describes how to manage user accounts using two applications
within the Solstice AdminSuite software:

• Group Manager, a graphical user interface for managing group information

• User Manager, a graphical user interface used to manage user account
information

This is a list of the step-by-step instructions in this chapter.

How to Start Group Manager page 119

How to Add a Group page 121

How to Start User Manager page 122

How to Set Up User Account Defaults page 124

How to Add a New User Account page 125

How to Copy an Existing User Account page 128

How to Modify a Group page 130

How to Delete a Group page 131

How to Modify a User Account page 132

How to Delete a User Account page 135
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Command-Line Equivalents of Group Manager
Table 7-1 lists the commands that provide the same functionality as Group
Manager and can be used without running an X Window System. Many of the
Group Manager procedures in this chapter provide corresponding examples
using the command-line equivalents.

Files Modified by Group Manager
Table 7-2 lists the files Group Manager modifies depending on what name
service you selected.

Table 7-1 Command-Line Equivalents of Group Manager

Command Description

admgroupadd Adds a new group and members (if specified) to the group

admgroupmod Modifies an existing group

admgroupdel Deletes an existing group

admgroupls Lists the existing groups in the selected name service

Table 7-2 Files Modified by Group Manager

If the Name Service You Selected Is ... Then Group Manager Modifies The ...

NIS or NIS+ Name service’s group  database

None /etc/group  file
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Command-Line Equivalents of User Manager
Table 7-3 lists the commands that provide the same functionality as User
Manager and can be used without running OpenWindows or Motif CDE.
Many of the User Manager procedures in this chapter provide corresponding
examples using the command-line equivalents.

Files Modified by User Manager
Table 7-4 describes the system files that are modified by User Manager.

Table 7-3 Command-Line Equivalents of User Manager

Command Description

admuseradd Adds a new user account. Unlike the User Manager, you
cannot copy a user account with this command.

admusermod Modifies an existing user account.

admuserdel Deletes an existing user account.

admuserls Lists the existing user accounts in the selected name service.

Table 7-4 Files Modified by User Manager

System File Where Modified Description

auto_home /etc , NIS, or NIS+ An indirect automounter database containing entries that
enable client systems to mount their home directories
automatically

group /etc , NIS, or NIS+ A database containing UNIX group entries recognized on the
local system or in a name service

passwd /etc , NIS, or NIS+ A database containing user account entries such as user name,
user ID, group ID, and home directory

shadow /etc  (shadow  information
is stored in the passwd  file
when NIS or NIS+ is used)

A database containing user password entries in encrypted
form and password aging information

/var/mail/$USER Mail server A file used to store the user’s email

/etc/aliases Mail server A file used to store mail addresses for the user

cred.org_dir NIS+ A NIS+ table used to store the user’s DES and LOCAL
credentials
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Setting Up User Accounts

Table 7-5 Task Map: Setting Up User Accounts

Activity Description For Instructions, Go To

Add Groups Optional. To help administer users, add groups by choosing
Add from the Group Manager’s Edit menu. This is usually
a one-time task.

▼ How to Add a
Group

page 121

Set User Account
Defaults

Optional. Before you add several user accounts, set up
defaults for the User Manager by choosing Set Defaults
from the User Manager’s Edit menu. Setting up defaults
can increase the consistency and efficiency of adding user
accounts.

▼ How to Set Up
User Account
Defaults

page 124

Add a User
Account

Add a New User Account
Add a user account by choosing Add from the User
Manager’s Edit menu.

▼ How to Add a New
User Account

page 125

Copy an Existing User Account
Copy an existing user account by choosing Copy from the
User Manager’s Edit menu. This is useful if you need to add
a user account that is similar to an existing user account.

▼ How to Copy an
Existing User
Account

page 128
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▼ How to Start Group Manager

1. Verify that the prerequisites described in Chapter 1, “Introduction,” are
met.

2. Start the Solstice Launcher.

The Solstice Launcher is displayed.

3. Click on the Group Manager icon.

The Load window is displayed.

4. Select the name service used in your network.

5. Check that the domain or host name is correct.
If not, type the name of the domain or host you need to access.

6. Click on OK.
The Group Manager main window is displayed.

$ solstice &
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Example of the Group Manager Main Window
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▼ How to Add a Group

1. Start Group Manager from the Solstice Launcher and select the name
service, if not done already.
See “How to Start Group Manager” on page 119 for more information.

2. Choose Add from the Edit menu on the Group Manager main window.
The Add window is displayed. If you need information to complete a field,
click on the Help button to see field definitions for this window.

3. Type the name of the new group in the Group Name text box.

4. Type the group ID for the new group in the Group ID text box.
The group ID should be unique.

5. (Optional) Type user names in the Members List text box.
The list of users will be added to the group. User names must be separated
by commas.

6. Click on OK.
The list of groups displayed in the Group Manager main window is updated
to include the new group.

Example of a Completed Add Window

The following example adds a group named users  that has a group ID of 100.
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Example of a Command-Line Equivalent for Adding a Group

The following example is the equivalent of using Group Manager to add a
group named users  that has a group ID of 100.

▼ How to Start User Manager

1. Verify that the prerequisites described in Chapter 1, “Introduction,” are
met.

2. Start the Solstice Launcher.

The Solstice Launcher is displayed.

3. Click on the User Manager icon from the Solstice Launcher.

The Load window is displayed.

4. Select the name service used in your network.

5. Check that the domain or host name is correct.
If not, type the name of the domain or host you need to access.

6. Click on OK.
The User Manager main window is displayed.

# admgroupadd -g 100 users

$ solstice &
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Example of the User Manager Main Window
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▼ How to Set Up User Account Defaults

1. Start User Manager from the Solstice Launcher and select the name
service, if not done already.
See “How to Start User Manager” on page 122 for more information.

2. Choose Set Defaults from the Edit menu.
The Set Add Defaults window is displayed.

3. Fill in the Set Add Defaults window.
The defaults you select will be the initial defaults values in the Add
window. If you need information to complete a field, click on the Help
button to see field definitions for this window.

You can set the following defaults:
• Primary and Secondary Groups
• Login Shell
• Password Policy
• Creating a Home Directory
• Home Directory Server
• Skeleton Path (Path to User Initialization Files)
• Using AutoFS (AutoHome Setup)
• Permissions in Home Directory
• Mail Server

4. Click on OK.

Command-Line Equivalent for Setting Up User Account Defaults

You can use the admuseradd  command with the -D  option to set up user
account defaults from the command line.
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▼ How to Add a New User Account

1. Start User Manager from the Solstice Launcher and select the name
service, if not done already.
See “How to Start User Manager” on page 122.

2. Choose Add from the Edit menu.
The Add window is displayed.

3. Fill in the Add window.
If you need information to complete a field, click on the Help button to see
field definitions for this window.

4. Click on OK.
The list of user accounts displayed in the User Manager main window is
updated to include the new user account.
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Example of a Completed Add Window

The server where the home
directory is located.

The path (on the system run-
ning User Manager) from which
to copy user initialization files
into the user’s home directory.
You can also specify an auto-
mounted path to user initializa-
tion files on another system.
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Example of a Command-Line Equivalent for Adding a User

The following command is the equivalent to adding a user with User Manager.

In this command,

# admuseradd -u 101 -g users -c “Kryten Series 4000” -s /bin/csh -k /etc/skel -x pw=NORM \
-x pwwarn=1 -d /export/home/kryten -m -x autohome=Y -x serv=jupiter kryten

-u 101 Specifies the user ID, in this case 101.

-g users Specifies the user’s primary group, in this
case a group named users.

-c “Kryten Series 4000” Specifies a comment for the user account.

-s /bin/csh Specifies the default shell environment, in
this case the C shell.

-k /etc/skel Specifies a directory containing skeleton
information, such as .cshrc , that will be
copied into the user’s home directory.

-x pw=NORM Specifies the initial password type, in this
case normal.

-x pwwarn=1 Specifies the number of days that the user
will be warned about password expiration.

-d /export/home/kryten Specifies the name of the home directory.

-m Creates the new user’s home directory (as
specified with the -d  option) if it does not
already exist.

-x autohome=Y Specifies whether the home directory should
be set up to be automounted.
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▼ How to Copy an Existing User Account

1. Start User Manager from the Solstice Launcher and select the name
service, if not done already.
See “How to Start User Manager” on page 122.

2. Select a user account entry to copy from the main window.

3. Choose Copy from the Edit menu.
The Copy window is displayed with the following fields copied from the
selected user account:

• Primary Group
• Secondary Groups
• Comment
• Login Shell
• Path
• Server
• Skeleton Path

4. Fill in the fields in the Copy window.

If you need information to complete a field, click on the Help button to see
field definitions for this window.

5. Click on OK.
The list of user accounts displayed in the User Manager main window is
updated to include the new user account.

Note – There is no command line equivalent for copying an existing user
account.

-x serv=jupiter Specifies the name of the server where the
home directory will reside.

kryten Specifies the name of the system.
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Maintaining User Accounts

Table 7-6 Task Map: Maintaining User Accounts

Activity Description For Instructions, Go To

Modify a Group Modify a group’s name or the users in a group by
choosing Modify from the Group Manager’s Edit menu.

▼ How to Modify a
Group

page 130

Delete a Group Delete a group by choosing Delete from the Group
Manager’s Edit menu.

▼ How to Delete a
Group

page 131

Modify a User
Account

If a user account needs to be changed, modify the user
account by choosing Modify from the User Manager’s
Edit menu.

▼ How to Modify a
User Account

page 132

Delete a User
Account

Delete a user account by choosing Modify from the User
Manager’s Edit menu.

▼ How to Delete a
User Account

page 135
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▼ How to Modify a Group

1. Start Group Manager from the Solstice Launcher and select the name
service, if not done already.
See “How to Start Group Manager” on page 119 for more information.

2. Select the group entry to modify from the Group Manager main window.

3. Choose Modify from the Edit menu.
The Modify window is displayed containing the selected group entry.

4. Either modify the group’s name or the users in the group.
User names must be separated by commas. If you need information to
complete a field, click on the Help button to see field definitions for this
window.

5. Click on OK.
The group information displayed in the main window is updated.

Example of a Completed Modify Window
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Example of a Command-Line Equivalent for Modifying a Group

The following command is the equivalent to modifying the member list in a
group with Group Manager.

In this command,

▼ How to Delete a Group

1. Start Group Manager from the Solstice Launcher and select the name
service, if not done already.
See “How to Start Group Manager” on page 119 for more information.

2. Select the group entry you want to delete from the Group Manager main
window.

3. Choose Delete from the Edit menu.
A window is displayed asking you to confirm the deletion.

4. Click on OK.
The group entry is deleted from the Group Manager main window.

Command-Line Equivalent for Deleting a Group

You can also use the admgroupdel  command to delete a group.

# admgroupmod -g 10 -x members=r2d2,holly,kryten

-g 10 Specifies the number of group, in this case 10.

-x members=
r2d2,holly,kryten

Specifies the users who belong to group 10: r2d2 ,
holly , and kryten .
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▼ How to Modify a User Account

1. Start User Manager from the Solstice Launcher and select the name
service, if not done already.
See “How to Start User Manager” on page 122 for more information.

2. Select the user account entry to modify from the User Manager main
window.

3. Choose Modify from the Edit menu.
The Modify window is displayed containing the selected user account entry.

4. Modify the user account.
If you need information to complete a field, click on the Help button to see
field definitions for this window.

5. Click on OK.

Verification

Double-click on the modified user account entry in the User Manager main
window to verify that the modifications were made. Click on cancel to close
the window without making any modifications.
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Example of a Completed Modify Window

The following example sets the user rimmer  to be a member of the lp
secondary group.
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Example of a Command-Line Equivalent for Modifying a User
Account

The following command is the equivalent to modifying a user account with
User Manager. In this case, the command sets the user rimmer  to be a member
of the lp  secondary group.

# admusermod -G lp rimmer
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▼ How to Delete a User Account

1. Start User Manager from the Solstice Launcher and select the name
service, if not done already.
See “How to Start User Manager” on page 122 for more information.

2. Select the user account entry to remove from the main window.

3. Choose Delete from the Edit menu.
The Delete window is displayed to confirm the removal of the user account.

4. (Optional) Click on the check box to delete the user’s home directory and
its contents.

5. (Optional) Click on the check box to delete the user’s mailbox and its
contents.

6. Click on OK when you are ready to delete the user account.
The user account entry is deleted from the User Manager main window.

Example of the Delete Window
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Example of a Command-Line Equivalent for Deleting a User
Account

The following command is the equivalent of deleting a user account with User
Manager.

In this command,

# admuserdel -r -x serv=jupiter test1

-r Specifies that the contents of the user’s home
directory be removed.

-x serv=jupiter Specifies the name of the server where the home
directory resides.

test1 Specifies the name of the user account.
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Managing Terminals and Modems
With Serial Port Manager 8

This chapter describes how to set up and maintain modems and terminals by
using the Solstice Serial Port Manager and its corresponding command-line
equivalents. This is a list of the step-by-step instructions in this chapter.

Serial Port Manager configures the serial port software to work with terminals
and modems by calling the pmadm command and supplying the appropriate
information. It features:

• Displays of serial port information
• Templates for common terminal and modem configurations
• Multiple port setup, modification, or deletion

How to Start Serial Port Manager page 144

How to Configure Multiple Ports Using Serial Port Manager page 145

How to Add a Terminal page 146

How to Add a Modem page 147

How to Initialize a Port Without Configuring page 149

How to Disable a Port page 150

How to Delete a Port Service page 150
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Serial Port Manager Features
The Serial Port Manager enables you to configure or remove terminals and
modems used with your serial ports. This tool also enables you to configure
multiple ports at the same time.

The Seral Port Manager consists primarily of two windows: the Serial Port
Manager main window and the Serial Port Manager: Modify window.

The Serial Port Manager main window displays the serial ports for the system
that you are currently logged managing.

In this window, three pull-down menus enable you to:

• Select the port that you wish to modify
• Delete modems and terminals
• View serial ports for different hosts
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The three pull-down menus consist of the following:

The option that is most commonly used is the Modify option in the Edit pull-
down menu. This option opens the Serial Port Manager: Modify window.

In this window, you have many options to choose from, including templates
for commonly used terminal and modem configurations. The templates can be
viewed by selecting the Template button, which enables you to choose one of
the following template options:

• Terminal - Hardwired
• Modem - Dial in Only
• Modem - Dial out Only
• Modem - Bidirectional
• Initialize Only - No Connection

Pull-down Menu Options Description

File Exit Closes the Serial Port Manager tool

Edit Modify Opens the Serial Port Manager: Modify window

Delete Removes the port monitor and service tag
configuration for the selected port

View Host Brings up the Serial Port Manager: Host
window, which enables you to select from a list
of available hosts
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You can select the desired option level using one of the Detail buttons
described in Table 8-1. Each button displays a different level of options, as
shown in the previous screen display. (Each level is separated by a thin line.)

Basic Detail

More Detail

Expert Detail
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Table 8-1 Serial Port Manager Detail Options

Detail Option Description

Basic Service Enable Button that allows you to enable (button
selected) or disable (button de-selected) the
associated port.

Baud Rate Button that allows you to select the baud rate
of your terminal or modem. You can either
choose one of the listed baud rates or enter a
different baud rate using the other option.

Terminal Type Text entry field that allows you to specify the
type of terminal that will be connected to the
serial port.

More Initialize Only Button that specifies that the port software is
initialized, but not configured.

Bidirectional Button that specifies that the port line is used
in both directions.

Software Carrier Button that specifies that the software carrier
detection feature is used. If this option is not
checked, the hardware carrier detection signal
is used.

Login Prompt Text entry field that allows you to change the
login prompt.

Comment Text entry field that allows you to type any
comments to clarify the type of port the serial
port is configured to be; by default, the
Comment field will display the name of the
serial port template that you have selected.

Service Tag tty tag entry that corresponds to the selected
port.

Port Monitor Tag Button that allows you to select the type of
monitor associated with this port; you can
either choose from the list or choose the Other
option and then enter the monitor type.

Expert Create utmp Entry Button that when selected, specifies that a
utmp entry is created upon login. This item
must be checked if a login service is used.
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Command-Line Equivalents of Serial Port Manager
Table 8-2 lists the commands that provide the same functionality as Serial Port
Manager and can be used without running OpenWindows or Motif CDE.
Many of the Serial Port Manager procedures in this chapter provide
corresponding examples using the command-line equivalents.

Expert
(continued)

Connect on Carrier Button that when selected, specifies that a
port’s associate service is invoked immediately
when a connect indication is received.

Service Text entry field that specifies the program that
is run upon connection.

Streams Modules Text entry field that shows the Streams
modules that are pushed before the service is
started.

Timeout (secs) Button that allows you to chose the amount of
seconds before the connection times out.

Table 8-2 Command-Line Equivalents of Serial Port Manager

Command Description

admserialmod Modifies a serial port service for a terminal or modem

admserialdel Deletes an existing serial port service for a terminal or modem

admserialls Lists the existing services for the specified serial ports

Table 8-1 Serial Port Manager Detail Options (Continued)

Detail Option Description
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Files Modified by Serial Port Manager
Table 8-3 describes the files that are modified by Serial Port Manager on the
system where you are modifying the serial port services.

Table 8-3 Files Modified by Serial Port Manager

System File Description

/etc/saf/_sactab The Service Access Facility’s administrative file that
contains configuration data for the port monitors it
controls

/etc/saf/ pmtag/_pmtab The port monitor’s administrative file that contains
port monitor-specific configuration data for the
services it provides

/var/saf/pmtag/log The port monitor’s log file logging service states:
successful initialization, failure, enabled, or disabled
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Using Serial Port Manager
By using serial port manager, you can accomplish a number of tasks. The
following procedures describe each of these tasks.

▼ How to Start Serial Port Manager

1. Verify that the prerequisite steps described in Chapter 1, “Introduction”
are met.

2. Type solstice &  from a Command or Shell Tool prompt and press
Return.

3. Click the Serial Port Manager icon.
The Serial Port Manager main window is displayed.

4. (Optional) Choose Host from the View menu.

a. Select the host you wish to access using Serial Port Manager.
You can also type in the name of the host in the selection field.

b. Click on OK to access the host using Serial Port Manager.
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▼ How to Configure Multiple Ports Using Serial Port Manager

1. Start Serial Port Manager from the Solstice Launcher, if not done already.
See the procedure on page 144 for information about starting Serial Port
Manager.

2. Select the ports that you would like to modify.
You can select more than one port by single-clicking on each port listed in
the Serial Port Manager main window.

3. Select the Modify option from the Edit pull-down menu.
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▼ How to Add a Terminal

1. Start Serial Port Manager from the Solstice Launcher, if not done already.
See the procedure on page 144 for information about starting Serial Port
Manager.

2. Select the port or ports that will be used with a terminal in the Serial Port
Manager main window.

3. Choose Modify from the Edit menu.
The Modify window is displayed in the Basic Detail mode. (For additional
details, click on More or Expert.)

4. Choose Terminal – Hardwired from the Template menu.

5. Change values of template entries if desired.

6. Click on OK to configure the port.

Example of a Command-Line Equivalent for Adding a Terminal

The following example is the equivalent of using Serial Port Manager to enable
a terminal connection to port /dev/term/a .

In this command,

# admserialmod -e -p hw a

-e Enables the port.

-p hw Specifies that the hardwired template be used to
configure the port.

a Specifies the name of the port, in this case port a.
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▼ How to Add a Modem

1. Start Serial Port Manager from the Solstice Launcher, if not done already.
See the procedure on page 144 for information about starting Serial Port
Manager.

2. Select the port or ports that will be used with a modem from the Serial
Port Manager main window.

3. Choose Modify from the Edit menu.
The Modify window appears in the Basic Detail mode. (For additional
details, select either the More or Expert Detail modes.)

4. Choose the modem configuration from the Template menu that meets or
most closely matches your modem service.
The modem template choices are described here.

See the Reference on-line help for the default values of each template. If a
UUCP service will be used to dial in to your modem on a Solaris 2.x system,
see “How to Configure a Modem for Use With UUCP” on page 148 for the
rest of the procedure.

5. Change values of template entries if desired.

6. Click on OK to configure the port.

Example of a Command-Line Equivalent for Adding a Modem

The following example is the equivalent of using Serial Port Manager to enable
a modem to port /dev/term/b .

Modem Configuration Description

Modem – Dial In Only Users may dial in to the modem but cannot dial out.

Modem – Dial Out Only Users may dial out from the modem but cannot dial in.

Modem – Bidirectional Users may either dial in or out from the modem.

# admserialmod -e -p bi -b 38400 b
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In this command,

▼ How to Configure a Modem for Use With UUCP

UUCP sends information using seven bits and even parity. Solaris software
modem configurations use eight bits and no parity for internationalization
purposes. To set up your modem service to work with UUCP, follow these
instructions.

1. Start Serial Port Manager from the Solstice Launcher, if not done already.
See the procedure on page 144 for information about starting Serial Port
Manager.

2. From the Serial Port Manager main window, select the port or ports that
will be used with a modem.

3. Choose Modify Service from the Edit menu.
The Modify Service window appears in the Basic Detail mode. (For
additional details, select either the More or Expert Detail modes.)

4. Choose the modem configuration from the Template menu that meets or
most closely matches your modem service.

5. Select Other from the Baud Rate menu.

6. Enter a baud rate value from the /etc/ttydefs  file that provides seven
bit, even parity service and click on OK.

In this example, the 9600E baud rate was selected. This provides a service
with a 9600 baud rate, seven bits, and even parity.

7. Change values of other template entries if desired.

8. Click on OK to configure the port.

-e Enables the port.

-p bi Specifies the bidirectional template be used to
configure the port.

-b 38400 Specifies the baud rate.

b Specifies the name of the port.
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Example of a Command-Line Equivalent for Adding a Modem

The following example is the equivalent of using Serial Port Manager to enable
a modem (for use with UUCP) to port /dev/term/b .

In this command,

▼ How to Initialize a Port Without Configuring

1. Start Serial Port Manager from the Solstice Launcher, if not done already.
See the procedure on page 144 for information about starting Serial Port
Manager.

2. Choose Modify from the Edit menu.
The Modify window appears in the Basic Detail mode. See the Reference
on-line help for default values of the Basic, More, or Export Detail modes.

3. Choose Initialize Only – No Connection from the Template menu.

4. Click on OK to initialize the port.

Example of a Command-Line Equivalent for Initializing a Modem

The following example is the equivalent of using Serial Port Manager to
initialize port /dev/term/b .

# admserialmod -e -p bi -b 9600E b

-e Enables the port.

-p bi Specifies the bidirectional template be used to
configure the port.

-b 9600E Specifies the baud rate.

b Specifies the name of the port.

# admserialmod -e -p init b
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In this command,

▼ How to Disable a Port

1. Start Serial Port Manager from the Solstice Launcher, if not done already.
See “How to Start Serial Port Manager” on page 144 for information about
starting Serial Port Manager.

2. Select the port or ports that you want to disable from the Serial Port
Manager main window.

3. Choose Modify from the Edit menu.

4. Select the Service Enable item in the Modify window to disable the port.
The other items in the Modify window will turn gray when the port service
is disabled.

5. Click on OK to disable the port.

Example of a Command-Line Equivalent for Disabling a Port

The following example is the equivalent of using Serial Port Manager to
disable port /dev/term/b .

▼ How to Delete a Port Service

1. Start Serial Port Manager from the Solstice Launcher, if not done already.
See the procedure on page 144 for information about starting Serial Port
Manager.

2. Select the port or ports with a service you want to delete from the Serial
Port Manager main window.

-e Enables the port.

-p init Specifies the port should only be initialized.

b Specifies the name of the port.

# admserialmod -d b



Managing Terminals and Modems With Serial Port Manager 151

8

3. Choose Delete from the Edit menu. A window is displayed asking you to
confirm that the service should be deleted.

4. Click on OK when you are ready to delete the service.

Example of a Command-Line Equivalent for Deleting a Port Service

The following example is the equivalent of using Serial Port Manager to
disable port /dev/term/b .

# admserialdel b
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Setting Up SunSoft Print Client
Software With Printer Manager 9

This chapter provides the procedures for setting up and managing the SunSoft
print client software by using the Printer Manager application, a graphical user
interface within the Solstice AdminSuite software.

This is a list of the step-by-step instructions in this chapter.

Note – The Printer Manager tasks are only part of what you need to know to
effectively set up and manage the SunSoft print client software. The Solstice
AdminSuite 2.2 Print Administration Guide provides an overview that helps you
understand the SunSoft print process. It also contains task information about
converting the configuration information for existing printers and copying the
information to SunSoft print clients.

How to Start Printer Manager page 156

How to Install a Printer page 158

How to Add Access to a Printer page 161

How to Modify Printer Information page 164

How to Delete Access to a Printer page 167

How to Delete a Printer From a Print Server (If No Name Service) page 168
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For step-by-step instructions on administering printing, see the System
Administration Guide, Volume II.

You can set up printing by using LP print service commands instead of Printer
Manager. For detailed examples, see the System Administration Guide, Volume II.

Files Modified by Printer Manager
Table 9-1 describes the SunSoft and Solaris system files that are modified by
Printer Manager.

Table 9-1 Files Modified by Printer Manager

System File Description

/etc/printers.conf A file containing printer configuration information
for SunSoft print client operation

printers.conf.byname An NIS map that contains printer configuration
information for SunSoft print client operation

fns.ctx_dir An NIS+ map that contains printer configuration
information for SunSoft print client operation and
other information

/etc/lp/printers/ printer/* A Solaris file containing LP printer configuration
information

/etc/lp/interfaces/ printer A Solaris shell script used to communicate with a
local printer

/etc/lp/default A Solaris file containing the name of the LP system
default printer

/etc/lp/filter.table A Solaris lookup table containing the configured
LP filters

/etc/lp/Systems A Solaris file containing a list of remote systems
for Solaris LP

/etc/saf/sactab A Solaris file containing service access facility
configuration

/etc/saf/tcp_pmtab A Solaris file containing port monitor
configuration
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Setting Up and Managing SunSoft Print Client Software
Table 9-2 gives you an overview of the tasks for using Printer Manager to set
up and manage printing services with the SunSoft print client software.

Table 9-2 Task Map: Setting Up and Managing SunSoft Print Client Software

Activity Description For Instructions, Go To

Install a Printer on
a Print Server

Install a Printer
Install a printer on the system to which it is attached. This
procedure tells the system about the printer so the system
can act as a print server. If you use a name service, this
task also makes the printer available to all SunSoft print
clients.

▼ How to Install a
Printer

page 158

Give Print Clients
Access to a Printer

Add Access to a Printer
Give SunSoft print clients access to a printer that is
installed on a print server.

▼ How to Add Access
to a Printer

page 161

Modify Existing
Information for a

Printer

Modify Printer Information
Modify the current configuration information for a printer.

▼ How to Modify
Printer Information

page 164

Delete Access to a
Printer

Delete Access to a Printer
Delete access to a printer from the NIS or NIS+ master file
or from each specified print client’s
/etc/printers.conf  file if you do not use a name
service.

▼ How to Delete
Access to a Printer

page 167

Delete a Printer From a Print Server
Delete a printer from the print server’s
/etc/printers.conf  file. This step applies only if you
are not using a name service.

▼ How to Delete a
Printer From a Print
Server (If No Name
Service)

page 168
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Starting Printer Manager
You can use Printer Manager to complete all the tasks necessary to set up and
maintain the SunSoft print client software, so the first thing to do is start the
Printer Manager application with Solstice AdminSuite.

▼ How to Start Printer Manager

1. Verify that the following prerequisites are met. To use the Solstice
AdminSuite software, you must have:
• A bit-mapped display monitor. The Solstice AdminSuite software can be

used only on a system with a console that is a bit-mapped screen such as
a standard display monitor that comes with a Sun workstation.
If you want to perform administration tasks on a system with an ASCII
terminal as the console, use Solaris commands instead.

• OpenWindows software. Start this software with the following command:

• Membership in the sysadmin group (group 14).
• The required access privileges for managing the NIS or NIS+ database. If

your name service is NIS+, you must be a member of the NIS+ admin
group.

• Federated Naming Service (FNS) software.
• If your name service is NIS+, you must initialize the NIS+ namespace to

use FNS by entering the following command:

This command creates the organization context and default subcontexts for
an existing NIS+ domain. It also creates NIS+ tables and directories in the
NIS+ hierarchy.

2. Log in as yourself.
You should use the Solstice AdminSuite software as a regular user who has
membership in the sysadmin group rather than as root.

$ /usr/openwin/bin/openwin

$ fncreate -t org org//
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3. Start the Solstice Launcher.

The Solstice Launcher window is displayed.

4. Click on the Printer Manager icon to start the application.

The Load window is displayed as an overlay on the Printer Manager main
window.

5. Select the name service used in your network.
Choices are: NIS+, NIS, or None.

6. Check that the domain or host name is correct.
If not, type the name of the domain or host name you need to access.

7. Click on OK.
The Printer Manager main window is displayed by itself after you click on
OK.

Installing a Printer
When you use Printer Manager to install a printer on a system, you define the
characteristics of the printer and identify the users who are permitted to access
it. The system on which you install the printer becomes the print server.

$ solstice &
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Installing a printer means something different depending on whether you use
a name service.

▼ How to Install a Printer

1. Connect the printer to a system and turn on the power to the printer.
Consult the printer vendor’s installation documentation for information
about the hardware switches and cabling requirements.

2. Start Printer Manager.
When you log in:

• If your name service is NIS or NIS+, you can log in on any system on the
network because you’ll be able to specify the system on which you are
installing the printer.

• If you are not using a name service, you can log in on any system on the
network and change the host name in the Load window to the name of the
system to which you attached the printer.

For detailed information about starting Printer Manager, see the procedure
on page 156.

3. Select Install Printer from the Edit menu.
The Install Printer window is displayed.

4. Fill in the window.
If you need information to complete a field, click on the Help button to see
field definitions for this window.

5. Click on OK.
If you are using NIS or NIS+, the printer is entered in the name service
master file and all SunSoft print clients have access to it. The printer is also
entered in the print server’s /etc/printers.conf  file and /etc/lp
directory.

If You... Then Printer Manager...

Use a name service Adds the printer in the NIS or NIS+ master file, and
the printer is available to all SunSoft print clients

Don’t use a name service Adds the printer in the print server’s configuration
files only, and print clients do not know about the
printer
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If you are not using a name service, the printer is entered in the print
server’s /etc/printers.conf  file and /etc/lp  directory.

Verification

Verify that the printer has been installed by checking for the new printer entry
in the Printer Manager main window.
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Example of a Completed Install Printer Window

This example shows the Install Printer window when Printer Manager was
loaded with a name service. If you use a name service, you can specify any
system on the network as the print server in this window.

If you are not using a name service, the Print Server field displays the host
name you specified in the Load window, and you cannot change the name of
the print server in this window.
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Adding Access to a Printer
When you give a system access to a printer that is attached to a print server,
that system becomes a print client. You may not need to add access for SunSoft
print clients depending on whether you installed the printer through Printer
Manager and whether you use a name service.

▼ How to Add Access to a Printer

1. Start Printer Manager.
You can add access to a printer from any system on the network.

• If you use a name service, you don’t need to specify print clients. You add
access to the printer for all SunSoft print clients on the network.

• If you don’t use a name service, you will be able to specify the print
clients to be given printer access.

For detailed information about starting Printer Manager, see the procedure
on page 156.

If You Installed the Printer
Through... Then...

Printer Manager and you have
a name service

The printer is already available to all SunSoft print
clients. You don’t need to add access to the printer.

Printer Manager and you
don’t have a name service

You need to add access to the printer for SunSoft
print clients.

UNIX commands and you
have a name service

Unless you converted information for this printer
from a SunOS 5.x or 4.x system and loaded NIS or
NIS+, the printer is not listed in the name service.
You need to add access to the printer so it will be
entered in the name service and made available to
all SunSoft print clients.

UNIX commands and you
don’t have a name service

Unless you converted information for this printer
from a SunOS 5.x or 4.x system and copied the
master /etc/printers.conf  file to print clients,
you need to add access for SunSoft print clients. (If a
print client had access previously, that access has
been erased.)
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2. Select Add Access to Printer from the Edit menu.
The Add Access to Printer window is displayed.

3. Fill in the window.
If you need information to complete a field, click on the Help button to see
field definitions for this window.

4. Click on OK.
If your name service is NIS or NIS+, the printer is entered in the name
service master file and all SunSoft print clients have access to it.

If your name service is None, the printer is entered in the
/etc/printers.conf  file of each print client you specified.

Verification

Verify that the access has been added by submitting a print request from the
print client and checking the printer for output.
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Example of a Completed Add Access to Printer Window

In this example, the network does not use a name service, so the window
contains the Print Clients field. This field enables you to specify the print
clients to be given access to the specified printer. If the name service is NIS or
NIS+, the window does not contain the Print Clients field.
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Modifying Printer Information
After you’ve installed a printer through Printer Manager, you can modify some
of the information originally entered. You can also set two additional options
that control the printer’s ability to accept and process print requests.

The Modify window of Printer Manager has two versions. On the short
version, you can change only the printer description and whether the printer is
set up as the default printer. You’ll see the short window if:

• You don’t use a name service and the printer is not local to the print server.

• You are not a member of the sysadmin group (group 14), regardless of your
name service selection.

• The print server does not have the Solstice AdminSuite software.

Otherwise, you’ll get the long version of the window, where you can change
more information and set the options for accepting and processing print
requests.

Note – You can’t change certain printer information even on the long version
of the window. If you need to change the printer name, print server, or printer
type, you’ll have to delete the printer and reinstall it. For these procedures, see
“Deleting Access to a Printer” on page 167 and “Installing a Printer” on
page 157.

▼ How to Modify Printer Information

1. Start Printer Manager.
You can log in on any system on the network. For detailed information
about starting Printer Manager, see the procedure on page 156.

2. Select the printer that you want to modify from the scrolling list in the
Printer Manager main window.

3. Select Modify from the Edit menu or double-click on the printer in the
scrolling list.
The short version or the long version of the Modify window is displayed.
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4. Fill in the window.
If you need information to complete a field, click on the Help button to see
field definitions for this window.

5. Click on OK.

Verification

Verify that the printer information has been changed by reloading Printer
Manager and checking for your changes, as follows:

1. Select Load from the File menu.
The Load window is displayed.

2. Leave the settings as they are, and click on OK.
The Printer Manager main window is displayed.

3. Select the printer you just modified from the scrolling list in the Printer
Manager main window.

4. Select Modify from the Edit menu.
The Modify window is displayed.

5. Check to see if your changes to the printer information are displayed.
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Example of a Completed Modify Window

This example shows the long version of the Modify window. The short version
contains only four fields—it displays the printer name and print server, and
enables you to change the printer description and default printer selection.
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Deleting Access to a Printer
The only way to change the name, print server, or printer type originally
assigned to a printer is to delete the printer and reinstall it using new
information.

If you need to move, replace, or reinstall a printer with new information, you
should first make sure that all the print requests in the printer’s queue are
printed or moved to another printer. You must also delete print clients’ access
to the printer and delete the printer from the print server before you physically
detach the printer from the print server.

If your name service is NIS or NIS+, you delete access to a printer and delete
the printer from the print server at the same time.

If you are not using a name service, you must first delete access to a printer for
each print client and then delete the printer from the print server as a separate
task.

▼ How to Delete Access to a Printer

1. Start Printer Manager.
You can log in on any system on the network to delete access to a printer.

• If your name service is NIS or NIS+, you won’t need to specify print
clients. You delete access to the printer for all SunSoft print clients on the
network and delete the printer from the print server at the same time.

• If you are not using a name service, you can log in on any system on the
network and change the host name to the name of the print client for
which you want to delete printer access.

For detailed information about starting Printer Manager, see the procedure
on page 156.

2. Select the printer for which you want to delete access from the scrolling
list in the Printer Manager main window.

3. Select Delete from the Edit menu.
The Warning window is displayed. It contains a prompt asking you to verify
that you really want to delete the printer.
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4. Click on OK.
If your name service is NIS or NIS+, the printer is deleted from the name
service master file and access is removed for all print clients. The printer is
also deleted from the print server’s /etc/printers.conf  file and
/etc/lp  directory.

If you are not using a name service, the printer is deleted only from this
print client’s /etc/printers.conf  file. You must repeat steps 1 through 4
to delete access to the printer for other SunSoft print clients.

Verification

If your name service is NIS or NIS+, verify that the printer has been deleted
from the name service by making sure that the printer is not listed in the
Printer Manager main window.

If you are not using a name service, verify that the print client’s access has
been deleted by making sure that the printer is not listed in the Printer
Manager main window.

▼ How to Delete a Printer From a Print Server (If No Name Service)

1. Start Printer Manager.
You can log in on any system on the network to delete a printer from a print
server. Select None as the name service and change the host name to the
name of the print server.

For detailed information about starting Printer Manager, see the procedure
on page 156.

2. Select the printer to be deleted from the scrolling list in the Printer
Manager main window.

3. Select Delete from the Edit menu.
The Warning window is displayed. It contains a prompt asking you to verify
that you really want to delete the printer.



Setting Up SunSoft Print Client Software With Printer Manager 169

9

4. Click on OK.

The printer is deleted from the print server’s /etc/printers.conf  file
and /etc/lp  directory.

Verification

Verify that the printer has been deleted from the print server by making sure
that the printer is not listed in the Printer Manager main window.

Where to Go From Here
After you have set up the systems at your site to use the SunSoft print client
software, users may also want to set up their ~/.printers  home directory to
contain custom printer aliases.

For step-by-step instructions on these tasks, see the Solstice AdminSuite 2.2 Print
Administration Guide in the Solstice AdminSuite 2.2 AnswerBook.



170 Solstice AdminSuite 2.2 Administration Guide—May 1996

9



171

Managing Network Service Files
With Database Manager 10

This chapter describes how to manage network services by using Database
Manager, a graphical user interface within the Solstice AdminSuite software
used to manage network-related system files.

This is a list of the step-by-step instructions in this chapter.

How to Start Database Manager page 174

How to Add a System File Entry page 176

How to Modify a System File Entry page 177

How to Delete a System File Entry page 178
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Overview of Database Manager
Database Manager is primarily used to manage the network-related system
files since other tools are used to manage user, client system, serial ports, and
printer-related files. With Database Manager, you can edit system files in a
system’s /etc  directory, NIS name service, or the NIS+ name service.

Using Database Manager to add an entry to a system file usually managed by
another tool can save time. For example, Host Manager requires you to enter
the Ethernet address when adding a standalone system even though you may
want to use this system for remote copy and login only. However, the Ethernet
address is not required when you use Database Manager to update the hosts
file.

Caution – It is important that you do not bypass critical information when
providing services to users and client systems. Use caution when using
Database Manager to update system files normally managed by other tools.

Files Modified by Database Manager
The network-related system files that can be modified with Database Manager
are described in Table 10-1.

Table 10-1 Files Modified by Database Manager

System File Description

aliases Aliases in ASCII format for the local host. Or, if it is a NIS+
or NIS file, aliases available for use across the network.

auto.home  (NIS) or
auto_home  (NIS+)

Entries for client systems to mount their home directories
automatically; an indirect automounter map.

bootparams Entries client systems need to boot from the network.

ethers Ethernet addresses of network client systems.

hosts Entries for systems on the network and their associated IP
addresses.

locale The default locales used by network clients.

netgroup Entries for netgroups, a group of systems granted identical
access to network resources for security and organizational
reasons.

!
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netmasks Network mask values used to implement IP subnetting.

networks Information about available networks.

protocols Information about Internet protocols used in your network.

rpc Entries for available RPC services (by name) and their
associated program numbers and aliases.

services Information about network services and their “well-known”
port numbers.

timezone Entries for systems and their geographic region and time
zone used at installation.

Table 10-1 Files Modified by Database Manager (Continued)

System File Description
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Managing Network Services Files
The following section describes how to use Database Manager to manage
network services files.

▼ How to Start Database Manager

1. Verify that the steps described in Chapter 1, “Introduction,” are met.

2. Type solstice &  from a Command or Shell tool prompt and press
Return.
The Solstice Launcher is displayed.

3. Click the Database Manager icon.
The Load Database window is displayed.

4. Select the name service used in your network.

5. Check that the domain or host name is correct.
If not, type the domain or host name you need to access.

6. Select the file you want to display.
Select the aliases  file, for example.

7. Click on OK.
The Database Manager main window is displayed with the file contents
displayed.
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Example of the Database Manager Main Window

This example shows that the aliases  file has been selected and displayed.
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▼ How to Add a System File Entry

1. Start Database Manager from the Solstice Launcher, select the name
service, and the system file to be displayed, if not done already.
See the procedure on page 174 for information about starting Database
Manager.

2. Select Add from the Edit menu in the Database Manager main window.
The Add window is displayed.

3. Fill out the Add window.
If you need information to complete a field, click on the Help button to see
field definitions for the system file.

4. Click on OK.

Verification

Verify that the entry has been added by locating the new entry in the Database
Manager’s main window.

Example of Adding a System File Entry Using Database Manager

The following is an example a completed Add window where a mail alias has
been added to the aliases  file.
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▼ How to Modify a System File Entry

Caution – Notify users before you modify their work environment.

1. Start Database Manager from the Solstice Launcher and select the name
service, if not done already.
See the procedure on page 174 for information about starting Database
Manager.

2. Select a system file to modify in the Database Manager main window.

3. Select Modify from the Edit menu.
The Modify window is displayed.

4. Fill out the Modify window.
If you need information to modify a field, click on the Help button to see
field definitions for the system file.

5. Click on OK when finished.

Verification

Verify that the entry has been modified by locating the entry in the Database
Manager’s main window.

Example of Modifying a System File Entry Using Database
Manager

The following is an example of the Modify window and a selected system file
entry.

!
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▼ How to Delete a System File Entry

1. Start Database Manager from the Solstice Launcher and select the name
service, if not done already.
See the procedure on page 174 for information about starting Database
Manager.

2. Select an alias entry to delete in the Database Manager main window.

3. Select Delete from the Edit menu.
A window is displayed asking you to confirm the deletion.

4. Click on OK if you really want to delete the system file entry.

Verification

Verify that the system file has been updated in the Database Manager’s main
window.

Example of Deleting a System File Entry Using Database Manager

The following is an example of a Database Manager Delete verification
window.
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Managing Disks and File Systems
With Storage Manager 11

The Storage Manager application contains two tools, Disk Manager and File
System Manager, that enable you to manage disk configurations and file
systems on servers that are on your network.

This is a list of the step-by-step instructions in this chapter.

How to Load an Initial Context page 183

How to Load a Different Context page 183

How to Create a UFS File System page 191

How to Create a Mount Point page 193

How to Modify the Properties of a Mount Point or Directory page 195

How to Mount or Unmount a File System page 197

How to Share or Unshare a Directory page 199

How to View Static Client File Systems page 201

How to View Active Server File Systems page 203

How to View Static Server File Systems page 205

How to Remove a Mount Point From the /etc/vfstab File page 207

How to Specify a Viewing Filter page 215

How to Specify a Volume Label page 217

How to Modify fdisk Partitions page 219

How to Modify Slice Geometry page 221

How to Clone a Disk page 223
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Storage Manager’s Load Context Property Book
Storage Manager introduces the concept of a property book to the Solstice
AdminSuite product. A property book is the mechanism by which you identify,
view, and modify the properties of editable objects, such as disks or file
systems. A property book, using a book metaphor, contains a list of chapters
that represent properties for the object. You can expand each chapter to view or
modify the properties.

The purpose of the Load Context Property Book is for you to set the context in
which Storage Manager will operate. Generally, a context is the way to manage
the properties of an object. In the case of File System Manager, the context
includes which host to manage, what name service to modify or how to view
and modify the file systems on a server. In the case of Disk Manager, the
context includes what diskset (a logical grouping of disks) to modify if you
have the Solstice DiskSuite™ 4.0 software installed on the system. For more
information on Solstice DiskSuite, see Solstice DiskSuite 4.0 Administration Guide
and Solstice DiskSuite Tool 4.0 Users Guide.

The Load Context Property Book is displayed when you start Storage Manager
from the Solstice Launcher. You can also display this window by choosing
Load from the File menu in either Disk Manager or File System Manager, or by
clicking on the Load Context icon in either tool bar. Figure 11-1 shows the
Storage Manager’s Load Context Property Book.
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Figure 11-1 Storage Manager’s Load Context Property Book

Here are some brief descriptions of the areas within Storage Manager’s Load
Context Property Book:

• Current Context – Is a read-only field that displays the host name of the
current context. Storage Manager initially has no context set.

• Context Type – Is a read-only field that indicates the name of the tool with
which the current context is associated. In Figure 11-1, the tool is Storage
Manager.

Chapter PropertiesChapters
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• Property Browser – Is like a table of contents in a book. It lists all the
chapters and subchapters (if any) in the book, which represents properties of
an object. The Property Browser enables you to navigate quickly to the
desired chapter and to expand or collapse its contents as desired.

Clicking on a chapter in the Property Browser causes the corresponding
chapter in the Property Viewer to become visible, if it is not already visible.
Double-clicking on a chapter in the Property Browser first makes the
chapter visible in the Property Viewer, and then expands or collapses the
chapter in the Property Viewer.

• Chapters – Contains a common set of properties for the object that you can
view or modify.

• The + and - Buttons – The buttons that appear below the Property Browser
perform an expand all (+) or collapse all (-) function on the chapters in the
Property Viewer. This is a quick way of viewing all chapter properties or
only the chapter names.

The buttons that appear next to chapter names in property books also
perform an expand all or collapse all function, but only on the selected
chapter.

• Property Viewer – Displays the properties you can set when changing your
current context. By default, the chapters in this Property Viewer appear
expanded, so that you can easily specify the context on which you want to
operate. At a minimum, you must probe a server in the Host chapter in
order to specify a context. For more information, see “How to Load a
Different Context” on page 183.

• Chapter Properties – Enables you to set the context you want to display and
modify.

For more reference information on the chapters that are available from the
Load Context Property Book (Host, Name Service, File System, Disk Set), refer
to online help.
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▼ How to Load an Initial Context

This procedure assumes that the Load Context window is displayed as a result
of clicking on the Storage Manager icon in the Solstice Launcher.

1. If you want to view or modify the context of the system where you started
the Solstice Launcher and Storage Manager, make needed changes to the
Name Service, File System, and Disk Set chapters, if any. Skip to Step 5.

2. If you want to view or modify the context of a system other than the one
where you started the Solstice Launcher and Storage Manager, delete the
existing name in the Host Name field and type the name of the host
whose context you want to view or modify.

3. Click on Probe Host.
A System Discovery window is displayed, indicating that information is
being updated from the specified host.

4. If desired, make changes to the Name Service, File System, and Disk Set
chapters.

5. Click on OK.
A System Discovery window is displayed, indicating that Storage Manager
is validating context parameters as well as discovering devices, directories,
and mount points on the specified host.

▼ How to Load a Different Context

This procedure assumes that Storage Manager has an active current context
(that is, the File System Manager main window or Disk Manager main window
is open).

1. Choose Load from the File menu, or click on the Load Context icon in the
tool bar.
The Load Context window is displayed, with the current context’s host
name displayed in the Host chapter.

2. Delete the existing name in the Host Name field and type the name of the
host whose context you want to view or modify.

3. Click on Probe Host.
A System Discovery window is displayed, indicating that information is
being updated from the specified host.



184 Solstice AdminSuite 2.2 Administration Guide—February 1996

11

4. If desired, make changes to the Name Service, File System, and Disk Set
chapters.

5. Click on OK.
A System Discovery window is displayed, indicating that Storage Manager
is validating context parameters as well as discovering devices, directories,
and mount points on the specified host.

Example of Loading a Different Context
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File System Manager Overview
File System Manager is a tool that enables you to create and modify file
systems, mount points, and directories using two types of windows, the main
window and a Property Book. The main window displays a hierarchical view
of directories and file systems, as well as the mount points and shared
resources for the current context. The Property Book displays the chapters and
their properties for a selected directory or file system that you can view or
modify.

Specifically, File System Manager is a tool that enables you to complete the
following tasks:

• Create new file systems

• Modify file system options in the /etc/vfstab  file

• Manage /etc/vfstab  files on a single or group of diskless clients or
AutoClient systems.

• Mount or unmount file systems

• Share or unshare file systems

• Include a file system in existing automounter maps

• Convert a directory into a mount point

For step-by-step instructions on how to complete these tasks, refer to Table 11-1
on page 190. Also, these instructions are included in the online help provided
with the File System Manager tool.
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File System Manager’s Main Window
Figure 11-2 shows the important areas of the File System Manager’s main
window.

Figure 11-2 File System Manager’s Main Window

Here are some brief descriptions of the areas within File System Manager’s
main window:

• Current Context – Specifies the server or clients on the server where you are
managing file systems. You can change the current context by choosing
Load from the File menu or by clicking on the Load Context icon in the tool
bar.

Menu Bar

Tool Bar

Main
Browser

Current Context
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List

Message
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• Menu Bar – Displays the menus that enable you to perform operations in
File System Manager. For detailed descriptions of the menus, see the online
help.

• Tool Bar – Displays icons that provide an easier way to select
commonly-used operations provided by the main menu, such as mount and
unmount, and the ability to launch other tools. When you move the mouse
pointer over an active icon, the message area describes what operation the
icon will perform. You can choose Toolbar from the View menu to turn the
tool bar off or on (by default, it is turned on).

• Main Browser – Displays the directory hierarchy for the current context.
You can use the navigation buttons to expand or collapse the view of the
directories and mount points. The browser initially displays the top-level of
the file system hierarchy.

• The + and - Buttons – Are three state buttons that are used to expand and
collapse the hierarchical structure you are viewing. The three states are:
• Collapsed all (the + is displayed)
• Collapsed managed objects (the +/- is displayed)
• Expanded all (the - is displayed)

The +/- state means that the corresponding entry is only partially expanded
or collapsed. Clicking on a button in this state will further expand the entry.

• Message Area – Provides information about the main window or icon
where the mouse pointer is located.

• Mount Point List – Displays an entry for each mount point defined in the
current context. Each entry contains the full path name of the mount point,
the type of file system mounted on that mount point, whether the associated
resource is currently mounted on the mount point, and the name of that
resource.

• Shared Resource List – Displays an entry for each shared resource
(directory or mount point) defined in the current context. Each entry
contains the full path name of the resource, followed by the options
controlling its export.
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File System Manager Property Book
There are three ways to open the File System Manager Property Book.

• Select a mount point or directory in the main window and choose Properties
from the Object menu.

• Select a mount point or directory in the main window and click on the
Property Book icon in the tool bar.

• Double-click on a mount point or directory in the main window.

Figure 11-3 shows the important features of the File System Manager Property
Book.

Figure 11-3 File System Manager Property Book

Chapters
Chapter
Properties
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• Mount Point – Specifies the name of the mount point that you are managing
in the property book. In Figure 11-3 the object is the /export  mount point.

• Type – Specifies the type of the mount point.

• Property Browser – Functions much the same way as the Storage Manager
Load Context Property Browser. It lists all the chapters and subchapters (if
any) for the selected directory, mount point, or file system.

Double-clicking on a chapter expands the chapter in the Property Viewer
and displays the subchapters (if any) or the object properties.
Double-clicking on a subchapter expands that subchapter in the Property
Viewer.

• Chapter – Contains a common set of properties for the object that you can
view or modify.

• The + and - Buttons – The buttons that appear below the Property Browser
perform an expand all (+) or collapse all (-) function on the chapters in the
Property Viewer. This is a quick way of viewing all chapter properties or
only the chapter names.

The buttons that appear next to chapter names in property books also
perform an expand all or collapse all function, but only on the selected
chapter.

• Property Viewer – Enables you to expand and collapse the contents of
chapters. You can expand a chapter down to its object properties, enabling
you to view or modify the property for the object.

Chapter Properties – Specifies the properties that you can view or modify for
the object. There can be one or more properties in a chapter.

For more reference information on the chapters that are available from the File
System Manager Property Book, refer to the online help.
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Managing File Systems, Mount Points, and Directories With File System Manager

Table 11-1 Task Map: Managing Files With File System Manager

Activity Description For Instructions, Go To

Create a UFS File
System

Create a new file system on a specified device. ▼ How to Create a
UFS File System

page 191

Create a Mount Point Create a local (UFS) or remote (NFS) mount point. ▼ How to Create a
Mount Point

page 193

Modify the Properties
of a Mount Point or

Directory

Mount or unmount a file system, share or unshare a
directory, or modify an automounter map.

▼ How to Modify the
Properties of a
Mount Point or
Directory

page 195

 Mount or Unmount a
File System

Mount or unmount a file system. ▼ How to Mount or
Unmount a File
System

page 197

 Share or Unshare a
Directory

Share or unshare a directory. ▼ How to Share or
Unshare a Directory

page 199

View Static Client File
Systems

View the file systems that are mounted and
directories that are shared at boot time on the
server’s diskless clients and AutoClient systems.

▼ How to View Static
Client File Systems

page 201

View Active Server
File Systems

View the file systems that are currently mounted and
the directories that are shared on the server.

▼ How to View Active
Server File Systems

page 203

View Static Server File
Systems

View the server’s file systems that are mounted and
directories that are shared at boot time on the server.

▼ How to View Static
Server File Systems

page 205

Remove a Mount
Point From

/etc/vfstab

Remove a mount point from the /etc/vfstab  file. ▼ How to Remove a
Mount Point From
the /etc/vfstab File

page 207
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▼ How to Create a UFS File System

1. Choose Create File System from the Object Menu.
The New File System property book is displayed.

2. Open the Device chapter.

3. Enter the device name of an unused slice or metadevice on which to create
the UFS file system.
You can either type the name of a device, or drag and drop a slice from Disk
Manager or a metadevice from DiskSuite Tool.

4. If you want to verify that the specified device is currently available, click
on the Check File System button.

5. If you want to copy the contents of an existing directory into the new file
system, open the Population Options chapter and select Populate on
Create. Enter the Source Directory from which to copy the contents into
the new file system.

6. Click on OK.
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Example of Creating a UFS File System
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▼ How to Create a Mount Point

1. Click on the appropriate icon in the tool bar to create a UFS or NFS mount
point, or choose the appropriate option from the Object menu.
The Mount Point Name window appears.

2. Type a name and click on OK.
The property book for the mount point is displayed.

3. If you are creating a UFS mount point, skip to Step 6. If you are creating
an NFS mount point, open the Server Path chapter.

4. Type the name of a server and click on Probe Server.
A list of exported file systems is displayed in the Exported File Systems list.

5. Click on the desired file system name or type a name in the Path Name
field. Skip to Step 9.

6. Open the Device chapter.

7. Enter the device name of an unused slice on which to create the UFS
mount point.
You can either type the name of a device or drag and drop a slice from Disk
Manager.

8. If you want to verify that the specified device is currently available, click
on the Check File System button.

9. Make modifications to the other chapters, if needed.
For example, in the Mount Options chapter you can choose to mount now
and/or mount at boot time.

10. Click on OK.
The mount point appears in the Mount Point list.
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Example of Creating a Mount Point
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▼ How to Modify the Properties of a Mount Point or Directory

1. Select a directory or mount point from the main window.
You can select a directory or mount point from the main browser, the Mount
Point list, or the Shared Resource list.

Note – Once you select a mount point or directory, the Object menu may allow
you to automatically mount a file system, unmount a file system, share a
directory, or unshare a directory. If you want to complete one of these tasks, it
is faster to use the Object menu rather than make the change using the
Property Book.

2. Choose Properties from the Object menu.
The property book for the file system or directory is displayed.

3. Open the available chapters to modify the properties for the mount point
or directory.
Click on Help in the property book to see detailed information about each
chapter.

4. Click on OK.
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Example of a File System Manager Property Book
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▼ How to Mount or Unmount a File System

1. Select a mount point from the main browser, Mount Point list, or Shared
Resource list.

Note – Once you select a mount point, the Object menu may allow you to
automatically mount or unmount a file system. This method is faster than
making the change using the Property Book.

2. Choose Properties from the Object menu.
The property book for the file system is displayed.

3. Open the Mount Options chapter to modify the mount options (for
example, mount or unmount the file system).

4. Click on OK.
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Example of Mounting a File System
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▼ How to Share or Unshare a Directory

1. Select a directory or UFS mount point from the main browser, Mount
Point list, or Shared Resource list.

Note – Once you select a directory or mount point, the Object menu may allow
you to automatically share or unshare it. This method is faster than making the
change using the Property Book.

2. Choose Properties from the Object menu.
The property book for the file system is displayed.

3. Open the Sharing chapter to modify the share options (for example, share
or unshare the file system).

4. Click on OK.
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Example of Sharing a Directory
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▼ How to View Static Client File Systems

Static client file systems are those file systems that will be mounted on a server’s
AutoClient or diskless clients when they boot.

1. Click on the Load Context icon or choose Load from the File menu.
The Load Context property book is displayed.

2. Open the File System chapter, if not done already.

3. Click on the Static Client File System button.

Note – This button is only active if there are AutoClient systems or diskless
clients configured on the system.

The Client Context field is activated.

4. Select either Client Group or Individual Client.

5. Select a system from the Client Group or All Clients list.

6. Click on OK.
The file systems that will be mounted at boot time for the clients are
displayed in the Mount Point list on the main window.

The directories that will be shared at boot time for the clients are displayed
in the Shared Resources list on the main window.
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Example of Viewing Static Client File Systems
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▼ How to View Active Server File Systems

Active server file systems are the file systems on a server that are currently
mounted or shared. This is the same information as contained in the
/etc/mnttab  file.

1. Click on the Load Context icon or choose Load from the File menu.
The Load Context property book is displayed.

2. Open the File System chapter, if not done already.

3. Click on the Active Server File System button.

4. Click on OK.
The file systems that are currently mounted on the server are displayed in
the Mount Point list on the main window.

The directories that are currently shared on the server are displayed in the
Shared Resources list on the main window.
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Example of Viewing Active Server File Systems
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▼ How to View Static Server File Systems

Static server file systems are the file systems on a server that will be mounted or
shared at boot time. This is the same information as contained in the
/etc/vfstab  file.

1. Click on the Load Context icon or choose Load from the File menu.
The Load Context property book is displayed.

2. Open the File System chapter, if not done already.

3. Click on the Static Server File System Button.

4. Click on OK.
The file systems that will be mounted at boot time on the server are
displayed in the Mount Point list on the main window.

The directories that will be shared at boot time on the server are displayed
in the Shared Resources list on the main window.
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Example of Viewing Static Server File Systems
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▼ How to Remove a Mount Point From the /etc/vfstab  File

1. Perform the procedures in “How to View Static Server File Systems” on
page 205.

2. Select a mount point from the main browser, Mount Point list, or Shared
Resource list.

3. Choose Properties from the Object menu.
The property book for the file system is displayed.

4. Open the Mount Options chapter.

5. Open the Basic subchapter.

6. Click on Vfstab Entry.
You are toggling (deselecting) this property.

7. Click on OK.
The mount point no longer appears in the Mount Point list.
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Example of Removing a Mount Point Entry From the
/etc/vfstab  File
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Disk Manager Overview
Disk Manager is a tool that enables you to view and edit fdisk  partitions and
slices using two types of windows, the main window and a Property Book. The
main window displays the controllers, targets, disks, and slices for the current
context. The Property Book displays the chapters and their properties for the
selected disk(s), and it is at this level that you can view and edit disk
properties.

Specifically, you can complete the following tasks with Disk Manager.

• Assign a volume name to a disk.

• View and modify fdisk  partitions on x86 and PowerPC platforms.

• Show and set the active fdisk  partition on x86 and PowerPC platforms.

• View and modify slice geometry on SPARC, x86, and PowerPC platforms.

• Copy a disk’s characteristics to one or more disks of the same type.

Note – Before modifying fdisk  partitions and slices, you might want to back
up critical data.

For step-by-step instructions on how to complete these tasks, refer to Table 11-2
on page 214. Also, these instructions are included in the online help provided
with the Disk Manager tool.
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Disk Manager’s Main Window
Figure 11-4 shows the important areas of the Disk Manager’s main window.

Figure 11-4 Disk Manager’s Main Window

Here are some brief descriptions of the areas within Disk Manager’s main
window:

• Current Context – Specifies the server where you are managing disks. You
can change the current context by choosing Load from the File menu or by
clicking on the Load Context icon in the tool bar.

• Menu Bar – Displays the menus that enable you to perform operations in
Disk Manager. For detailed descriptions of the menus, see online help.
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• Tool Bar – Displays icons that provide an easier way to select
commonly-used operations provided by the main menu, such as cutting,
pasting, and launching other tools. When you move the mouse pointer over
an active icon, the message area describes what operation the icon will
perform. You can choose Toolbar from the View menu to turn the tool bar
off or on (by default, it is turned on).

• Main Browser – Displays a hierarchical view of the disk controllers, SCSI
targets, and disks for the current system context. You can use the
expand/collapse buttons to expand or collapse the view of the SCSI targets
and disks under each disk controller. The main browser initially displays the
disk controllers for all the available disks in the current context, in their
collapsed state.

• The + and - Buttons – Are three state buttons that are used to expand and
collapse the hierarchical structure you are viewing. The three states are:
• Collapsed all (the + is displayed)
• Collapsed managed objects (the +/- is displayed)
• Expanded all (the - is displayed)

The +/- state means that the corresponding entry is only partially expanded
or collapsed. Clicking on a button in this state will further expand the entry.

• Filter Message Area – Displays whether a filter is on or off, and if a filter is
on, how many disks are filtered.

• Message Area – Provides information about the main window or icon
where the mouse pointer is located.

• Disk List – Displays the type and size information for the disk(s) currently
selected in the main browser.

• Slice List – Displays the slices and their sizes for the disk(s) currently
selected in the disk list.

Selecting Multiple Disks

If you have multiple disks that are the same vendor type and have the same
physical geometry, you can perform an operation on them simultaneously. This
is called batch editing or batching. To select more than one disk in the main
browser or disk list, click SELECT (by default, the left mouse button) on the
first disk. Then select each subsequent disk by pressing the Shift key and
clicking SELECT.
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Disk Manager Property Book
There are three ways to open the Disk Manager Property Book.

• Select one or more disks in the main browser and choose Properties from the
Object menu.

• Select one or more disks in the main browser and click on the Property Book
icon in the tool bar.

• Double-click on a disk in the main browser.

Figure 11-5 shows the important features of the Disk Manager Property Book.

Figure 11-5 Disk Manager Property Book

Chapter
PropertiesChapters
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Here are some brief descriptions of the areas within Disk Manager’s main
window:

• Disk Name – Specifies the object or group of objects that you can manage in
the property book. In Figure 11-5, the object is a disk whose name is
c0t6d0 .

• The ... Button – Indicates that there is at least one other disk of the same
type as the disk being edited on the system. Clicking on the ... button
displays the Choose Disks to Edit window. This allows you to select more
than one disk (of the same type) for simultaneous edit operations.

• Disk Type – Specifies the type of the object. In Figure 11-5, the object is a
disk that has a disk type of DEFAULT.

• Property Browser – Functions much the same way as the Storage Manager
Load Context Property Browser. It lists all the chapters or subchapters (if
any) for the selected disk(s).

Double-clicking on a chapter expands the chapter in the Property Viewer
and displays the subchapters (if any) or the object properties.

• Chapters – Contains a common set of properties for the object that you can
view or modify.

• The + and - Buttons – The buttons that appear below the Property Browser
perform an expand all (+) or collapse all (-) function on the chapters in the
Property Viewer. This is a quick way of viewing all chapter properties or
only the chapter names.

The buttons that appear next to chapter names in property books also
perform an expand all or collapse all function, but only on the selected
chapter.

• Property Viewer – Enables you to expand and collapse the contents of
chapters. You can expand a chapter down to its object properties, enabling
you to view or modify the property for the object.

• Chapter Properties – Specifies the properties that you can view or modify
for the object. There can be one or more properties in a chapter. In
Figure 11-5, the Label chapter has a Volume Label field that provides a way
to assign a name to a disk.

For more reference information on the chapters that are available from the Disk
Manager Property Book, see online help.
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Managing Disks With Disk Manager

Table 11-2 Task Map: Managing Disks With Disk Manager

Activity Description For Instructions, Go To

Specify a Viewing
Filter

Specify the attributes of the disk(s) that you want to view
in the Disk Manager main browser.

▼ How to Specify a
Viewing Filter

page 215

Specify a
Volume Label

Assign a name to a disk. ▼ How to Specify a
Volume Label

page 217

 Modify fdisk
Partitions

Select an active fdisk  partition, modify fdisk  partition
sizes, and/or modify the type of fdisk  partitions.

▼ How to Modify fdisk
Partitions

page 219

 Modify Slice
Geometry

Modify slice sizes. ▼ How to Modify Slice
Geometry

page 221

Clone a Disk Copy a disk’s characteristics onto other disks of the
same type.

▼ How to Clone a Disk page 223
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▼ How to Specify a Viewing Filter

1. Choose Filter from the View menu.
The Filter Disks and Slices window appears with a list of the available disk
attributes in the Available Attributes list.

2. Specify which disks, with specific disk attributes, you want to display in
the main window.

a. Click on a disk attribute in the Available Attributes list.

b. Click on the >> button to move the attribute to the Show Disks list.

c. Repeat Step a and Step b until the Show Disks list contains all the disk
attributes that disks displayed in the main window will have.

Note – Clicking on the All >> button, moves the entire list of attributes in the
Available Attributes list to the Show Disks list. Clicking on the All << button,
moves the entire list of attributes in the Show Disks list to the Available
Attributes list.

3. Click on OK.
The main window refreshes, displaying only the disks that match the
criteria specified in the Show Disks list. The message area below the main
browser displays the number of filtered disks.
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Example of a Filter Disks and Slices Window

The Available Attributes section contains an entry for each disk type present in
the current context, and an entry called “Available Space” that corresponds to
all disks and slices with free space. The Show Disks section lists the attributes
of the disks displayed in the main window. By default, this section is empty
because filtering is turned off.
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▼ How to Specify a Volume Label

1. Select the disk that you want to modify in the Disk Manager main
browser.

2. Open the Property Book for the selected disk.
For more information see “Disk Manager Property Book” on page 212.

The Property Book window appears.

3. Open the Label chapter.
For more information see “Disk Manager Property Book” on page 212.

4. Delete the existing name in the Volume Label field, if applicable.

5. Enter the name of the volume label, which must be an alphanumeric
string of 8 or fewer characters.

6. Click on OK.
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Example of Specifying a Volume Label
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▼ How to Modify fdisk  Partitions

1. Select the disk that you want to modify in the Disk Manager main
browser.

2. Open the Property Book for the selected disk.
For more information see “Disk Manager Property Book” on page 212.

The Property Book window appears.

3. Open the Partitions chapter.
For more information see “Disk Manager Property Book” on page 212.

Size the Property Book window so that the entire partition layout is visible.

4. Click on the select box in the Editable column that corresponds to the
fdisk  partition you want to edit.

5. Modify the size of an fdisk  partition(s) by clicking on the arrows in the
Slider portion of the window, or click on the appropriate Start or End field
in the Partition Data portion of the window, type in a value, and press
Return.
For reference information, see online help.

Note – For PowerPC platforms, do not modify the boot disk partitions. For x86
platforms, fdisk  Solaris partitions must start at cylinder 1 or higher and they
may not overlap.

6. If desired, select the button in the Boot column to make the fdisk
partition active (the one whose operating system will be used at system
start-up).

7. Choose the type of the fdisk  partition.
Choose the appropriate type using the menus in the Type column.

8. Click on OK.
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Example of Modifying fdisk  Partitions
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▼ How to Modify Slice Geometry

1. Select the disk that you want to modify in the Disk Manager main
browser.

2. Open the Property Book for the selected disk.
For more information see “Disk Manager Property Book” on page 212.

The Property Book window appears.

3. Open the Slices chapter.
For more information see “Disk Manager Property Book” on page 212.

Size the Property Book window so that the entire slice layout is visible.

4. Click on the select box in the Editable column that corresponds to the
slice you want to edit.

5. Modify the size of a slice(s) by clicking on the arrows in the Slider
portion of the window, dragging the bar indicators, or typing values in
the Start and End fields.
For reference information, see online help.

Note – For x86 and PowerPC platforms, slices must start at cylinder 1 or higher
and may not overlap.

6. Click on OK.



222 Solstice AdminSuite 2.2 Administration Guide—February 1996

11

Example of Modifying Slice Geometry
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▼ How to Clone a Disk

1. Select the disk you want to clone in the Disk Manager main browser.

2. Click on the copy icon in the tool bar or choose Copy from the Edit menu.

3. Select a unused disk of the same type, or select a controller containing
one or more unused disks of the same type, in the Disk Manager main
browser.

4. Click on the paste icon in the tool bar, or choose Paste from the Edit
menu.

Note – An alternate method to performing the tasks described in Step 2 to
Step 4 is to press ADJUST (by default the middle mouse key) over the disk you
want to copy, drag the cursor onto the disk of the same type, and release the
ADJUST button.
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Part 3 — Additional Solstice AdminSuite
Administration

This part provides information on additional administration that you may
need to do after using the Solstice AdminSuite software, and additional
administration that the Solstice AdminSuite software provides.

Booting a System From the Network
Provides instructions on how to manually boot your diskless clients from the
network and how to set them up to automatically boot from the network.

12

Monitoring Software Usage
Provides overview information and instructions on how to use a compilation
of software programs that enable you to monitor software usage in a
server/client environment or on a non-networked system.

13
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Booting a System From the Network 12

After you add a diskless client (see “How to Add Support for a Diskless
Client” on page 101) to a server, the system is ready to boot and run the Solaris
environment.

Note – Diskless clients must always boot from the network.

This is a list of the step-by-step instructions in this chapter.

SPARC: How to Manually Boot a System From the Network page 229

SPARC: How to Manually Boot a Sun-4 System From the Network page 231

SPARC: How to Set Up a System to Automatically Boot From the
Network

page 231

SPARC: How to Set Up a Sun-4/3nn System to Automatically Boot From
the Network

page 234

SPARC: How to Set Up a Sun-4/1nn, 2nn, or 4nn System to
Automatically Boot From the Network

page 235

x86: How to Manually Boot a System page 237

x86: How to Set Up a System to Automatically Boot From the Network page 239

PowerPC: How to Manually Boot a System page 241

PowerPC: How to Set Up a System to Automatically Boot From the
Network

page 242
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SPARC: Booting From the Network
This section provides procedures on how to manually boot your SPARC system
from the network, and how to set it up to automatically boot from the network.

You need to read only certain portions of this section. Table 12-1 shows you
which task information to read for the type of systems you have on your
network.

Table 12-1 System Booting Information

If You Have This System ... See These Tasks ... On ...

SPARCstation and above with the Solaris
software already running (boot prom
prompt) or out of the box (the ok  prompt)

“SPARC: How to Manually Boot a System From the
Network”

“SPARC: How to Set Up a System to Automatically Boot
From the Network”

page 229

page 231

Sun-4 systems “SPARC: How to Manually Boot a Sun-4 System From the
Network”

“SPARC: How to Set Up a Sun-4/3nn System to
Automatically Boot From the Network”

“SPARC: How to Set Up a Sun-4/1nn, 2nn, or 4nn System
to Automatically Boot From the Network

page 231

page 234

page 235
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Note – In the Solaris 2.5 environment, only the Sun-4c, Sun-4d, Sun-4m, Sun-4u
kernel architectures, and the x86 and PowerPC platforms are supported. The
Solaris 2.5 software no longer supports Sun-4 and Sun-4e.

Table 12-2 summarizes the commands you use to manually boot systems from
the network for different system models.

For more information about the booting process in general, see the Solaris 2.4
Administration Supplement for Solaris Platforms for the Solaris 2.4 product, and
the System Administration Guide, Volume I for the Solaris 2.5 product.

▼ SPARC: How to Manually Boot a System From the Network

Note – If you want to manually boot a Sun-4 system from the network, see
“SPARC: How to Manually Boot a Sun-4 System From the Network” on
page 231.

1. Make sure the diskless client has been set up as described in “How to
Add Support for a Diskless Client” on page 101.

2. Make sure the system is in the prom monitor environment.
If the system is not running, power it up. If the system is currently running,
use the init 0  command to get it to the boot prom prompt.

3. If the screen displays the > prompt instead of the ok  prompt, type n and
press Return or Enter.
The screen should now display the ok  prompt. If not, see “SPARC: How to
Manually Boot a Sun-4 System From the Network” on page 231.

Table 12-2 Sun System Boot Commands

System Type Boot Command

SPARCstation and above boot net

Sun-4/3nn b le()

Sun-4/1nn, Sun-4/2nn, Sun-4/4nn b ie()
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4. Boot the system from the network.

Example of Manually Booting a SPARC System From the Network

ok boot net

# init 0
> n
ok
.
.
.
ok boot net
Booting from: le(0,0,0)
2bc00 hostname: pluto
domainname: Solar.COM
root server:
root directory: /export/root/pluto
SunOS Release 5.4 Version [2.4_FCS] [UNIX(R) System V Release
4.0]
Copyright (c) 1983-1994, Sun Microsystems, Inc.
configuring network interfaces: le0.
Hostname: pluto
Configuring cache and swap:......done.
The system is coming up. Please wait.
NIS domainname is Solar.COM
starting rpc services: rpcbind keyserv ypbind kerbd done.
Setting netmask of le0 to 255.255.255.0
Setting default interface for multicast: add net 224.0.0.0:
gateway pluto
syslog service starting.
Print services started.
volume management starting.
The system is ready.
login: root
password:
# exit
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▼ SPARC: How to Manually Boot a Sun-4 System From the Network

1. Make sure the diskless client has been set up as described in “How to
Add Support for a Diskless Client” on page 101.

2. Make sure the system is in the prom monitor environment.
If the system is not running, power it up. If the system is currently running,
use the init 0  command to get it to the boot prom prompt.

3. Type the appropriate boot command to boot the system from the network.

▼ SPARC: How to Set Up a System to Automatically Boot From the
Network

Note – If you want to set up a Sun-4 system to automatically boot from the
network, see “SPARC: How to Set Up a Sun-4/3nn System to Automatically
Boot From the Network” on page 234, or “SPARC: How to Set Up a Sun-4/1nn,
2nn, or 4nn System to Automatically Boot From the Network” on page 235.

1. Make sure the diskless client has been set up as described in “How to
Add Support for a Diskless Client” on page 101.

2. Make sure the system is in the prom monitor environment.
If the system is not running, power it up. If the system is currently running,
use the init 0  command to get it to the boot prom prompt.

3. If the screen displays the > prompt instead of the ok  prompt, type n and
press Return or Enter.
The screen should now display the ok  prompt. If not, see “SPARC: How to
Set Up a Sun-4/3nn System to Automatically Boot From the Network” on
page 234, or “SPARC: How to Set Up a Sun-4/1nn, 2nn, or 4nn System to
Automatically Boot From the Network” on page 235.

> b le()
or
> b ie()
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4. Determine the version number of the boot prom with the banner
command. The following is an example:

5. Set the boot device.

If the boot prom is version 2.0 or greater, type the following command.

If the boot prom version is less than 2.0, type the following command.

For more information about boot proms, see the OpenBoot 2.x Command
Reference Manual or the OpenBoot 3.x Command Reference Manual.

6. Boot the system automatically from the network by using the boot
command.

ok banner
SPARCstation 2, Type 4 Keyboard

ROM Rev. 2.0, 16MB memory installed, Serial # 289
Ethernet address 8:0:20:d:e2:7b, Host ID: 55000121

ok setenv boot-device net
boot-device=net

ok setenv boot-from net

ok boot
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▼ SPARC: How to Display Existing Boot Device Values on Sun-4 Systems

This procedure describes how to display the current boot device values, if you
need to record them before changing them.

1. Display the values of the system’s current booting devices.

The system displays the first EEPROM value.

2. Write down the EEPROM number and value.
For example, you might see EEPROM 018:12? . The EEPROM number is 018
and the value is 12.

3. Press Return to display the next value.

4. Repeat steps 2 and 3 until the last value is displayed.
The last value is 00.

5. Quit the EEPROM display mode.

Example of Displaying Existing Boot Device Values on Sun-4
Systems

Entering q18  and pressing Return three times displays the three values. You
should retain this information. The last q entry returns you to the >  prompt.

> q18

EEPROM 01B: 00? q

> q18
EEPROM 018: 12?
EEPROM 019: 69?
EEPROM 01A: 65?
EEPROM 01B: 00?  q
>
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▼ SPARC: How to Set Up a Sun-4/3nn System to Automatically Boot From
the Network

1. Make sure the diskless client has been set up as described in “How to
Add Support for a Diskless Client” on page 101.

2. Make sure the system is in the prom monitor environment.

3. (Optional) Perform the procedures in “SPARC: How to Display Existing
Boot Device Values on Sun-4 Systems” on page 233 if you want to record
the current boot device values.

4. At the command prompt, enter the following boot device code sequence.

This is the code for le  (the Lance Ethernet).

What you are doing for any of the Sun-4 architectures is programming the
EEPROM (or NVRAM) by entering q followed by the hexadecimal address
in the EEPROM. This sets the appropriate operating system boot device.

5. Boot the system automatically from the network.

Example of Setting Up a Sun-4/3nn System to Automatically Boot
From the Network

> q18 12 6c 65

> b

> q18 12 6c 65
EEPROM 018 -> 12
EEPROM 019 -> 6C
EEPROM 01A -> 65
>
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If the system output looks like the example above, you set the codes
successfully. If the output looks similar to the following:

you set the wrong code for the specific system architecture, and the system will
not boot. You need to reset the codes. In the above example output, a
Sun-4/3nn was set up with the wrong device code (ie  instead of le ).

▼ SPARC: How to Set Up a Sun-4/1nn, 2nn, or 4nn System to
Automatically Boot From the Network

1. Make sure the diskless client has been set up as described in “How to
Add Support for a Diskless Client” on page 101.

2. Make sure the system is in the prom monitor environment.

3. (Optional) Perform the procedures in “SPARC: How to Display Existing
Boot Device Values on Sun-4 Systems” on page 233 if you want to record
the existing boot device values.

> b

EEPROM boot device... ie(0,0,0)

Invalid device = ‘ie’
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4. At the command prompt, enter the following boot device code sequence.

This is the code for ie  (the Intel Ethernet).

What you are doing for any of the Sun-4 architectures is programming the
EEPROM (or NVRAM) by entering q followed by the hexadecimal address
in the EEPROM. This sets the appropriate operating system boot device.

5. Boot the system automatically from the network.

Example of Setting Up a Sun-4/1nn, 2nn, or 4nn System to
Automatically Boot From the Network

If the system output looks like the example above, you set the codes
successfully. If the output looks similar to the following:

you set the wrong code for the specific system architecture, and the system will
not boot. You need to reset the codes. In the above example output, a
Sun-4/1nn, 2nn, or 4nn was set up with the wrong device code (le  instead of
ie ).

> q18 12 69 65

> b

> q18 12 69 65
EEPROM 018 -> 12
EEPROM 019 -> 69
EEPROM 01A -> 65

> b

EEPROM boot device... le(0,0,0)

Invalid device = ‘le’
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x86: Booting From the Network
The following procedures apply to x86 systems. Booting an x86 system uses
these two subsystems:

• Solaris boot diskette (contains the program that provides booting from the
network)

• Secondary boot subsystem

The Solaris boot diskette, also known as the MDB diskette, provides a menu of
bootable devices such as disk, network, or CD-ROM. (The system probes
currently connected devices and displays the devices in the MDB menu.)
Diskless clients must boot from the network so you would always enter the
code for the network device.

The second boot subsystem menu displays available boot options. The system
automatically boots to run level 3 if you do not select an option within 60
seconds. The other options enable you to specify boot options or enter the boot
interpreter (see boot(1M) ).

▼ x86: How to Manually Boot a System

This procedure describes how to manually boot your x86 system from the
network. Screen displays will vary based on system configurations.

1. Make sure the diskless client has been set up as described in “How to
Add Support for a Diskless Client” on page 101.

2. Insert the Solaris boot diskette into the drive.

3. Press the reset button.
The Primary Boot Subsystem menu is displayed after a short time.
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The Solaris boot diskette provides a menu of bootable devices such as disk,
network, or CD-ROM. (The system probes currently-connected devices and
displays the devices in the MDB menu.)

Note – The number 30 displayed in the bottom left corner counts down,
indicating the number of seconds left to set the boot device code. If you do not
specify the boot device code within 30 seconds, the system will attempt to boot
from the C drive, which is the default device.

Solaris 2.4 for x86 Multiple Device Boot, vsn 2.1

Solaris/x86 Multiple Device Boot Menu

Code Device Vendor Model/Desc Rev
====================================================

10 DISK MAXTOR LXT-535S 8.75
11 CD SONY CD-ROM CDV-8012 3.1d
12 NET SMC/WD I/O=300 IRQ=5

Enter the boot device code:

30
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4. Enter the boot device code to boot from the network.
In this example the boot device code is 12.

The Secondary Boot Subsystem menu is displayed after a short time.

5. Type b or boot  to boot the system and press Return.

▼ x86: How to Set Up a System to Automatically Boot From the Network

This procedure describes how to create an x86 multiple device boot (MDB)
diskette so that your x86 diskless client will always boot from the network—so
you do not have to be there to boot it. Otherwise, if the master MDB diskette is
inserted into the drive, an x86 system will attempt to boot off the C drive after
a power cycle (for more information see “x86: Booting From the Network” on
page 237).

Note – Before following these steps to create an MDB boot diskette, obtain the
master MDB diskette for the x86 system and a blank 1.44 Mbyte diskette. The
blank diskette will be formatted, so do not use a diskette with data on it.

1. Become root on your server.

2. Change your working directory.

# cd /opt/SUNWadm/2.2/floppy

Solaris 2.4 for x86 Secondary Boot Subsystem, vsn 2.11

<<< Current Boot Parameters >>>
Boot path: /eisa/dpt@5c88,0/cmdk@0,0:a
Boot args: /kernel/unix

Type b [file-name] [boot-flags] <ENTER> to boot with options
or i <ENTER> to enter boot interpreter
or <ENTER> to boot with default

<<< timeout in 60 seconds >>>

Select (b)oot or (i)nterpreter:
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3. Create the MDB boot diskette.

The script prompts you when to insert the MDB master diskette and the
blank diskette, and provides additional status information.

Note – Even though the script says that it created an AutoClient floppy, you
can also use this floppy on diskless x86 systems.

4. Insert the MDB boot diskette into the diskette drive of the x86 system.
You must leave this boot diskette in the diskette drive so that the system
will automatically boot from the network if a power cycle occurs.

# ./mk_floppy

Please insert the master MDB floppy and press Return:
Please insert a blank floppy and press Return:
Formatting 1.44 MB in /dev/rdiskette
.............................................................
...................
fdformat: using "./mdboot" for MS-DOS boot loader
Successfully created the AutoClient floppy.
#
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PowerPC: Booting From the Network
This section provides procedures on how to manually boot your PowerPC
system from the network, and how to set it up to automatically boot from the
network. The steps are similar to those for booting a SPARC system from the
network.

▼ PowerPC: How to Manually Boot a System

1. Make sure the diskless client has been set up as described in “How to
Add Support for a Diskless Client” on page 101.

2. Make sure the system is in the prom monitor environment.
If the system is not running, power it up. If the system is currently running,
execute the following commands to get it to the boot prom prompt.

a. Become root.

b. Halt the system by using the init 0  command.

c. Press any key to stop the automatic boot process after the Hit any
key to abort  prompt.

The ok  prompt is displayed.

3. If this is the first time you are booting the system as an AutoClient
system, insert the Solaris boot diskette into the diskette drive.

4. Boot the system from the network.

# init 0

Automatically booting in 5 seconds. Hit any key to abort.

ok boot net
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▼ PowerPC: How to Set Up a System to Automatically Boot From the
Network

1. Make sure the diskless client has been set up as described in “How to
Add Support for a Diskless Client” on page 101.

2. Make sure the system is in the prom monitor environment.
If the system is not running, power it up. If the system is currently running,
execute the following commands to get it to the boot prom prompt.

a. Become root.

b. Halt the system by using the init 0  command.

c. Press any key to stop the automatic boot process after the Hit any
key to abort  prompt.

The ok  prompt is displayed.

3. Verify that the auto-boot?  parameter is set to true  by using the
printenv  command.
If the auto-boot?  parameter is set to true , skip to Step 6.

4. If the auto-boot?  parameter is set to false , change it to true  by using
the setenv  command.

# init 0

Automatically booting in 5 seconds. Hit any key to abort.

ok printenv auto-boot?
auto-boot?="true" (default value = "true")

ok setenv auto-boot? true
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5. Verify that the auto-boot?  parameter has been changed.

6. Change the boot-device  parameter by using the setenv  command to
boot from the network rather than from disk.

7. Verify the change by using the printenv  command.

8. If this is the first time you are booting the system as an AutoClient
system, insert the Solaris boot diskette into the diskette drive.

9. Boot the system automatically from the network.

ok printenv auto-boot?
auto-boot?="true" (default value = "true")

ok setenv boot-device boot net

ok printenv boot-device
boot-device="boot net" (default value =
"pci/pci1000,1@1/disk@6,0:\solaris.elf")

ok boot
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What Is Software Usage Monitoring
Software usage monitoring is a compilation of software programs that enable
you to monitor software usage in your computer system. The software usage
monitoring system tracks the software usage and installations across network
servers and workstations, to simplify system administration and purchasing
decisions. For example, after using software usage monitoring, you may find
that some software is never used while other software may be used repeatedly
and needs additional licenses. In addition, you may find that a piece of
software is installed on a workstation and is never used; this software could be
used by another user who needs it.

The software usage monitoring system is not intended to be a licensing
manager, nor does it track all software usage on your computer system. The
software usage monitoring system functions as a push system rather than a pull
system. That is, the software monitoring system cannot randomly obtain usage
information from your computer system. Software running on your computer
system must push usage information to the software usage monitoring server.

What Can Software Usage Monitoring Do
Software usage monitoring can do three basic tasks:

• It generates software usage information (report entries).

• It transfers report entries from the client (local queue) to the software usage
monitoring server.

• It formats and prints software report entries.

Software usage monitoring accomplishes these tasks using commands which
are listed and described in Table 13-1.

Note – Refer to the man pages for detailed descriptions of the commands.
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How Can Software Usage Monitoring Be Used
To generate software usage entries, you must run the swu_rpt  command or
function with your software applications. You can accomplish this by using
any of the following:

• You can use the swu_rpt  command from the command line.

The command line method enables you to start an application program and
create a software usage entry. For example, if you want to start the
FrameMaker program and create a software usage entry, you can do this at
a command line. The following example shows how you could do this.

• You can use the swu_rpt  command in a shell script.

The shell script method enables you to add the swu_rpt  command into an
existing shell script. For example, you may have a shell script called “frame”
used to start the FrameMaker program. You can create a shell script
wrapper by editing the frame script. Within this script, you can add the
swu_rpt command before and after the script’s program executable. Thus,
you wrap the program executable with swu_rpt  commands. This creates a

Table 13-1 Software Usage Monitoring Commands

Command Description

swu_rpt  (command or function) Creates a software usage entry and places it into the
local queue (/var/opt/SUNWswusg/swusage ) on the
client or the master log file on the software usage
monitoring server
(/var/opt/SUNWswusg/swusage.log )

swu_queue  command Moves the software report entries in the local queue
(/var/opt/SUNWswusg/swusage ) to the software
usage monitoring server; also enables and disables the
local queue

swu_svr  command Software usage monitoring daemon which receives
software usage reports sent by the swu_queue
command from the client or by swu_rpt  function

swu_print  command Formats and prints usage information in the master log
file (/var/opt/SUNWswusg/swusage.log ) to stdout
or another file
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Begin and End software usage entry each time the script is run.

In addition to the shell script wrapper method, you can modify the shell
script executable command line to include the swu_rpt  command using the
-c  option, which will create a Begin and an End entry each time the script is
run.

Note – The end record may not be accurate if the command returns after
spawning a new process (for example, in the background).

• You can embed calls to the swu_rpt  function in an application.

The embedded application method enables you to add a call to the software
usage library into your application source code. For example, if you or
someone else on your computer network has created an application, you can
call the software usage library from this application. This causes software
usage entries to be created each time the application is run.

Note – To use the embedded application method, you must have access to the
application’s source code.

How to implement these methods is described in detail in “Generating
Software Usage Report Entries” on page 257.
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How Does Software Usage Monitoring Work
The software usage monitoring system can be used in a client/server
environment or in a shared file system environment. Software usage
monitoring operates differently, depending upon which environment it is run.
The following sections describe how software usage monitoring operates in
each environment.

Software Usage Monitoring in a Client/Server Environment

Figure 13-1 shows an illustration of the software usage monitoring sequence of
events when used in a client/server environment.

Figure 13-1 Software Usage Monitoring Sequence Of Events (Client/Server)

Note – The client may also act as a software usage server in that it may have
the swu_svr  daemon, master log file, and swu_print  command installed on
the client.

Software Usage Monitoring Client

swu_rpt
command or function runs

swu_queue
command

Software Usage Monitoring Server

swu_svr  daemon swu_print
command

1.

2.

3.

4. 5.

Master log file

Local queue
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The following list describes the sequence of events.

1. The swu_rpt  command or function is initiated on the software usage
monitoring server or client from a command line, shell script, or within an
application.

2. The swu_rpt  command or function then creates a software usage report
entry in the local queue for the associated program. (The type of entry
depends upon the options used with the swu_rpt  command or function.)

Note – If the local queue has been disabled, no report entries will be logged.

3. A cron  job (run from root’s crontab ) using the swu_queue  command runs
on the client or server that transfers (flushes) information in the local queue
to the swu_svr  daemon that is running on the software usage monitoring
server.

Note – Files can be transferred manually by a root user from the local queue to
the swu_svr  daemon using the swu_queue  command using the -F  option.

4. The swu_svr  daemon accepts incoming report entries from the swu_queue
command and saves it to the master log file
(/var/opt/SUNWswusg/swusage.log ) or the log file name specified
when the swu_svr  daemon was started by root on the software usage
monitoring server.

Note – If the swu_svr  daemon is not running on the software usage
monitoring server specified in the entry, that entry in the local queue is
removed from the queue.

5. The swu_print  command takes information in the master log file
(/var/opt/SUNWswusg/swusage.log ) or the specified log file name and
copies all, part, or a summary of the information to another file where the
information can be searched using awk or other search tool. By default, this
command sends it to the standard output device if no file is specified.
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Note – This sequence of events shows the order in which commands are run;
however, you should note that the swu_rpt  command or function could be
run numerous times before the swu_queue  command transfers software usage
report entries from the local queue.

Software Usage Monitoring in a Shared File System Environment

Software usage monitoring operates in a similar manner in a shared file system
environment as it does in a client/server environment. By installing software
usage monitoring on a dedicated software usage monitoring server, you can
share the binary files with other hosts in your network.

Figure 13-2 shows an illustration of the software usage monitoring sequence of
events when used in a shared file system environment.

Figure 13-2 Software Usage Monitoring Sequence Of Events (Shared File System)

The following list describes the sequence of events.

1. The swu_rpt  command or function is initiated on a host from a command
line, shell script, or within an application.

2. The swu_svr  daemon receives the information generated from the swu_rpt
command or function and saves it to the master log file
(/var/opt/SUNWswusg/swusage.log ) or the file name specified when
the swu_svr  daemon was started by root.

Note – If the swu_svr  daemon is not running on the host server, the entry is
lost.

Software Usage Monitoring Server

swu_rpt
command or function runs

swu_svr  daemon swu_print
command

1. 2. 3.

Master log file

Host without Client
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3. The swu_print  command takes information in the master log file
(/var/opt/SUNWswusg/swusage.log ) or the specified file name and
copies all, part, or a summary of the information to another file where the
information can be searched using awk or other search tool. By default, this
command sends it to the standard output device if no file is specified.

Before Using Software Usage Monitoring
Before you use software usage monitoring, you need to complete a number of
steps. Usually, these steps only need to be done once; however, it may be
necessary to repeat some of them.

The steps required to set up software usage monitoring depend upon the
environment in which you intend to run software usage monitoring. The
following procedures describe how to set up software usage monitoring on a
server and/or a client if you so choose.

▼ How to Verify Software Usage Monitoring has been Installed on a
Software Usage Monitoring Server

1. Verify that software usage monitoring server side code has been installed
on the host server.

If software usage monitoring has not been installed, refer to the Solstice
AdminSuite 2.2 Installation and Product Notes for information about installing
software usage monitoring.

2. Verify that the swu_svr daemon is running on the host server.

$ cd /opt/SUNWswusg/bin
$ ls
swu_print swu_svr

$ ps -ef | /usr/bin/grep swu_svr

root 264 1 0 Jan 04 console 2:43 /opt/SUNWswusg/bin/swu_svr
jod 752 311 1 14:50:16 pts/3 0:00 grep swu_svr
$
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If the swu_svr  daemon is not running, start the swu_svr  daemon. Refer to
the “Starting and Stopping the swu_svr Daemon” on page 256 that describes
how to start and stop the swu_svr daemon.

Note – If you wish to generate software usage monitoring information on a
host, the software usage monitoring client binary packages should be installed
on that host or should be made available to that host through NFS.

▼ How to Verify that Software Usage Monitoring is Installed and Enabled
on a Client

1. Verify that software usage monitoring client code has been installed on
the host server.

If software usage monitoring has not been installed, refer to the Solstice
AdminSuite 2.2 Installation and Product Notes for information about installing
software usage monitoring.

2. Verify that the swu_queue  is enabled.

If queue_disabled  appears after the ls  command, login as root and
enable the queue as shown below.

$ cd /opt/SUNWswusg/bin
$ ls
swu_queue swu_rpt

$ cd /var/opt/SUNWswusg/swusage
$ ls
$

$ ls

queue_disabled
# /opt/SUNWswusg/bin/swu_queue -e

# ls
 #
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▼ How to Verify that Software Usage Monitoring is Enabled on a Host in a
Shared File System Environment

1. Verify that a software usage monitoring server has been added to the
name service.

2. Verify that the swu_rpt  command is executable (through a shared file
system or copied locally) by any shell scripts that use it.

Note – Refer to the Solstice AdminSuite2.2 Installation and Product Notes
document for information about how to set up your swusage_host  server.

$ rpcinfo -t host 120100
program 120100 version 1 ready and waiting
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Starting and Stopping the swu_svr  Daemon
When software usage monitoring is installed, the swu_svr  daemon is started
on the software usage monitoring server. At times, you may want to stop or
restart the swu_svr  daemon. The following procedures describe how to start
and stop this daemon.

▼ How to Start the swu_svr  Daemon

1. Log into the software usage monitoring host server as root.

2. Start the swu_svr  daemon.

3. Log out.

▼ How to Stop the swu_svr  Daemon

1. Log into the software usage monitoring host server as root.

2. Stop the swu_svr  daemon.

3. Log out.

# /etc/init.d/swusage start

# /etc/init.d/swusage stop
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Generating Software Usage Report Entries
Software usage monitoring report entries can be generated using the following
methods:

• A command line interface

• Shell scripts

• An embedded application

Each method uses the same basic software usage components; however, the
methods access the components differently. The following sections describe
each method and the procedures used to implement each method.

Using a Command-Line Interface

The command-line interface method is probably the simplest method of
implementing software usage monitoring; however, it can also be the most
taxing method as it requires you to manually type in each command each time
you run software usage monitoring with an application.

▼ How to Monitor Software Usage Using a Command-Line Interface

At the shell prompt, generate a usage report using one of the following
swu_rpt  command lines.

To create a software usage report entry specifying that the associated program
has been installed, use the -i  option.

To create a software usage report entry specifying that the associated program
has started, use the -b  option.

$ swu_rpt -p product-name [-I identifier] [-s server] [-a attr1=val1, attr2=val2,...] -i

$ swu_rpt -p product-name [-I identifier] [-s server] [-a  attr1=val1, attr2=val2,...] -b
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To create a software usage report entry specifying that the associated program
has ended, use the -e  option.

To create software usage report entries specifying a begin and an end entry for
the associated program, use the -c  option.

In these commands,

$ swu_rpt -p product-name [-I identifier] [-s server] [-a attr1=val1, attr2=val2,...] -e

$ swu_rpt -p product-name [-I identifier] [-s server] [-a attr1=val1, attr2=val2,...] -c command

-p product-name Indicates the name of the product that software
usage is being recorded for; this option must be
included.

-I identifier Specifies a numerical identifier for usage records;
swu_rpt  will provide its own identifier if one is
not specified.

-s server Specifies the software usage monitoring server to
which the usage records are to be sent. The default
is the host aliased to swusage_host .

-a attr1=val1,
attr2=val2,...

Allows the user to give the software usage entry
unique or more descriptive information.

-b Indicates that a begin entry will be recorded.

-e Indicates that an end entry will be recorded.

-i Indicates that an install entry will be recorded.

-c command Indicates that the command or program listed after
the -c  option should be executed and that a begin
and end entry should be recorded.
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Example of Monitoring Software Usage Using a Command-Line
Interface

The following example shows the software usage monitoring command as
used from a command line, which starts the FrameMaker program using the
command maker , and logs the application using the software usage
monitoring swu_rpt  command.

In this example, two software usage report entries would be created because
the -c  option was used (the -c  option creates a begin and an end entry). The
entries would look like the following.

Report Entry 1: Report Entry 2:

Type Admin/Usage Type Admin/Usage
Product FrameMaker Product FrameMaker
SubType Begin SubType End
Time 8444845890 Time 8444845957
UserID 30581 UserID 30581
User jod User jod
Host buck Host buck
Domain forest.field.com Domain forest.field.com
HostID 1234567890 HostID 1234567890
Locale C Locale C
Version 1 Version 1
Usage Server sherlock Usage Server sherlock
RecordID 29581 RecordID 29581

$ swu_rpt -p FrameMaker -I 29581 -s sherlock -c maker
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Using Shell Scripts

Another method of monitoring software usage is to create a shell script that
initiates a program. This method enables you to create a log entry each time a
user executes the shell script. A shell script can be modified using one of two
methods: you can create a shell script wrapper, or you can modify the script of
an existing shell script program. Either method creates a begin and end
software usage monitoring log entry.

• Using the shell script wrapper method, you would enter a software usage
monitoring command line before and after the program executable
command line. For example, you may have a script called “maker” that
starts the FrameMaker program. Within this “maker” script, you could add
software usage monitoring commands that would “wrap” around the
executable portion of the script. By doing this, the software usage
monitoring commands are executed when the script is initiated and also
when the script ends.

Note – Using the shell script wrapper method may not be the best option if
your command runs in the background. An end record is generated
immediately after the command is executed and the time used is not accurate.

• Using the method of modifying the shell script executable command line, a
single command line in the script starts the specified program, and also
creates a begin and end software usage monitoring log entry.

The following procedures describe how to implement each software usage
monitoring shell script method.
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▼ How to Monitor Software Usage Using a Shell Script Wrapper

1. Using the editor of your choice, open the shell script to which you wish to
add the software usage monitoring commands.

2. Before the program executable command line in the script, add the
following swu_rpt  command line.

In this command,

swu_rpt -p product name [-I identifier] [-s server] [-a attr1=val1, attr2=val2,...] -b

-p product-name Indicates the name of the product that software
usage is being recorded for; this option must
always be included.

-I identifier Specifies a unique, alpha numeric identifier for
usage records; swu_rpt  will provide its own
identifier if one is not specified.

-s server Specifies the server to which the usage records are
to be sent. The default is the host aliased to
swusage_host .

-a attr1=val1,
attr2=val2,...

Allows the user to give the software usage entry
unique or more descriptive information.

-b Indicates that a begin entry should be recorded.
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3. After the program executable in the script, add the following swu_rpt
command.

In this command,

4. Exit the script, saving your changes.Verify that the script is executable.

swu_rpt -p product-name [-I identifier] [-s server] [-a attr1=val1, attr2=val2,...] -e

-p product-name Indicates the name of the product that software
usage is being recorded for; this option must
always be included.

-I identifier Specifies a unique, numerical identifier for usage
records; swu_rpt  will provide its own identifier if
one is not specified.

-s server Specifies the server to which the usage records are
to be sent. The default is the host aliased to
swusage_host .

-a attr1=val1,
attr2=val2,...

Allows the user to give the software usage entry
unique or more descriptive information.

-e Indicates that an end entry should be recorded.
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Example of Monitoring Software Usage Using a Shell Script
Wrapper

The following example shows the software usage monitoring commands
added to a shell script called dir_script  that lists the directory in which it
was called, the files in the directory, and the current date and time.

In this example, two software usage report entries would be created and would
look like the following.

Report Entry 1: Report Entry 2:

Type Admin/Usage Type Admin/Usage
Product dir_script Product dir_script
SubType begin SubType end
Time 8444845890 Time 8444845892
UserID 30581 UserID 30581
User jod User jod
Host buck Host buck
Domain forest.field.com Domain forest.field.com
HostID 1234567890 HostID 1234567890
Locale C Locale C
Version 1 Version 1
Usage Server sherlock Usage Server sherlock
RecordID 295833 RecordID 295833
C_Command1 pwd C_Command1 pwd
C_Command2 ls C_Command2 ls
C_Options -la C_Command3 date
C_Command3 date

swu_rpt -p dir_script -I 295833 -s sherlock -a \
“Command1=pwd,Command2=ls,Options=-la,Command3=date” -b
pwd
ls -la
date
swu_rpt -p dir_script -I 295833 -s sherlock -a \
“Command1=pwd,Command2=ls,Command3=date” -e
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▼ How to Add Software Usage Monitoring to a Shell Script Program
Executable Command Line

1. Using the editor of your choice, open the shell script to which you wish to
add the software usage monitoring commands.

2. Locate the command line in the script that calls the program.

3. Add the following arguments to the program executable command line.

In this command,

4. Exit the script, saving your changes. Verify that it is executable.

swu_rpt -p product-name [-I identifier] [-s server] [-a attr1=val1, attr2=val2,...] -c command

-p product-name Indicates the name of the product that software
usage is being recorded for; this option must
always be included.

-I identifier Specifies a unique, numerical identifier for usage
records; swu_rpt  will provide its own identifier if
one is not specified.

-s server Specifies the server to which the usage records are
to be sent. The default is the host aliased to
swusage_host .

-a attr1=val1,
attr2=val2,...

Allows the user to give the software usage entry
unique or more descriptive information.

-c command Specifies the program executable command.
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Example of Adding Software Usage Monitoring to a Shell Script
Program Executable Command Line

The following example shows the software usage monitoring command added
to a program executable command line that executes FrameMaker.

In this example, the software usage report entry would look like this:

Report Entry 1: Report Entry 2:

Type Admin/Usage Type Admin/Usage
Product Frame Product Frame
SubType Begin SubType End
Time 8148244876 Time 8148244920
UserID 30581 UserID 30581
User jod User jod
Host buck Host buck
Domain forest.field.com Domain forest.field.com
HostID 1234567890 HostID 1234567890
Locale C Locale C
Version 1 Version 1
Usage Server sherlock Usage Server sherlock
RecordID 295836 RecordID 295836
C_Command maker C_Command maker
C_Version 4.0 C_Version 4.0

swu_rpt -p Frame -I 295836 -s sherlock -a “Command=maker,Version=4.0” -c maker
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Using an Embedded Application

Software usage monitoring can be implemented by embedding calls to the
swu_rpt  function into an application. This method works well for monitoring
applications that you or others on your computer network have created.

For example, you may have created an online timecard to keep track of time
spent on projects; however, you are not sure that it is being used by everyone.
Within the online timecard application, you can embed calls to the swu_rpt
function, which then generates usage reports every time the application is
executed.

The following procedure provides information about how to embed the
software usage monitoring report function within an application.

▼ How to Embed Software Usage Monitoring into Applications

1. Open the application source code file that will contain the software usage
monitoring commands.

2. Add the following header file to the application source code.

3. Add a swu_rpt function specifying the begin of the application.

4. Add a swu_rpt function specifying the end of the application.

#include <swusage.h>

swu_rpt ( “ Server_name” , “ Identifier” , SWU_BEGIN, “ Product name”, avl)

swu_rpt ( “ Server_name” , “ Identifier” , SWU_END, “ Product name”, avl)
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5. Compile the application source code with one of the following arguments.
For static linking of the libraries:

For dynamic linking of the libraries:

$ ... -I/opt/SUNWswusg/include -L/opt/SUNWswusg/lib -Bstatic -lswusage -lnsl ...

$ ... -I/opt/SUNWswusg/include -R/opt/SUNWswusg/lib -L/opt/SUNWswusg/lib
-lswusage -lnsl ...
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Example of Embedding Software Usage Monitoring into
Applications

The following example shows an application that includes the software usage
monitoring function.

#include <stdio.h>/* definition of NULL */
#include <swusage.h> /* swu_rpt() prototype, swusage_alist definition */
#define ATTRIBUTE_COUNT 3

main()
{

struct swusage_alist avl[ATTRIBUTE_COUNT];

/*
 * Define some product specific attribute-value pairs that will
 * be included in the software usage report records.
 */
avl[0].u_attr = "ATTR_1";
avl[0].u_value = "val_1";
avl[1].u_attr = "ATTR_2";
avl[1].u_value = "val_2";

/*
 * Terminate the attribute list
 */
avl[2].u_attr = NULL;
avl[2].u_value = NULL;

/*
 * Create a begin record for the application
 */
swu_rpt(“Server_name”, “Identifier”, SWU_BEGIN, "My product name", avl);

/*
 * The application code would go here.
 */

/*
 * Create an end record for the application
 */
swu_rpt(“Server_name”, “Identifier”,SWU_END, "My product name", avl);

}
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In this example, the software usage report entry would look like this:

Report Entry 1: Report Entry 2:

Type Admin/Usage Type Admin/Usage
Product My product name Product My product name
SubType Begin SubType End
Time 8148244876 Time 8148244920
UserID 30581 UserID 30581
User jod User jod
Host buck Host buck
Domain forest.field.com Domain forest.field.com
HostID 1234567890 HostID 1234567890
Locale C Locale C
Version 1 Version 1
Usage Server Server_name Usage Server Server_name
RecordID Identifier RecordID Identifier
C_ATTR_1 val_1 C_ATTR_1 val_1
C_ATTR_2 val_2 C_ATTR_2 val_2
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Transferring Software Usage Entries on a Client to the Master Log File on the
Software Usage Monitoring Server

If software usage monitoring is installed on a client and software usage entries
have been recorded on the client, you need to transfer the software usage
report entries in the client’s local queue to the master log file on the software
usage monitoring server. Figure 13-3 provides an illustration of where the data
is located.

Figure 13-3  Software Usage Monitoring Files and Locations

The software usage report entries in the local queue are located in the
/var/opt/SUNWswusg/swusage  directory. The report entries are designated
by an alphanumeric string. For example, if you entered the ls command in the
local queue, you would see something like the following:

The software usage report entries are moved from this directory using the
swu_queue  command.

When the software usage monitoring system was installed, a cron  job was
added to the host’s root crontab . This cron  job runs the swu_queue
command at a random time between midnight and 7 a.m. This swu_queue
command transfers (flushes) the usage reports from the local queue to the
master log file (/var/opt/SUNWswusg/swusage.log ) on the software usage
server specified in the usage entry.

$ cd /var/opt/SUNWswusg/swusage
$ ls
swrepAAAa000Tv  swrepAAAa000UL  swrepBAAa000Tv  swrepBAAa000UL

Software Usage
Monitoring Client

Local queue
/var/opt/SUNWswusg/swusage

Software Usage Monitoring Server

swu_svr daemon Master Log File
/var/opt/SUNWswusg/swusage.log
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Although this job runs automatically, there may be times when you wish to
transfer the data in the local queue to the software usage monitoring server at
a time other than when the cron  job transfers the data. To do so, see “How to
Transfer Software Usage Entries on the Client to the Master Log File on the
Software Usage Monitoring Server” on page 272.

Note – When the swu_queue  command is executed and the files are
successfully transferred from the local queue to the master log file, the files are
removed from the local queue; if the files do not get transferred (for example,
the host specified in the entry was not running), the files in the local queue are
not removed, which may cause your file system to fill. To prevent this from
happening, you can disable the queue using the swu_queue -d  command,
which prevents usage records from being logged.

The following list contains possible problem areas when transferring software
usage entries on the client to the master log file.

• If the swu_svr  daemon is running on the host specified in the software
usage entry, files will be transferred from the local queue to the master log
file.

• If swu_queue  can not connect to the software usage server daemon because
the host in the record doesn’t exist, the record is removed from the local
queue.

• If the usage record contains a software usage server host that doesn’t exist,
the record is removed.

• If the software usage server host specified in the usage record is not running
or if there is an RPC failure, the usage record remains queued for later
delivery.

• If the usage record doesn’t contain a software usage server host, then the
record is removed from the local queue.
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▼ How to Transfer Software Usage Entries on the Client to the
Master Log File on the Software Usage Monitoring Server

1. Log in to the client that has software usage report entries.

2. Become root.

3. Enter the swu_queue  command.

In this command,

# swu_queue -F

-F Transfers data in the local queue to the swu_svr
daemon on the usage monitoring server.
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Printing Software Usage Data from the Master Log File
After the software usage data has been moved from the local queue to the
master log file on the host server, you may want to print the information in the
master log file to another file, stdout  (screen), or printer.

The software usage record entries are not formatted in the master log file. The
swu_print  command moves and formats the software usage report entries in
the master log file to another file or the standard output device. Three options
can be used with the swu_print  command to format the entries differently.

The options available with the swu_print  command are listed in Table 13-2,
along with an example of how the software usage report entries are formatted
with the associated option.

Table 13-2 swu_print  Options

Option Format Example

-a PRODUCT SUBTYPE TIME RECORD_ID USER HOST
maker Begin Feb 26 17:08:17IDstring jod sherlock
vi Begin Feb 27 19:09:19IDstring jad holmes

-d TYPE=Admin/Usage
Product=maker
SubType=Begin
Time=819653293
UserID=49740
User=jod
Host=buck
Domain=field.forest.com
HostID=55003efc
Locale=C
Version=1
Server=sherlock
RecordID=IDstring

-s PRODUCT TIME USER HOST
maker 01:31:47 jod buck
vi 19:09:19 jad doe
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Formatting these entries enables you to use awk or another search tool to
search on keywords; formatting also enables you to easily translate the entries
into another database or report.

Note – swu_print  does not delete the software usage report entries from the
master log file. In order to get rid of these entries, you must delete the master
log file. Otherwise, entries are appended to the software usage report entries
that you already copied out using the swu_print  command. This could result
in your file system becoming full; see “How to Remove the Master Log File” on
page 277 for information about how to safely remove this file.

The report entries created by the software usage monitoring system vary
depending upon the command used to generate the entry; however, all entries
have some fields that will always appear. Table 13-3 provides a list of all
possible report entries, along with a description of each entry, and a list of
when the entry is used.

Table 13-3 Report Entries

Field Possible Entries Description When Used

Type Admin/Usage Indicates the record is a system administration,
software usage entry.

Always

Product Varies Indicates the product name (or program name) of the
software that is being logged; specified with the
swu_rpt  command or function.

Always

User Varies Indicates the user who ran the software. The entry will
indicate the user’s login name.

Always

SubType Begin Intended to indicate that the software associated with
this record has begun execution at the indicated time.

swu_rpt command
options -b  or -c

End Intended to Indicate that the software associated with
this record has ended execution at the indicated time.

swu_rpt command
options -e  or -c

Install Intended to indicate that the software associated with
this record has been installed.

swu_rpt command-i
option

Enable Queue Indicates that the local swu_queue  has been enabled. swu_queue  command
-e  option

Disable Queue Indicates that the local swu_queue  has been disabled. swu_queue  command
-d  option
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Note – If the field variable is not set, ??  would be the entry for the field
variable because software usage monitoring could not determine its value.

To copy and format the software usage monitoring report entries in the master
log file to another file or the standard output device, you need to perform the
following procedure.

Time Varies Indicates the time the software began execution, ended
execution, or was installed. The value indicates the
value of time in seconds since 00:00:00 UTC January 1,
1970.

Always

UserID Varies Indicates the user ID of the user who ran the software. Always

Host Varies Indicates the name of the workstation or server that the
program or command was run on.

Always

Domain Varies Indicates the name service domain that the host resides
in.

Always

HostID Varies Indicates the hardware serial number of the host
workstation or server.

Always

Locale Varies Indicates the current value of the LANG environment
variable.

Always

Version Varies Indicates the software usage monitoring version
(specified by the software usage monitoring program)

Always

Usage
Server

Varies Indicates the software usage server to which usage
entries are to be sent

Always

RecordID Varies Indicates a unique, numerical ID that is specified with
the swu_rpt command; if no identifier is specified, the
parent process ID process and time is used as the
default

Always

Table 13-3 Report Entries (Continued)

Field Possible Entries Description When Used
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▼ How to Print Software Usage Data from the Master Log File

1. Log in to the software usage monitoring host server.

2. Open a command tool and enter the swu_print  command.

In this command,

$ swu_print [-a|-d|-s]  [-f filename] [-l log_file]

-a Specifies the format swu_print  is to use
(default - all). Refer to Table 13-2 for format
examples.

-d Specifies the format swu_print  is to use (dump).
Refer to Table 13-2 for format examples.

-s Specifies the format swu_print  is to use
(summary). Refer to Table 13-2 for format
examples.

-f filename Specifies the file to which information in the log file
will be directed.

-l log_file Specifies the master log file. If this option is not
specified, the default file
/opt/SUNWswusg/swusage.log  is used.



Monitoring Software Usage 277

13

Removing the Master Log File
To keep your file system from filling up, you will periodically have to clean up
the master log file; however, you must follow a certain procedure to properly
remove this log file to prevent future data loss.

The following procedure describes how to safely remove the master log file.

▼ How to Remove the Master Log File

1. Log in as root on the software usage monitoring server.

2. Move the master log file to a temporary log file.

3. Perform any processing you wish to /tmp/tmp.log .

4. Remove /tmp/tmp.log .

5. Log out.

Note – This procedure moves all the software usage record entries located in
swusage.log  to a new file; any new records generated during this procedure
will cause a new swusage.log  file to be created.

# mv /var/opt/SUNWswusg/swusage.log /tmp/tmp.log

# rm /tmp/tmp.log
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Glossary

aliases  file

A file containing mail aliases, which are names that represent distribution lists
of users.

authentication
A function provided by the sadmind  daemon which verifies the identity of the
user making a system administration request across the network.

authorization
The sadmind  daemon verifies that the authenticated user has permission to
execute the Solstice AdminSuite software on the server. After the user identity
is verified, the sadmind  daemon uses the user identity to perform
authorization checks.

AutoClient system
A system with a monitor and keyboard, CPU and memory, Ethernet hardware,
and a small disk (at least 100-Mbyte) to cache its root (/ ) and /usr  file systems
from a server on a network. This system gets its other file resources from a
server on the network.

auto_home  (or auto.home ) file
An indirect automounter map that contains entries enabling client systems to
mount their home directories automatically. It is primarily accessed using User
Manager.
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baud rate
The switching speed of a line, which is the number of changes in the electrical
state of the line per second. At low speeds, baud rate is equivalent to bits
transmitted per second. At higher speeds, the bits transmitted per second is
greater than the baud rate because one baud can be made to represent more
than one bit.

Berkeley Software Distribution (BSD)
One of two major “flavors” of the UNIX® operating system, the other being
System V. SunOS operating system releases before SunOS 5.0 (Solaris 2.0) are
BSD.

boot server
A system that provides the programs and information a client needs to boot.

bootparams file
A file containing entries that are used to enable client systems to boot from the
network.

chapter
A chapter represents the properties of an object. You can view and/or change
the properties within a chapter by opening it.

content type
Specified when you add support for a local printer. Identifies the particular
formats of files that can be printed. Supported content types are: PS
(PostScript), ASCII, simple, or any.

context
A context describes the environment or components of the object whose
properties you are going to view and/or edit. In the case of File System
Manager, the context includes what name service to modify or how to view
and modify the file systems on a server. In the case of Disk Manager, the
context includes the disk metaset to modify if you have the Solstice DiskSuite
4.0 software installed on the system.

context type
A field in the Storage Manager Load Context window that indicates the name
of the tool with which the current context is associated.

current context
A field in the Storage Manager Load Context window that specifies the host
name with which the current context is associated.



Glossary 281

Database Manager
One of Solstice AdminSuite’s applications used to manage
network-related system files such as aliases  and netmasks .

dataless client
A system with a monitor and keyboard, CPU and memory, Ethernet hardware,
and small local disk for the swap area and the root (/ ) file system. This system
gets it other file resources from a server on the network.

default
An assumed value, or an action taken automatically unless you specify
otherwise.

device
A hardware component, such as a printer or disk drive, acting as a unit to
perform a specific function.

diskless client
A system with a monitor and keyboard, CPU and memory, and Ethernet
hardware. This system gets it file resources and swap space from a server on a
network.

Ethernet address
A system’s hardware address. The Ethernet address can be displayed using the
banner  command from the PROM level.

ethers  file
A file containing Ethernet addresses of network client systems.

fdisk  partition
A logical partition of a disk drive dedicated to a particular operating system on
x86 and PowerPC systems.

file server
A system that shares file resources and disk storage space for network clients.

file system
A hierarchy of files and directories in the Solaris operating environment.

generic system
A system that is not running the Solaris software, or whose type has not yet
been updated using Host Manager’s Update System Type feature, or uses local
or loghost entries in the system management databases.
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group
A collection of users who share files and other system resources. Each user
belongs to a primary group (listed in the user’s passwd  entry), and optionally,
one or more secondary groups.

group  file
A file containing entries for UNIX groups. The group  file is accessed from
Group Manager.

group ID (GID)
A group identification number used by the system to identify a user’s primary
group. Group ID numbers for users usually range from 100 to 60000.

Group Manager
One of Solstice AdminSuite’s applications used to manage group information
in the group  file.

hardwired
Refers to a device such as a terminal that is physically connected to the local
system.

Host Manager
One of Solstice AdminSuite’s applications used to manage network client
services.

host name
A unique name that identifies a system.

initialization files
Special files that run automatically when you log in. When an account is
created and you specified a skeleton path, User Manager copies generic
versions of the initialization files into the user’s home directory. You can then
edit the copies as needed to customize each user’s environment.

install server
A system on the network that provides a Solaris CD image (either from a CD-
ROM drive or a copy on hard disk) for other systems to install from.

IP address
A system’s unique network address.

launcher
See Solstice Launcher.
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local printer
A printer physically connected to the local system.

locale  file
A file containing the default locales used by network clients.

media server
A system that shares a CD-ROM device for remote installation of software.

metaset
A logical grouping of disks.

modem

name service
Method by which system information is maintained in the network. There are
three selections in Solstice AdminSuite: NIS, NIS+, and None.

• NIS – Name service shipped with the SunOS 4.1.x operating system
(Solaris 1). Designated systems, called NIS servers, contain maps that store
information about the network, its clients, and its users.

• NIS+ – Name service shipped with the Solaris software. Making use of true
databases (instead of two-column maps that simply associate one variable
with another), NIS+ stores more information than NIS.

• None – Method for administrators of networks that do not use a network
name service; administrators usually select one system on the network on
which to maintain a master copy of the /etc  configuration files.

name service domain
A group of systems and the information served to those systems.

netgroup  file
A file containing entries for netgroups, a group of systems granted identical
access to network resources for security and organizational reasons.

Modem ModemSystem SystemPhone

Digital signal

Analog signal

Lines 21
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netmasks file
A file containing network mask values used to implement IP subnetting.

network client
A system that uses remote resources from a server.

networks file
A file containing information about available networks.

nsswitch.conf
A file that contains an entry for each system file and a corresponding name
service source to search for the system file information. The name service
sources are designated as keywords— nis , nisplus , or files . If more than
one name service source is listed, they are searched in the order given.

object
A disk or file system, whose properties you can view and modify.

OpenWindows
A windowing system based on the OPEN LOOK® graphical user interface.

OS server
A server that provides OS services to support diskless clients, dataless clients,
and AutoClient systems.

OS services
OS software that you can add to an OS server for it to support clients of other
platform groups and Solaris releases. You can also add services for clients that
are the same platform group and require the same Solaris release as the OS
server.

parallel port
A port that transfers one or more bytes simultaneously over multiple lines. See
also serial port.

partition
See slice.

passwd  file
A file that contains user account information such as user name, user ID, group
ID, and home directory. User Manager accesses this file.



Glossary 285

password status
Characteristics associated with a user’s password. User Manager’s Add User
window has a password status menu that enables you to control user
password characteristics. The choices are:

• Normal password – Sets a password for the user.
• Cleared until first login – Prompts user for a password on first login.
• Account is locked – Disables account. Account can be unlocked by

assigning a new password. This type of account allows a user to own files
but not log in.

• No password—setuid only – Disables the ability to directly log in to the
account. This allows programs such as lp  or uucp  to run under an account,
without allowing a user to log in.

permissions
A set of attributes that determines which users have access to read, write, and
execute a file or directory’s contents.

port

A channel through which a device communicates with the operating system.

port monitor

A program that continuously “watches out” for requests to log in, or requests
to access printers or files.

When a port monitor detects a request, it sets the parameters required to
establish communication between the operating system and the device
requesting service. Then the port monitor transfers control to other processes
that provide the services needed.

primary group
A user’s default group, which determines the group ownership on a file the
user creates, or is allowed to access, if already created. Membership in this
group is defined by the group identifier listed in the user’s entry in the passwd
file.

print client
A system that uses a print server for printing files.

print server
A system that has a printer physically connected to it and the appropriate
software configured to print both local and remote print requests.
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Printer Manager
One of the Solstice AdminSuite’s applications used to manage local and
remote printer setup.

printer name
A unique name, with a maximum of 14 characters, for a printer.

printer type
The terminfo  database entry that contains the control sequences that
initialize the printer.

profile server
A system that contains JumpStart files for systems to perform a custom
JumpStart installation.

PROM
A programmable read-only memory chip with a program called the monitor
that runs a quick self-test procedure and checks such things as the hardware
and memory on the system. If no errors are found, the system begins the
automatic boot process.

PROM prompt
The prompt displayed when the system halts; either > or ok .

property book
The mechanism by which you identify, view, and modify the properties of
editable objects.

property browser
A property browser is like the table of contents in a book. It lists all the
chapters and subchapters in a book. This allows you to quickly navigate to the
desired chapter whose properties you want to view or modify.

property viewer
Displays the object or context properties you can view or modify.

protocols file
A file containing information about Internet protocols used in your network.

remote printer
A printer connected to a remote system such as a print server.

root
A user who has access to all parts of the system. This is usually the system
administrator. Also known as superuser.
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rpc file
A file containing entries for available Remote Procedure Call (RPC) services
(by name) and their associated program numbers and aliases.

sadmind  daemon
A distributed system administration daemon that carries out security tasks
when administrative tasks are performed across the network.

secondary group
Membership in this group is defined by the group identifier listed in the group
file with a list of users as members.

serial port

A port which transmits a byte of information bit-by-bit over a single line using
a standard communications protocol such as RS-423. See also parallel port.

Serial Port Manager
One of the Solstice AdminSuite’s applications used to manage serial devices.

services file
A file containing information about network services and their “well-known”
port numbers.

shadow  file
A file containing encrypted user passwords and password aging information.
Accessed using User Manager.

shell
A command-line interpreter program that accepts and executes commands that
you type. There are several varieties of shell programs, and three are included
in the Solaris software: Bourne, Korn, and C.

skeleton path
A prototype directory containing start up files. See also initialization files.

slice
A slice is an area on a disk composed of a single range of contiguous blocks. A
slice is a physical subset of a disk (except for slice 2, which by convention
represents the entire disk). Before you can create a file system on a disk, you
must format it into slices.

Solstice AdminSuite
A graphical user interface used to perform administrative tasks such as
managing users, groups, hosts, printers, and serial devices.
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Solstice Launcher
The base window of the interface, used to start the other application tools.

standalone system

A system with a monitor and keyboard, CPU and memory, approximately 200
or more megabytes of disk space, and usually a backup device. It may or may
not be connected to a network.

superuser
A user who has access to all parts of the system. This is usually the system
administrator. Also known as root.

sysadmin group
The UNIX group whose members belong to the sysadmin group (Group 14).
Members of the sysadmin group can use Solstice AdminSuite’s applications
locally or remotely.

system default (printer)
The printer your print requests will be sent to if you do not specify a printer.

system files
Files that contain important system administration information such as user
accounts, passwords, and groups. These files are contained on the local system
in the /etc  directory, or in the NIS or NIS+ database on a name server.

System V
One of two major “flavors” of the UNIX operating system, the other being
BSD. The SunOS 5.0 operating system (Solaris 2.0) and subsequent releases are
System V.

timezone file
A file containing entries for systems and their geographic region and time
zone.

user account
A record of essential user information stored on the system. You must have a
user account to access a system.

user ID (UID)
A number used by the operating system to identify a user. User ID numbers
for users usually range from 100 to 60000.

user name
The name, assigned to an individual user, that controls access to a system.
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User Manager
One of the Solstice AdminSuite’s applications used to manage user account
information.

utmp  entry
A entry made in the /var/adm/utmp  file when a user logs in and out of the
system.

workspace
The background screen area on which windows and icons are displayed.

ypbind
An NIS daemon process that runs on all client systems and allows the client to
communicate with an NIS server.

zsmon
Sun’s naming convention for the port monitor that monitors a system’s two
serial ports. It is derived from the Zilog serial communications driver.
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Index

A
access

to printers
adding, 161
deleting, 167

Add Access to Printer window, 162
Add Application window, 41
Add option (Edit menu)

Group Manager, 121
Host Manager, 83
User Manager, 125 to 126

Add window
Database Manager, 176
Host Manager, 83, 84, 86, 103, 108
User Manager, 125, 126

adding
access to a printer, 161
applications

in global register, 36, 38
in local register, 34
in Solstice Launcher window, 41

client support, 71
groups, 121
modems, 147
server support, 71
Solaris 2.x OS services to OS

servers, 98
standalone system information, 98

SunOS 4.x services to OS servers, 92
support

for dataless clients, 105
for diskless clients, 101
for OS servers, 83
for standalone systems, 83

system file entry, 176
terminals, 146
user accounts, 125 to 126

Admin Help, 51
buttons, 52

AdminSuite, See Solstice AdminSuite
aliases  file, 172
Application Path Selection window, 44
Application Properties window, 43
application properties, customizing, 41
application tools

filtering entries, 53
general reference, 49 to 58

applications
customizing, locally registered, 43 to

45
registering in Solstice Launcher, 33 to

40
removing

from global registry, 37, 40
from local registry, 35
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architecture type
for dataless clients, 105
for diskless clients, 101
for standalone systems, 84
selecting when adding Solaris 4.x OS

services, 95
ASCII terminal, 8
authentication security, 17

levels of, 18
authorizing permissions, 17
auto_home  file, 117
AutoClient systems

characteristics, 65

B
baud rate for modems, 148
bit-mapped display monitor, 8
boot servers

defined, 69
for dataless clients, 106
for OS servers, 84
for standalone systems, 84

boot software, 64
boot subsystems

secondary boot subsystem
x86, 237

booting
dataless clients, 107
diskless clients, 102
subsystems on an x86, 237

bootparams  file, 71, 172
buttons (Solstice AdminSuite), 55

C
CD image, See Solaris CD image
changing, See modifying, 130
clients

See also diskless clients, dataless
clients

defined, 62
support for, 61 to 112

maintaining, 110 to 112

commands
filtering, 53
install4.x , 94
software usage monitoring, 248
soladdapp , 34, 36, 37, 38, 40
swu_print, 273

configuration information for diskless
clients, 102

configuring
modems, 148
ports, 146, 147, 148

context
definition, 180

conventions, typographic, xx
Convert to OS Server option (Host

Manager Edit menu), 88
Convert window (Host Manager), 89
converting standalone systems, 88
Copy option (User Manager Edit

menu), 128
copying user accounts, 128
credentials for security levels, 18
cron job

software usage monitoring, 251
customizing

locally registered applications, 43 to
45

Solstice Launcher, 41 to 42

D
daemons

sadmind , 17
Database Manager

Add window, 176
advanced uses, 172
files modified by, 172
main window, 174
Modify window, 177
starting, 176

dataless clients, 65
adding services for, 92
adding support for, 105
booting, 107
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compared to other systems, 63
discontinuation of support for, 65
operating system services for, 64, 68

default printer, setting
with Printer Manager, 158 to 160

defaults
for adding system support, 82
for user accounts, 124

Delete option (Edit menu)
Group Manager, 131
User Manager, 135

deleting
access to printers, 167
groups, 131
port services, 150
printers from print servers

for NIS or NIS+, 167
if no name service, 168

support for a system, 111
system file entry, 178
user accounts, 135
user home directories, 135
user mailboxes, 135

disabling ports, 150
Disk Manager

batch editing, 211
batching, 211
description, 209
main window, 210
property book, 212
selecting multiple disks, 211

diskless clients, 65
adding support for, 92, 101
booting, 102
compared to other systems, 63
operating system services for, 64, 68

diskset
definition, 180

E
/etc/lp  directory

when printer is added in, 158
when printer is deleted from, 168, 169

/etc/printers.conf  file
of print client, 168
of print server, 158, 168
when printer is added in, 158
when printer is deleted from, 168, 169

Edit menu
Database Manager

Add option, 176
Delete option, 178
Modify option, 177

Group Manager
Add option, 121
Delete option, 131
Modify option, 130

Host Manager
Add option, 83, 101, 105
Modify option, 98, 111, 130
Set Defaults option, 82

Printer Manager
Add Access to Printer

option, 162
Delete option, 167, 168
Install Printer option, 158
Modify option, 164

Serial Port Manager
Delete option, 151
Modify option, 146, 147, 149
Modify Service option, 148

User Manager
Add option, 125 to 126
Copy option, 128
Delete option, 135
Modify option, 132
Set Defaults option, 124

/etc  files
as source of name service

information, 20, 72 to 77
modified by Group Manager, 116
modified by Printer Manager, 154

/etc/syslog.conf  file, 59
/etc/saf/ pmtag/_pmtab  file, 143
/etc/saf/_sactab  file, 143
ethers  file, 172
/export  file systems, 64
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F
Federated Naming Service, used with

NIS+, 156
field replaceable unit (FRU), 66
File menu

Host Manager
Save Changes option, 101
Update System Types option, 82

File Selection window, 44
file servers

for dataless clients, 105
for diskless clients, 101

File System Manager
description, 185
main window, 186
property book, 188

Filter Group menu, 53
filtering commands, 53
finding a printer entry, 169
footer information, 58

G
global browsing, 56
global registry, 34
global security policy, 21
group 14

membership required in, 8
permissions granted to, 18
see also sysadmin group

group  file, 117
group ID, 121
Group Manager

Add window, 121
adding users in sysadmin group, 16
defined, 115
Delete option (Edit menu), 131
files modified by, 116
main window, 119, 120
Modify option (Edit menu), 130
Modify window, 130
prerequisites for using, 119
starting, 119 to 120

tasks
for maintaining user

accounts, 129
for setting up user accounts, 118

groups
adding, 121
changing name of, 130
deleting, 131
modifying, 130
naming, 121

H
Help utility, 51
Hide list, moving applications to or

from, 41
host

software usage monitoring, 252
Host Manager, 61 to 112

Add window, 84, 86, 103, 108
Convert window, 89
Delete option (Edit menu), 111
files modified by, 71
global browsing, 56
limitations of, 70
main window, 58, 80, 81
Modify window, 99, 111
progress indicators, 58
Set Add Defaults window, 82
Set Defaults option (Edit menu), 82
starting, 80
status indicators, 58
tasks

available in, 66 to 67
for adding server/client

support, 78
for maintaining server/client

support, 110
Update System Types menu, 82
Update System Types option (File

menu), 82
hosts  file, 71, 172
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I
icons

path name, 44
tool, 41

initializing ports, 149
Install main menu, 94
Install Printer window, 158
install servers

defined, 69
for adding Solaris 2.x OS services, 98
for dataless clients, 105
selecting, 83

install4x  command, 94 to 96
installation services, 62
installing printer, 157

J
JumpStart installation, 64, 69

K
keyword files, 20

L
local queue

software usage monitoring, 251
local security policy, 21
locale  file, 172
locally registered applications,

customizing, 43 to 45
logging

Host Manager operations, 59

M
mailboxes (user), deleting contents of, 135
main window, 50
maintaining

client support, 110 to 112
server support, 110 to 112

managing
client support, 61 to 112
modems, 137 to 151
network service files, 171 to 178
server support, 61 to 112
terminals, 137 to 151
user accounts, 115 to 135

master log file
removing, 277

MDB floppy, 239
Members List

creating for a group, 121
for sysadmin group, 16

menu bars, 50
mixed-mode

See name service, setting up a
policy, 72

modems
adding, 147
configuring, 148
managing, 137 to 151

Modify option (Edit menu)
Database Manager, 177
Group Manager, 130
Host Manager, 98, 111, 130
Serial Port Manager, 146, 147
User Manager, 132

modify permissions for NIS+ tables, 15
Modify Service option (Serial Port

Manager Edit menu), 148
Modify Service window (Serial Port

Manager), 148
Modify window

Database Manager, 177
Group Manager, 130
Host Manager, 99, 111
Printer Manager, 164
Serial Port Manager, 146, 147, 149
User Manager, 132, 133

modifying
group name, 130
groups, 130
locally registered application, 43
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printer configuration
information, 164

support for systems, 111
system file entry, 177
user accounts, 132

Module Selection menu, 95
monitor, requirements for, 8
multiple device boot (MDB) floppy, 239

N
name service

See also NIS, NIS+, None
information used by sadmind

daemon, 20
selecting a, 14
setting up a policy, 72
using Solstice AdminSuite with, ?? to

16
netgroup  file, 172
netmasks  file, 173
network service files, managing, 171 to

178
network services, 62
networks  file, 173
NIS

access privileges required for, 8, 156
keyword, 20
not available for Serial Port

Manager, 14
setting up access for, 22
using with Solstice AdminSuite, 12
when printer is added in, 158, 162
when printer is deleted from, 168

NIS+
access privileges required for, 8, 156
admin group, membership in, 156
keyword, 20
not available for Serial Port

Manager, 14
permissions, modifying, 15
permissions, setting up, 22
security for, 20
using with Solstice AdminSuite, 12

when printer is added in, 158, 162
when printer is deleted from, 168

None
printer added in client’s /etc

files, 162
printer added in server’s /etc

files, 158, 159
printer deleted from client’s /etc

files, 168
printer deleted from server’s /etc

files, 169

O
object

definition, 180
OpenWindows, 7, 8
operating system services, 62, 68
/opt  directory, 64
OS servers

adding
SunOS 4.x OS services to, 92

adding support for, 83
converting standalone systems to, 88

OS Services window, 88

P
parity for modems, 148
passwd  file, 117
permissions

authorization of, 17
for NIS+ management, 22
for NIS+ tables, 15

port services, deleting, 150
ports

configuring, 146, 147, 148
disabling, 150
initializing, 149

print clients, access to printers, 161
print servers

managing, 155
setting up, 157
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printer
adding access to, 161
deleting access to, 167
installing, 157
modifying configuration for, 164

printer configuration information,
modifying, 164

Printer Manager
Add Access to Printer window, 162
files modified by, 154
Install Printer window, 158
Load window, 157
main window, 157
Modify window, 164
starting, 156

printing
software usage entries, 276

profile servers
defined, 69
for dataless clients, 106
for OS servers, 84
for standalone systems, 84

progress indicators, 58
prompts in command examples, xxi
property book

definition, 180
protocols  file, 173

R
registering applications in Solstice

Launcher, 33 to 40
registry

global, 34
adding applications in, 38
removing applications from, 40

local
adding applications in, 36
removing applications from, 37

private
adding applications in, 34
removing applications from, 35

remote booting, 62

remote installation, 69
not available for SunOS 4.x, 70

removing applications
from global registry, 37, 40
from local registry, 35

report entries
explained, 274

report entry
software usage monitoring

in a local queue, 251
requirements

for using AdminSuite, 8
for using NIS map information, 15
for using NIS+ table information, 15

.rhosts  file, entry required for NIS, 15
root file system

for dataless clients, 65
for diskless clients, 65
for servers, 64
for standalone systems, 64

root password, creating for diskless
clients, 102

root path
specifying for diskless clients, 101

root privilege, 8
security for, 18
using sysadmin group privileges

instead, 156
root .rhosts  file, 15
rpc  file, 173

S
sadmind  daemon, 17

name service information used by, 20
secondary boot subsystem

x86, 237
security, 17 to 22

levels of, 18 to 20
changing, 19 to 20

policy, 21 to 22
selecting a name service, 14
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sequence of events
software usage monitoring

in a shared file system
environment, 252

software usage monitoring in a client
server environment, 250

Serial Port Manager
description of, 137
main window, 144
Modify Service window, 148
Modify window, 146, 147, 149
starting, 144
Template menu, 146

servers, 61 to 111
boot, 69
compared to other systems, 63
defined, 62
file systems of, 64
install, 69
profile, 69
software to support other systems, 64
support for, 61 to 112

maintaining, 110 to 112
services  file, 173
Set Add Defaults window

Host Manager, 82
User Manager, 124

Set Defaults option (Edit menu)
Host Manager, 82
User Manager, 124

shadow  file, 117
Show list, moving applications to or

from, 41
software usage entries

generating using a command line
interface, 257

generating using a shell script
executable command
line, 260

generating using a shell script
wrapper, 260

generating using shell scripts, 260

software usage monitoring
commands, 248
cron job, 270
definition, 247
in a client/server environment

sequence of events, 250
in a shared file system

environment, 252
printing entries, 273
report entries, 274
transferring software usage entries on

a client, 270
using an embedded application, 266
verifying installation, 253, 254, 255

sofware usage monitoring
removing the master log file, 277

soladdapp  command, 34
globally registering applications

with, 36, 38
removing globally registered

applications with, 37, 40
Solaris 2.x OS services, adding to OS

servers, 98
Solaris CD image, 64

setting path
for dataless clients, 106
for OS servers, 84
for standalone systems, 84
when adding Solaris 2.x OS

services, 98
when converting standalone to

OS server, 89
Solaris OS server, 68
Solstice AdminSuite

application tools, 49 to 58
benefits of using, 5
buttons, 55
description of, 1
Help utility, 51
knowledge required to use, xix
launcher, 7
main windows, 50
menu bars, 50
NIS+ environment, 15 to 16
prerequisites for running, 8
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security, 17 to 22
levels of, 18 to 20
policy, 21 to 22

starting, 7
tasks available in, 5
using with name service, ?? to 16
using without name service, 16

Solstice Launcher, 7, 31 to 45
customizing, 41 to 42
menus, 33
registering applications in, 33 to 40
starting, 32

SPARC
booting, 228

standalone systems
adding support for, 83
compared to other systems, 63
converting to OS servers, 88
networked, 64

starting
Database Manager, 176
Group Manager, 119 to 120
Host Manager, 80
Printer Manager, 156
Serial Port Manager, 144
Solstice AdminSuite, 7
Solstice Launcher, 32
User Manager, 122

status indicators, 58
Storage Manager

context
definition, 180

Disk Manager
description, 209

File System Manager
description, 185

Load Context Property Book, 180 to
184

object
definition, 180

property book
definition, 180

See also Disk Manager
See also File System Manager

SunOS 4.x OS services, 70
adding, 92

support for systems
adding

for dataless clients, 105
for diskless clients, 101
for OS servers, 83
for standalone systems, 83

defined, 62
deleting, 111
modifying, 111
setting defaults, 82

swap path for diskless clients, 101
swap size for diskless clients, 101
swap space, 64

for dataless clients, 65
swu_print

command, 251
options, 273

swu_rpt
command

function
initiated, 251

swu_svr command
software usage monitoring, 251

swu_svr daemon
software usage monitoring, 251
starting and stopping, 256

symbolic links
listing CD directories using, 258, 261,

262, 264, 276
sysadmin group

adding users
in name service, 20

membership required in, 8, 15
permissions granted to, 18

system file entry
adding, 176
deleting, 178
modifying, 177

system information
adding, 83
specifying for diskless clients, 101
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system types, 63, 67
AutoClient, 65
updating, 82

T
Template menu (Serial Port Manager), 146
terminals

adding, 146
managing, 137 to 151
template, 142

/tftpboot  directory, 72
timezone  file, 71, 173
tool icons, customizing, 41
typographic conventions, xx

U
Update System Types option (Host

Manager File menu), 67, 82
updating system types, 82
user accounts, 115 to 135

adding, 125 to 126
copying, 128
deleting, 135
maintaining, 129 to 135
managing, 115 to 135
modifying, 132
setting defaults for, 124

user home directories, deleting, 135
user mailboxes, deleting, 135
User Manager

Add option (Edit menu), 125 to 126
Add window, 125, 126
Copy option (Edit menu), 128
defined, 115
Delete option (Edit menu), 135
Edit menu

Delete option, 135
Modify option, 132

files modified by, 117
main window, 122, 123
Modify window, 132, 133
prerequisites for using, 122
Set Add Defaults window, 124

Set Defaults option (Edit menu), 124
starting, 122

/usr  file system, 64

V
/var/saf/ pmtag /_pmtab/log  file, 143
Volume Management, 92, 93

and CD image software, 98

X
x86 booting subsystems, 237

Y
ypbind , running with -broadcast

option, 15
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